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About This Book Appeon® for PowerBuilder® 2015

1 About This Book

1.1 Audience

This book iswritten for PowerBuilder developers who want to use Appeon Developer to
complete the various Web or mobile deployment tasks, including analyzing, configuring,
deploying, debugging, running, and packaging the application.

1.2 How to use this book

There are eighteen chaptersin this book.

Chapter 1: About This Book

A general description of this book.

Chapter 2: Introduction

An overview of Appeon Developer.

Chapter 3: Before you begin

Some important instructions that you MUST follow before using Appeon Developer.
Chapter 4: Configuring Appeon Developer

Instructions for configuring Appeon Developer.

Chapter 5: Using UFA Tool

Instructions for analyzing the unsupported features in a PowerBuilder application.
Chapter 6: Deploying PowerBuilder Applications

Instructions for deploying PowerBuilder applications to the Web or the Mobile.
Chapter 7: Debugging Appeon Web Applications

Instructions for using Appeon Debugger to debug an Appeon Web application.
Chapter 8: Running Appeon Applications

Instructions for running Appeon applications after deployment.

Chapter 9: Launching Appeon Workspace Emulator

Instructions for launching Appeon Workspace.

Chapter 10: Using Information Manager

Instructions for viewing reports and log files generated in the Appeon migration process.
Chapter 11: Packaging Applications

Instructions for using Appeon application package tool to generate a deployment package, a
native mobile project, or customization and package for Appeon Workspace.

Chapter 12: Undeploying Appeon Applications
Instructions on how to undeploy Appeon applications.
Chapter 13: Developing with Code Insight
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Instructions on how to use the Appeon Code Insight feature.

Chapter 14: Launching Appeon Enterprise Manager

Instructions for launching Appeon Enterprise Manager from Appeon Developer.
Chapter 15: Converting screen size between pixels and PBUs

Instructions for using Appeon Size Calculator.

Chapter 16: Appeon for PowerBuilder Help

Instructions for launching the Appeon HTML help file.

Chapter 17: Extended Toolkit

Instructions for using the extended tools provided by Appeon: the DLL/OCX Files Package
tool, the Appeon Silent Installer, and the Appeon Developer Toolbar Register tool.

Chapter 18: Technical Support
Important information for technical support

1.3 Related documents

Appeon provides the following user documents to assist you in understanding Appeon for
PowerBuilder and its capabilities:

* Introduction to Appeon:

Gives general introduction to Appeon for PowerBuilder and its editions.

» Getting Started (for Appeon Mobile):
Guides you though installing PowerBuilder and Appeon for PowerBuilder, and developing
and deploying a mobile application.

* New Features Guide:

Introduces new features and changesin Appeon for PowerBuilder.

» Appeon Mobile Tutorials:
Givesinstructions on deploying, running, and debugging the mobile application,
distributing native mobile apps, and configuring the Appeon Server cluster.
» Appeon Mobile (Offline) Tutorials:
Gives instructions on setting up the Appeon Mobile (Offline) environment, and
configuring, deploying, running, updating, and debugging the offline application.
» Appeon Installation Guide:

Providesinstructions on how to install Appeon for PowerBuilder successfully.

¢ |nstallation Guide on Cloud Platform:

Providesinstructions on how to install Appeon for PowerBuilder on the cloud-based
platform such as Windows Azure and AWS EC2 and S3.
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Mobile Ul Design & Development Guide:
Introduces general guidelines on designing and devel oping the mobile app and UI.

» Migration Guidelines for Appeon Web:
A process-oriented guide that illustrates the compl ete diagram of the Appeon Web
migration procedure and various topics related to steps in the procedure, and includes
atutoria that walks you through the entire process of deploying a small PowerBuilder
application to the Web.

» Supported PB Features.
Provides adetailed list of supported PowerBuilder features which can be converted to the
Web/Mobile with Appeon as well as which features are unsupported.

» Appeon Developer User Guide:
Providesinstructions on how to use the Appeon Developer toolbar in Appeon for
PowerBuilder.

* Workarounds & API Guide:
Provides resolutions for unsupported features and various APIs to facilitate you to
implement the features (including Web and mobile) that are not easy or impossible to
implement in the PowerBuilder IDE.

* Appeon Workspace User Guide:
Gives a general introduction on Appeon Workspace and provides detailed instructions on
how to useit.

» Appeon Server Configuration Guide:
Provides instructions on how to configure Appeon Server Monitor, establish connections
between Appeon Servers and database servers, and configure AEM for maintaining
Appeon Server and the deployed applications.

* Web Server Configuration Guide:
Describes configuration instructions for different types of Web serversto work with the
Appeon Server.

» Troubleshooting Guide:
Provides information on troubleshooting issues, covering topics, such as product
installation, application deployment, AEM, and Appeon application runtime issues.

* Appeon Performance Tuning Guide:
Provides instructions on how to modify a PowerBuilder application to achieve better
performance from its corresponding Web/mobile application.

» Testing Appeon Web Applications with QTP:
Providesinstructions on how to test Appeon Web applications with QTP.
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1.4 If you need help

If you have any questions about this product or need assistance during the installation
process, access the Technical Support Web site at http://www.appeon.com/support.

Appeon Developer User Guide Page 4
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2 Introduction

Appeon Developer, acomponent of Appeon for PowerBuilder, extends the capabilities of
PowerBuilder, alowing anew or an existing PowerBuilder application to be converted into a
bona fide Web application or a native mobile application using only PowerBuilder skills.

Appeon Developer provides a set of tools that enable the entire PowerBuilder-to-Web or
PowerBuilder-to-Mobile process to take place within the PowerBuilder IDE. These tools
are accessed via atoolbar in the PowerBuilder IDE, which automatically loads each time
PowerBuilder is opened.

Figure 2.1: Appeon Developer toolbar embedded in the PowerBuilder IDE

@ PowerBuilder EI@
File Run Tools Window Help
mheloe oo BdEe @) 8| hos gt Hm Ny x| 0
EEFL-IFEE FEX IR

|

----- éﬂ (Mo Workspace)

¥ersion 11.5 Build 1502

Ready

Appeon Developer converts a PowerBuilder application by parsing the PBLs (source code)
of PowerBuilder applications and generating a set of corresponding HTML, JavaScript, and
XML files. When deployed by Appeon Server, these generated files form an exact Web-
based or mobile-OS-based replica of the source PowerBuilder application. Any user can
open a standard Windows Web browser and access the Web-based version of the origina
PowerBuilder application over the Internet, an intranet, or an extranet; or access the native
mobile application deployed by Appeon using a mobile device, such as an iPhone, an iPad,
Android-powered tablets and smartphones, etc.

2.1 Appeon Developer toolbar in PowerBuilder

All the Appeon Developer tools conform to the US Government Section 508 Accessibility
Guidelines.

The following figure represents the user interface of the Appeon Developer toolbar.

Figure 2.2: Appeon Developer toolbar
% 2 E R OK W

rert
rrr
FFF ﬁ. | @ R

The Appeon Developer toolbar has 15 buttons. The following table describes the
functionality of each button.
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Table 2.1: Appeon Developer toolbar functions

Button Name Function

ConfigWizard | Providesawizard for quick configuration of Appeon Developer
for Web or mobile conversion.

% Configure Sets configurations of Appeon Developer for Web or mobile
conversion.

&3 or 4+ |Analyze Analyzes application source code for unsupported features
before deployment. This analysis can cover the whole
application, at object level or within an inheritance hierarchy (It
displaysas # in PowerBuilder 11.5 or later).

Code Insight Develops PowerBuilder applications that are free of Appeon
unsupported features.

& Deploy Starts the complete process of deploying a PowerBuilder
application to the Web or Mobile.

2% Run Runs the deployed Web application (in Web browsers) or the
deployed mobile application (in Appeon Workspace Emulator).

<1ty Appeon Debugs Appeon applications.

Debugger

Information Manages logs and reports.

i Package Packages Appeon application files for installation.

b Undeploy Undeploys Web or mobile applications from Web Server(s) and
Appeon Server(s).

W AEM Launches Appeon Enterprise Manager (AEM).

FEE Size Calculator | Convertsthe display size between Points and PB Units.

g Appeon L aunches Appeon Workspace Emulator.

Workspace
Emulator

& Help Searches, browses, prints, copies, and pastes useful information
from the Appeon user guides.

8 Get Support Displays the product version and the support information. The
Check Update button in it allows you to check the Appeon
updates.

Apart from Code Insight and Information, only one Appeon Developer toolbar function can
be launched at any given time. This prevents an Appeon Developer process from interfering
with another.

2.2 Web and/or Mobile application development with Appeon
Developer
For either developing a new Web or native mobile application, or migrating an existing

PowerBuilder application onto the Web or to the Mobile, you need to perform three key tasks
in Appeon Developer: Analyze, Modify and Deploy Automatically.

Appeon Developer User Guide
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If you use Appeon for PowerBuilder for developing anew Web or native mobile application,
thefirst step isto write a new PowerBuilder application (refer to Chapter 2, Web RAD

with PowerBuilder and Appeon in Migration Guidelines for Appeon Web (Web only)). It is
recommended that the new PowerBuilder application conformsto Appeon coding styles, as
laid out in Supported PB Features for Appeon Mobile (Mobile only), or in Supported PB
Features for Appeon Web (Web only) then you will expend less effort in the first two tasks:
Analyze and Modify.

e Task 1: Analyze

Y ou need to analyze the application PBLs for unsupported PowerBuilder objects and
features, using the PowerBuilder IDE extended with Appeon Developer. General rules

of thumb regarding how the application should be structured are outlined in Chapter 2,
Basic Requirements and Recommendations in Supported PB Features for Appeon Mobile
(Mobile only) or in Supported PB Features for Appeon Web. The application must meet
these requirements before the analysis can begin.

The first step resultsin an analysis report highlighting unsupported PowerBuilder objects
and code within the application.

e Task 2: Modify

Next, work around or remove the unsupported PowerBuilder objects and code that prevent
the Web or mobile application from running, using standard PowerBuilder programming.
Supported PB Features for Appeon Mobile (Mobile only), or Supported PB Features for
Appeon Web (Web only) and Appeon Code Examples (an Appeon demo PowerBuilder
application) will guide you through this process by providing information regarding
supported PowerBuilder features as well as example code for implementing these features.

Then, perform afull build of the application in PowerBuilder, ensure that there are no
bugs in the PowerBuilder code and that the application functions correctly.

The second task resultsin a PowerBuilder application that is ready for automatic
conversion to the Web or to the Mobile.

» Task 3: Deploy automatically

At the push of a button, you can now automatically generate a precise replica of the
PowerBuilder application, that deploys to the n-Tier architecture and can be accessed by
Web browsers (Appeon Web applications) or in Appeon Workspace on various mobile
devices (Appeon Mobile applications).

Then, automatically deploy the generated Web or mobile application filesto Appeon
Server. The third task results in abona fide Web application or a native mobile application
with the look and feel of the source PowerBuilder application.

For detailed information about the Web conversion, please refer to the Migration
Guidelines for Appeon Web (Web only).

Appeon Developer User Guide Page 7
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3 Before You Begin

3.1 Installing Appeon for PowerBuilder

Follow Installation Guide for .NET carefully; make sure that both Appeon Developer and
Appeon Server have been installed.

Verify that Appeon Developer has been installed to the Developer PC.

Verify that Appeon Server has been installed to the application server, such as, SAP Sybase
EAServer, SAP NetWeaver Application Server, Oracle WebL ogic, IBM WebSphere,
TmaxSoft JEUS, JBoss, or Microsoft .NET Framework\I1S. Once Appeon Server has been
installed, the machine hosting Appeon Server is then referred to as Appeon Server.

If using a separate Web Server (e.g. Apache) instead of the application server built-in Web
server, verify that the Appeon Server Web Component has been installed to the Web Server.

Verify that al system requirements have been met for the Developer PC, Web Server,
Appeon Server, and the Database Server. Refer to Chapter 3, Installation Requirementsin
Installation Guide for .NET for details.

3.2 Configuring application database connectivity

Perform the following database configurations for all prospective PowerBuilder applications
that will be deployed with Appeon Developer:

1. Set up the database used by the PowerBuilder application to interface with Appeon Server
and the JDBC driver. Refer to the documentation from appropriate database vendors for
instructions.

2. Create the data source in Appeon Server. Appeon provides systematic instructions for
certified database systems. Refer to Section 4.4, “ Setting up Appeon Server data sources’
in Appeon Server Configuration Guide for .NET or in Appeon Server Configuration Guide
for J2EE for more information.

3. Map the transaction object in the target PowerBuilder application to the newly created
data source for the prospective Web or mobile application. Y ou can either dynamically
set up the mapping via Power Script following the instructions in Section 4.5.1, “Dynamic
transaction object to data source mapping” in Appeon Server Configuration Guide
for .NET or in Appeon Server Configuration Guide for J2EE or establish the mapping
statically in Appeon Developer or AEM.

3.3 Starting Appeon Server

Appeon Developer interacts with Appeon Server and Web server during Web or mobile
deployment. Web or mobile applications are deployed to one or more Appeon Servers and
one or more Web servers. Y ou should verify that the Appeon Server and Web server are
running before deployment. If you use the application server built-in Web server as the Web
server, you only need to start the application server/Appeon Server. For example, if you use
EAServer as the Appeon Server and EAServer HTTP Server as the Web server, you only
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need to start the EA Server/Appeon Server. Otherwise, start both the Web server and Appeon
Server. Refer to the documents provided by the Web server vender for how to start the Web
server, and refer to the following instructions to start the Appeon Server.

Table3.1: How to start Appeon Server

Operating Detailed I nstructions

System

NET Windows | Select Start > All Programs > Appeon for Power Builder 2015
> Appeon Server for .NET > 11S Manager

WebL ogic Windows | Select Windows Start > All Programs > Appeon for
Power Builder 2015 > Appeon Server for WebL ogic >
Instances > I nstanceName > Start WebL ogic

UNIX/ | Run the appeonserver.sh file in the $appeon/bin/ folder, for
Linux example:

$ $BEA_HOME/user_projects’domains/mydomain/appeon/bin/
appeonserver.sh

WebSphere | Windows | Select Windows Start > All Programs > Appeon for
Power Builder 2015 > Appeon Server for WebSphere > Start
WebSphere

UNIX/ | Run the appeonserver.sh file in the $appeon/bin/ folder, for
Linux example:

$ $WebSphere/ A ppServer/appeon/bin/appeonserver.sh

JBoss Windows | Select Start > All Programs > Appeon for Power Builder 2015
> Appeon Server for JBoss > | nstances > I nstanceName >
Start JBoss

UNIX/ | Run the appeonserver.sh file in the $appeon/bin/ folder, for
Linux example:

$ $jboss-5.1.0GA/appeon/bin/appeonserver.sh

JEUS Windows | Select Start > All Programs > Appeon for Power Builder 2015
> Appeon Server for JEUS > Start JEUS

UNIX/ | Run the appeonserver.sh file in the $appeon/bin/ folder, for
Linux example:

$ $tmaxsoft/IJEU S6.0/appeon/bin/appeonserver.sh

EAServer Windows | Select Windows Start > All Programs > Appeon for
Power Builder 2015 > Appeon Server for EAServer > Start
EAServer

UNIX/ | Runthe appeonserverstart.sh file in the $appeon/bin/ folder, for
Linux example:

$ $JA GUA R/appeon/bin/appeonserverstart.sh

Y ou can run EA Server/Appeon Server in different modes, debug
and normal, using different Java runtime versions and different
JavaVMs. For details on how to specify the mode optionsin
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Appeon Operating Detailed I nstructions

Server System

the above syntax, refer to the EAServer System Administration
Guide.
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4 Configuring Appeon Developer

The settings configured in Appeon Developer are critical; they are used throughout the entire
PowerBuilder-to-Web or PowerBuilder-to-Mobile process. Appeon Developer settings
determine which PowerBuilder application will be converted to the Web or to the Mobile,
and the manner in which it will be deployed.

Before you attempt to use any other functionality on the toolbar, complete the following
tasks:

1. Set up an application profile for each of the PowerBuilder applications intended for
conversion. Each application profile tells Appeon Developer important information about
the application, such as which PBLs compose the PowerBuilder application, the database
type, etc.

During the application profile setup, set up a profile for the database type used by the
application. This enables Appeon Developer to generate the correct database syntax.

2. Set up at least one Appeon Server profile and one Web Server profile. This enables
Appeon Developer to utilize the Appeon Server and Web Server for deployment.

3. Set up at least one deployment profile, which links at least one Appeon Server and one
Web Server together. This tells Appeon Developer where to deploy the Web or the mobile
application.

Appeon provides a Config Wizard () to quickly configure an application. With your
specifications, the wizard creates the application profile, database type profile, Appeon
Server profile, Web server profile, data source profile, and transaction object mapping. After

creation, all these profiles can be modified in the Configure tool (28). Besides modifying
the above profile settings, the Configure tool provides you with advanced settings, such as
performance settings, parsing options, Web Services profiles, runtime settings, etc.

4.1 Using Appeon Developer Configuration Wizard

The settings in Appeon Developer Configuration Wizard are the same asthose in the
Configuretool, therefore, only basic descriptions will be provided in this section. For detailed
descriptions, refer to Section 4.2, “Using Configure Tool”.

Click the Config Wizard button (27) on the Appeon Developer toolbar to launch the Appeon
Developer Configuration Wizard.

Carefully read the notes and requirements on the Welcome page of the Appeon Devel oper
Configuration wizard. Click Next to proceed.
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Figure4.1: Welcome page

Appecn Developer Configuration Wizard @

Yelcome to the Appeon Developer Configuration
Welcome Wizard|

The Appeon Developer Configuration Wizard will guide
wou through all the steps required for deploying an

B Configure basic settings application to the Web or to the Mobile. Please verify
B Salact PRI D the following before configuration.

1. The databaze in uze by the application iz rwnning and connected

B Configure deployment settings sussesdll

W Select DB types 2. The application haz been compiled with the “Full Buld” cormmand in a

supparted PowerBuilder version.

B Declare transaction object(s)

3. The application runs normally in PowerB uilder.

B Select image files 4 Al PELs have been optimized in PowerBuilder uzing the ""Optimize command.

B Select IMNI files

5. Application Server is started.
B Deploy Bxternal Files

B Summary

< Back [ Mest = ][ Cancel Finigh

4.1.1 Configuring basic settings

The basic settings refer to the settings of an application that are essential for deployment,
including application profile name, web folder, project type, device type, mobile app name,
mobile app icon, and mobile app description. For more information about them, refer to
Section 4.2.1.2.1, “Basic Settings’ in Section 4.2, “Using Configure Tool”.
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Figure 4.2: Configure basic settings of an application

Appecn Developer Configuration Wizard @
Please configure the following options:
Welcome
Application Profile Mame:  appnams
Configure basic settings weh Folder: appname
B Select PBL files
Praoject Type: [ - ]
B Configure deployment settings
Device Type: T ablet hd
B Select DB types #F [ __ ]
B Declare transaction object(s) ‘ Mobile App Name: appname
M obile App loor:
B Select image files M obile App Description: -
B Select INI files
B Deploy External Files -
B Summary
[ < Back ][ Mext = J [ Cancel ] Finizh

Step 1: Specify the application profile name in the Application Profile Name text box.

The application profile name is used to identify the PowerBuilder application during the
entire PowerBuilder-to-Web or PowerBuilder-to-Mobile process.

Step 2: Specify the application URL in the Web Folder text box.

The specified text is also used as the name of the folder created under the Web root of the
Web server for storing the files when the application is deployed.

Step 3: Select a project type from the Project Type dropdown list box.

Select "Mobile" if you intend to deploy your PowerBuilder application to mobile devices,
select "Web" if you intend to deploy your PowerBuilder application to the Web; select
"Universal" if you intend to deploy your PowerBuilder application to both the Web and

Mobile.

Step 4: (For mobile apps) Select a device type from the Device Type dropdown list box.

Tablet, Smartphone, and Both are listed for choices. For applications that are designed
for tablets, select "Tablet"; for applications that are designed for smartphones, select
"Smartphone”; for applications that are designed for both devices, select "Both".

Step 5: (For mobile apps) Enter an app name in the M obile App Name text box.

The mobile app name specified will be displayed in the Appeon Workspace home screen
after the application isinstalled to Appeon Workspace.

Step 6: (For mobile apps) Specify an icon for your mobile applications by clicking the

Browse... button.

Appeon Developer User Guide
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The icon specified will be displayed on the Appeon Workspace home screen after your
application isinstalled to Appeon Workspace.

Step 7: (For mobile apps) Enter a brief description in the M obile App Description text box.

The description will be displayed on the home screen of Appeon Workspace as the
application's description after deployment.

Step 8: Click Next.

4.1.2 Selecting PBL file(s)

Specify the version and the location of the PowerBuilder application source code.

Figure4.3: Select PBLs

Appeon Developer Configuration Wizard @

Select the PBL files used in your application:
Welcome

Configure basic settings EBT: C:AUsers\Public\Documentz\appeoniDeveloper201 34 B
Select FBL files Keep PBT Updated
B Configure deployment settings
FBL Yersion: [ PowerBuilder 11.5 ']
W Select DB types
FBL File List:

B Declare transaction object(s)

o huzershpublichdocument s appeonhdeveloper201 Fappeondemot zalesapplic. »
c:huzershpublichdocument s appeonhdeveloper20l Fappeondemot.zalezapplic
c:huzershpublichdocument s\ appeonhdeveloper20l Fappeondemot salesapplic

B Select image files

B Select IMI files

B Deploy External Files 4 m | "

B Summary

[ < Back ][ Mest = ][ Cancel Finizh

Y ou can add application PBLs using one of the following methods:

* Method 1: Select the PBT file to automatically add the PBL files. Details are as follows:
Click the browse (...) button to select the PBT file.

When aPBT fileis selected, all PBL files contained in the selected PBT are added to the
PBL FileList.

Thisisthe recommended method to add PBLs, asit reduces the likelihood of forgetting to
add arequired PBL.

* Method 2: You can also add PBL files without specifying the workspace and PBT filefirst.
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Click Add... to add one or multiple PBL files. Thisisthe only method you can take
when using the Configure tool. Refer to Section 4.2.1.2.1, “Basic Settings” for detailed
instructions.

Note: Keep the Keep PBT Updated checkbox checked if you want Appeon to automatically
update the PBL s every time you deploy an application. This ensures that any newly added
PBLswill be deployed and yet avoid missing PBL s after deployment.

4.1.3 Configuring deployment settings

The deployment settings associate the Appeon Server(s) and Web server(s) as a group used
for the application deployment.

Figure 4.4: Select the Appeon Server and Web server

Appecn Developer Configuration Wizard @

Flease select the Appeon Server(s) and Y¥eb server(s)
Welcome that your application will be deployed to:

Configure basic settings Deployment Profile Mame: | Local Deployrment ']
Select PBL files Appeon Servers
Configure deployment settings Celected  Mame Edit...
W Select DB types Local Appeon Server i
B Declare transaction object(s) |
|
| - Wweb Servers
B Select image files -
Selected Mame Edit...
B Select INI files Looal Web Server
B Deploy External Files —
B Summary
[ ¢ Back ][ Mext = J [ Cancel Finizh

Step 1: Select an existing deployment profile.

To create or modify a deployment profile, you must use the Configure tool. For detailed
instructions, refer to Section 4.2.4.2, “ Deployment profile settings’.

Step 2: Select the check boxes to include the Appeon Server(s) and the Web server(s) in the
deployment profile.

All the Appeon Server profiles and Web server profiles you have created are listed. More
than one Appeon Server and one Web server can be selected.

If the required Appeon Server profiles or Web server profiles are not available, click the Add
button to create them. Refer to Section 4.2.3.2, “ Appeon Server profile settings” for detailed
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instructions on creating an Appeon Server profile and refer to Section 4.2.3.3, “Web Server
profile settings” for detailed instructions on creating a Web server profile.

Step 3: Click Next to proceed.

When the Next button is clicked, the wizard will test the connection to the Appeon Server
and the Web server. If the connection is successful, the deployment profile is saved with the
associated Appeon Server(s) and Web server(s).

4.1.4 Selecting DB Type(s)

The database type is required during the application deployment if the application connects to
one or more databases.

Select the database type(s) used by the application by selecting the check boxes from the
Used column of the database type.

Figure 4.5: Database types

Appeon Developer Configuration Wizard @

Select the database type(s) used by your application:
Welcome

Mate: *rou must specify the database type(z] that your application uses, but it iz not

Configure basic settings hecessany to specify the exact database(z) used in thiz particular application. This
_ . zetting enables Appeon Developer to apply the carrect type of database driver for
Select PBL files gererating the cormect database syntax for PowerBuilder SOL statements in the
e K application.
Configure deployment settings
Select DF types .
IJzed Supported D atabase Types Configured =

B Declare transaction object(s) Sybase ASE

d

Mo

|EM DE2 UDE H
Svbaze 10 Mo —

B Select image files
B Select INI files B Informi: No
Oracle 10a/11g Mo i
B Deploy External Files Teecaa "
[ Edit ] [ Test
B Summary
[ < Back ][ Mest = ] [ Cancel ] Finizh

If the database type is not configured (The Configured column isindicated with "No"), you
should select it and click the Edit button to create a profile for it. For detailed instructions on
creating a database type profile, refer to Section 4.2.2, *Managing database type profiles’.

4.1.5 Declaring transaction object(s)

When the application is deployed to the Web or to the Mobile, Appeon Server handles the
connection with the server consolidated database (not the local offline database) using data
sources rather than transaction objects defined in the PowerBuilder application. Y ou must
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associate the transaction objects used by the PowerBuilder application with proper data
sources created in Appeon Server.

Y ou can create, modify or delete the mapping between transaction objects and data sources
either in Appeon Developer or AEM.

Figure 4.6: Specify transaction objects

Appecn Developer Configuration Wizard

Please specify the transaction object{s) used in the

Welcome application and the corresponding data source(s):

. Tranzaction Object Data Source DB Type
Select PBI files
Configure deployment settings

Select DF types

Dedlare transaction objeds)

B Select image files

B Select IMI files

B Deploy Bxternal Files

Configure. . Add... Delete

B Summary

[ < Back ][ Mest = ][ Cancel ][ Finizh

Click Add to create the mapping of the transaction object and the data source of an
application.
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Figure4.7: Add atransaction object

Add Transaction Object @
Tranzaction Object: sl
[Databaze Type: | Sybaze ASE 12.#/15.x b
Data Source:

IF pour Appeon Server iz the MET edition, vou can alzo select, edit, add, or delete the data
gource in the below Data Source group box,

Drata Source

Appeon Server -

Selected  Mame DB Host

Edit.. Add... Delete

] 4 ] | Cancel

Step 1: Input the transaction object name used by the application to the Transaction Object
text box.

Step 2: Select the database type from the Database Type dropdown list box.

Step 3: Specify the data source name in the Data Sour ce text box. The data source should
connect to the same database that the transaction object connects to.

Make sure that the data source existsin all Appeon Servers selected for this application
deployment. If the data source does not exist, you can create it by following instructionsin
Section 4.2.5, “Managing data source profiles’. After you create a data source, you can select
the Selected column to associate the data source with the transaction object.

Note: The data source tool will be available if Appeon Server isinstalled to Microsoft .NET
Framework\IIS, and will not be availableif Appeon Server isinstalled to EAServer 6.x,
WebL ogic, WebSphere, JBoss, NetWeaver Application Server or JEUS. Y ou should go to
the corresponding application server administration console to configure the data source

for EAServer 6.x, WebL ogic, WebSphere, JBoss, NetWeaver Application Server, or JEUS.
For detailed instructions, refer to Chapter 4, Database Connection Setup in Appeon Server
Configuration Guide for J2EE.

Appeon Developer User Guide Page 18



Configuring Appeon Developer Appeon® for PowerBuilder® 2015

4.1.6 Selecting image files

Click Browse to specify which folder contains the image files that will be used in the Web or
mobile application. Select Include Subfolder s to deploy the sub-folders under the specified
directory.

For detailed information about the image files, refer to Deploy Images.

Figure 4.8: Select imagefiles

Appeon Developer Configuration Wizard @

If your application uses image files, select the folder
where those imaqge files are stored and Appeon will
deploy the files to the Web or to the Mobile.

Welcorme

Configure basic settings Image Path:
C:AUzers\Public\Documentzs\&ppeonD eveloper 201 3appeondemo’.S alesdpplic

Select PBL files
Configure deployment settings [ Include Subfolders

Select DF lypes

Dedlare transaction object{s)

Select image files
B Select NI files

B Deploy External Files

B Summary

< Back ][ Mest = ][ Cancel ][ Finigh

4.1.7 Selecting INI files

If a PowerBuilder application uses an initialization (INI) file which contains user preferences,
specify the INI file so that Appeon can deploy the file for the application.

Click Add File... to add one or multiple INI filesor click Add Directory to add all INI files
in the selected directory.

For detailed information about the INI files, refer to Deploy INI Files.
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Figure4.9: Select INI files

Appecn Developer Configuration Wizard @

Please select the INI file(s) to be deployed with the

Welcome application if there are any. Click Next to proceed.

File List:
Configure basic settings "

| -

Selact PBL fites

Configure deployment settings

Select DE types

Pedlare transaction objeds)

Select image files

Select INT files —
B Deploy Bxternal Files ‘ -
fddFile.. | | AddDiectoy..
B Summary
< Back ][ Mest = ] [ Cancel ] [ Finigh

4.1.8 Selecting External files

If your application calls any custom user external files, such as DLL/OCX files, text files,
etc., you can specify them here and deploy them to the Web or the Mobile. Or you can use
the External File Packaging tool provided by Appeon to package the files and install them to
the client. For detailed instructions, refer to Section 17.1.1, “Packaging DLL/OCX files”.

Click Add File or Add Directory to add external filesto the table. Then select the Auto
Register column if the file needsto be automatically registered after it is downloaded to the
client. If you choose not to automatically register afile, you can register it manually after itis
downloaded.

For more information about the external files, refer to Deploy External Files.
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Figure 4.10: Select External files

Appecn Developer Configuration Wizard @

Please select the external file(s) to be deployed with the

Welcome application if there are any. Click Next to proceed.

Configure basic settings Auto Register  File Mame
Select PBL files

Configure deployment settings

Select DE types

Pedlare transaction objeds)

Select image files

Select INT files

Deploy External Files

fddFile.. | | AddDiectoy.. Delete

B Summary

< Back “ Mest = ][ Cancel ][ Finigh

4.1.9 Summary
Review the settings. Click Finish to complete the configuration.

If the Deploy the application now option is selected, the Appeon Deployment Wizard will
be launched for you to deploy the application. For detailed information, refer to Chapter 6,
Deploying PowerBuilder Applications.

After the configuration is complete, the application will be added to the Application Profiles
tab of the Configure tool where you can manage or change any settings of the application.
For detailed instructions, refer to Section 4.2, “Using Configure Tool”.
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Figure4.11: Summary page

Appecn Developer Configuration Wizard @

The following is the summary of settings for your
application deployment. To change any settings. click
Back.

Welcorme

Configure basic seftings W pplication Prafile Mame: -
appharne i
Select PBL files Application URL:
apphame =
Configure deployment settings Project Type: 1
tobile
Select DR types tobile &pp lcan: =
[Mone]
Declare transaction objeci{s) S e g Al N Tr: el tald
d [Mone]
Device Type:
T ablet
Select image files Mabile App Mame:
5 apphanme
Sefect INI files Deplayment Option: -
1 | n 3

Deploy External Files

Deplay the application now

Summarny

et = Cancel ][ Finizh J

4.2 Using Configure Tool

The Configure tool alows you to modify the settings of existing application profiles,
database type profiles, Appeon Server profiles, Web server profiles, deployment profiles and
data source profiles, and specify the advanced settings for an application profile, such asthe
performance settings, parsing options, Web service profiles, and runtime settings.

4.2.1 Managing application profiles

The Configure tool provides an Application Profilestab for you to modify the settings
specified in the Appeon Developer Configuration Wizard, and use the following advanced
functions:

» Specify the default application profile

» Select the file generation mode for an application
» Delete an application profile

» Boost the application runtime performance

» Specify parsing options

* Specify runtime settings

» Configure Web Service profiles
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4.2.1.1 Application Profiles tab page

When you click the Configur e button (28) on the Appeon Developer toolbar, the Appeon
Developer Configuration window appears with the Application Profiles tab selected by
default, as shown in the following figure.

Figure 4.12: Appeon Developer Configuration Window

95 Appeon Developer Configuration @

Application Profiles | DB Type Profiles I Server Profiles I Deployment Profiles I [rata Source Profiles

Application Profiles
Configure the PowerBuilder applications you intend to deploy ta the 'Web or to the Mobile,

Default Mame Project Tepe b ode PBL “Werzion Edit...
m zales Iniversal Rel PowerBuilder 1 T
codeexamples Wwieh Release PowerBuilder 1 -
act niversal Releaze PowerBuilder 17 m
zapteched riverzal Release PowerBuilder 1 =
arder niversal Releaze PowerBuilder 17 —
apphame b oibile Release PowerBuilder 1 =
Impart...
L T 3

(] ] I Cancel

4.2.1.1.1 Specifying the default application profile

To specify which application profile will be used as the default application profile, select the
Default radio button.

The PowerBuilder application defined in the default application profile is selected for
unsupported features analysis, PowerBuilder-to-Web or PowerBuilder-to-mobile conversion,
application packaging, and application undeployment.

4.2.1.1.2 Selecting an application file generation mode

To specify amode for Web or mobile file generation, click the Mode list box. If you change
the mode, you must perform afull deployment to make the new mode effective.

Table4.1: File generation mode

Description
Debug PS/JS | Generates unencrypted JavaScript files for debug | Web or mobile
use. application debugging

and tuning stage.
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Mode Description Usein the...

The PowerBuilder source code is provided
as comments in the JavaScript files for easy

reference.
Debug JS Generates unencrypted JavaScript files for debug | Web or mobile
use. application debugging

No PowerBUilder source code is provided in the | 2d tuning stage.

JavaScript files.
Release Generates encrypted JavaScript files. Production stage.

4.2.1.1.3 Deleting an application profile
Click the Delete button to delete a selected application profile.
Note: Y ou cannot delete the default application profile.

Deleting the application profile will automatically delete the temporary fold for the
application profile on the Developer machine. The folder has the same name as the
application profile and is created in the \Project folder under the root directory where Appeon
Developer isinstalled (e.g. C:\Program Files\A ppeon\Devel oper2015\).

4.2.1.1.4 Exporting/Importing an application profile

The Export and Import buttons are mainly to back up and restore the configuration of
application profile(s), for instance, if you want to transfer the configuration of application
profile(s) to another Appeon Developer.

 Click the Export button to export the selected application profile(s). In the pop-up dialog
box, type afile name, then the selected application profile(s) will be saved into the file as
XML file format.

To select multiple application profiles, you can use Shift+click or Ctrl+click, or drag the
mouse pointer to create a selection.

» Click the Import button to import application profile(s) from the XML filewhichis
generated by using the Export button.

If the application profile being imported has the same name as an existing application
profile, you will be asked to overwrite or ignore the existing application profile.

4.2.1.2 Application profile settings
The Application Profiles Configuration window provides eight tab pages for you to edit the
required application information:
Table 4.2: Application Profiles settings
To make changes

effective, you must...

Basic Settings | The application profile name, project Perform afull or
type, application URL, PBL version incremental deployment on
the application.
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To make changes

effective, you must...

and PBL location of an application. See
Section 4.2.1.2.1, “Basic Settings’.

DB Settings | The database types, transaction objects Perform afull or
and the corresponding data sources. See incremental deployment on
Section 4.2.1.2.2, “DB Settings’. the application.

Additional INI files, NET/COM components, image Perform afull or

Files filesand External files. See Section 4.2.1.2.3, |incremental deployment on
“Additional Files’. the application.

Misc Settings | Command line arguments, application Perform afull deployment
language, runtime performance, parsing on the application.
option, and log-writing mode. See
Section 4.2.1.2.4, “Misc Settings’.

Web Service | The WSDL file, service name and port for the | Perform afull or

Profiles Web service(s). See Section 4.2.1.2.5, “Web  |incrementa deployment on
Service Profiles’. the application.

Offline The offline capacity, start mode, and the local | Perform afull or

Settings database files. See Section 4.2.1.2.6, “Offline |incremental deployment on
Settings’. the application.

Runtime Company name and application hame Perform afull or

Settings displayed on the Web application downloading | incremental deployment on
page, and mobile application name, icon, the application.
and description displayed in the Appeon
Workspace and the target mobile device the
application apply for. See Section 4.2.1.2.7,
“Runtime Settings’.

Summary A summary view of the settings. Perform afull deployment
See the Section 4.2.1.2.8, “ Summary” section | " the application.
for more details.

4.2.1.2.1 Basic Settings

After you click Add or Edit on the Application Profilestab, the Application Profile
Configuration window is displayed with the Basic Settings tab selected by default, as
shown in the following figure.

The Basic Settings tab allows you to modify the web folder, project type, PBT, PBL version,
and PBL location.
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Figure 4.13: Basic Settings

pt Application Profile Configuration @
"Ww'eb Service Profiles Offline Settings Runtime Settingz S ummary
Basic Settings DB Settings Additional Files Misc Settings
Application
Profile Mame: sales
“Weh Folder:
Froject Type: Univerzal h

Application PBL:

FET: | o | Keep PET Updated

PBL ‘Yerzion: FPowerBuilder 11.5 -

Select the PET or PEL filez uzed in your application,

Al e PublichD ocuments\d ppeont Developer2( vappeondemotzalesapplicationdemohzales. »
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Profile Name - The application profile name is used to identify the PowerBuilder application
during the entire PowerBuilder-to-Web or PowerBuilder-to-mobile process. It is also used

in the appeondb database on Appeon Server to identify the DataWindow syntax, profile, and
registry information for an Appeon application.

The Profile Name cannot contain double-byte characters (such as Chinese, Korean, or
Japanese characters) or specia characters (such as, \, /,:, *, 2, ", <, >, or |).

Web Folder - The specified text is used as the name of the folder created under the Web
root (or document root) of the Web server for storing the Web or mobile application files
when the application is deployed, therefore, the URL for accessing the deployed application
will be in thisformat: http://web_server:port/web_folder/. The Web Folder can contain a
combination of letters, underscores (*_"), and numbers.

Avoid setting Web Folder as existing folder names in the Web server Web root (or document
root), because: (1) If aWeb or mobile application uses an existing folder under the Web

root as the Web Folder, alarge number of Web or mobile files belonging to the application
will be deployed to that folder, making it difficult to use the folder for its original purpose.
(2) If aWeb or mobile application uses afolder that is reserved for the Web server or
Appeon Server, some important files belonging to the Web server or Appeon Server may
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be replaced or even removed when the application is undeployed. The following are folder
names reserved for the Web server or Appeon Server that should not be used as Web Folders:
appeon, classes, docs, images, ir, wst, and WEB-INF.

The Web Folder for an application profile can be changed, and the Web or mobile files
stored at the Web server can have different versions for the client to access, but Appeon
only remembers the Web Folder in the last deployment, and performs the application
packaging and application undeployment based on the Web or mobile files generated in the
corresponding folder.

Project Type - The Project Type determines whether your PowerBuilder application will be
configured for the Web migration process, or the mobile migration process, or both.

* Web -- Deploys a Web app only. The Web target supports the most PB features including
Windows PC technologies, such as DLLS/OCXs.

» Mobile -- Deploys a native Maobile app only. The Mobile target supports mobile-specific
functionalities instead of Windows PC technologies.

» Universal -- Deploys both a native Mobile app and a Web app. The Universal target
supports the same features as the Mobile target. If your app uses Windows PC
technologies, such as DLLSOCXSs, you cannot use the Universal target.

Application PBL s - Select the PBL version and add application PBL files using any of the
following methods:

 Click the browse ... button and choose to add an application Target file (*.pbt).

By adding PBLs using an application Target, all PBLsin the Target are automatically
added to the application PBLsist. Thisisthe recommended way to add PBLS, asit
reduces the likelihood of forgetting to add arequired PBL.

» Click the Add button and add PBL files without using an application Target.

Y ou can add one or multiple PBL files at the same time. To select multiple files, hold
down the Ctrl key and choose which files to add.

» Copy and paste (Ctrl+C and Ctrl+V) the path list of PBLs into the Application PBLsfield.

Note: Keep the Keep PBT Updated checkbox checked if you want Appeon to automatically
update the PBL s every time you deploy an application. This ensures that any newly added
PBLswill be deployed and so avoids missing PBL s after deployment.

4.2.1.2.2 DB Settings

The DB Settings tab allows you to specify the database types and the transaction objects
that the application uses, as shown in the following figure. When configuring the database
types, it is not necessary to specify the actual databases that the application uses, it can be
any database of the same type. However, when specifying the transaction objects, you must
specify the actual transaction objects that the application uses.

What the DB Typeis used for
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PowerBuilder SQL statements must be converted into the correct database syntax before they
can be used to retrieve data from the database that the Web or mobile application connects to.
The DB Type settings enable Appeon Developer to apply the correct database driver type for

generating correct database syntax for PowerBuilder SQL statements.
Set the database types for the application

Select the database type(s) used by the application, as shown in the following figure.

Figure 4.14: Database types

®8 Application Profile Configuration @
Web Service Praofiles I Offline Settings I Runtime Settingz | Surmary
B asic Settings | DB Seftings | Additional Files | Mizc 5 ettings
Databaze Type
Select the Database Tope used by this application. The zelected databaze tupe must be configured.
Click. "Configure..." to configure a databaze type.
|Jzed Supported D atabase Types Configured il
[ W | M550LServer I =
[ Oracle 8 Mo
[ Oraclke i Mo
[l Sybaze ASE Mo
[ Cubmes ACH ksl ita Ve i
Tranzaction Object
Configure data sources for transaction objects used in the application.
Start tranzaction when executing stored procedures
Tranzaction Object Drata Source DB Type
zqlca appeohzample Sybaze ASA | Ultrali...
Edit. || add. || Delet
[ ak. ] [ Cancel

-

The following table describes each element on the DB Type tab.

Table 4.3: Database type settings

Column Description

configured database types are selectable.

Used Y ou can click the check boxes to select the database types used by the
application. More than one database type can be selected, but only the

Database
Types

Supported This column lists al the database types that are supported by Appeon.
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Column Description

Configured | Thiscolumnisidentical to the Configured column in Section 4.2.2
“Managing database type profiles’. It indicates whether a profile has been
configured for the database type.

If this column of the desired database type is"No", you must click the
Configure button to configure a profile for it before you can useit.
Configuring a database type profile in thistab is the same as configuring
itin the DB Type Profiles tab. Once a database type profile is configured
successfully, the Configured column in both this tab and the DB Type
Profiles tab changes from "No" to "Yes".

Soecify the transaction object and the data source

Click Add or Edit to configure a transaction object and specify the corresponding data
source. Refer to Section 4.1.5, “Declaring transaction object(s)” for detailed description.

Sart transaction when executing stored procedures

It is strongly recommended that you keep this option enabled. The only circumstance

you may consider disabling it is when there is commit statement executed inside a stored
procedure (SP) and there is no need to commit in the PB code; the reason is that by default
Appeon Server will start a transaction once an SP is executed, and the user will be able

to see details of this transaction in the Active Transactions tab in AEM; when commit is
executed inside the SP, the transaction will end and disappear from the database end, but as
there is no commit in the PB code, this transaction will still appear as an active transaction
in AEM, which will mislead usersto think thisis an uncommitted transaction. To avoid this
misunderstanding, you can disable this option, so Appeon Server will not start a transaction
when an SP is executed.

4.2.1.2.3 Additional Files

"Additional files' refer to the files that are outside the application source code, but are
necessary for running the PowerBuilder application, including INI files, .NET/COM
components, image files, and external files, such as DLL/OCX files, text files, etc.
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Figure 4.15: Additional Filestab

pt Application Profile Configuration @
Web Service Profiles Offline Settings Buntime Settingz Summary
B azic Settings DB Settings Additional Files iz Settings
Deploy [M] Files
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an the “Web and on the Mobile. Select the 1M files used within your application.

Add...

Bemowve

Deploy NET/COM components
1f your application uzes NET/COM components, select the files and Appeon will deplay them to the
SEIYVE

Add...

Remove

Deploy Image Files

I pour application uzes image fles, select the folder where those image files are stored and Appeon will
deploy the files to the 'wWeb ar to the kMobile.

C:AUzersvPublichDocuments\dppeonhD eveloper?01 3\appeondenotsalesapplicatior Browse. ..

Inzlude Subfolders

Deploy External Files

[f your application uzes external non-zypstem files, such as DLL, OCK, TET ete, select

; ) Optiar...
the files and Appean will deploy them to the server. | —Pen..

ak. ] | Cancel

Deploy INI Files

If a PowerBuilder application uses an initialization (INI) file which contains user preferences,
specify the INI filein this tab so that Appeon can deploy the file for the application.

Click Add to add the INI file(s) into the Deploy INI Files list box.
How INI files are supported in Appeon

During deployment, the specified INI file(s) are converted to XML file(s) and deployed to
Appeon Server. The XML file(s) act as mock INI file(s). When a Client runs the deployed
application for the first time, acopy of the XML fileis created in Appeon Server and keeps
the Client's profile information.

For a Client to use the correct profile information in its subsequent visits to the application,
the Client browser must be cookie-enabled. Otherwise, each time the Client visits the
application, a new copy of the XML fileis created in Appeon Server, and the new copy only
contains the information of the original INI file.

Y ou can delete the XML files that are unused for a period using Appeon Enterprise Manager
(AEM). For more information on how to maintain XML filesin Appeon Server, refer to
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Section 5.3.3.3.1, “Auto cleanup” in Appeon Server Configuration Guide for .NET or in
Appeon Server Configuration Guide for J2EE.

Deploy .NET/COM components

If a PowerBuilder application uses .NET/COM components which contains executable files
(.exe), and COM/COM+ components, specify the NET/COM componentsfilein thistab so
that Appeon can deploy the file for the application.

Click Add to add the .NET/COM components file(s) into the Deploy .NET/COM
components list box.

Deploy Images

Click Browse to specify which folder contains the image files that will be used in the Web
or mobile application. If you do not specify the path of the image files, the path to the
application PBL fileswill be displayed as the default path of the image files.

The image files can be in any format supported by PowerBuilder, apart from:
* unsupported run-length encoded (RLE), and
* unsupported Windows metafile ( WMF)

All the image files in the specified folder will be deployed to the %\Web Folder%/images
folder in the Web Server. %Web Folder% stands for the folder storing the Web application
files or the mobile application files. The image files may fail to be displayed on the Web or
in Appeon Workspace, or on mobile devicesif the file names are stored in the database or
dynamically generated. To resolve this, you can copy the image files directly to the %Web
Folder%/images folder, but make sure that the file names are all lowercase; otherwise, the
Web or mobile application may fail to load them.

Deploy External Files

If your application calls any custom user DLL/OCX files (for Web applications only), which
are also called external non-system DLL/OCX filesin thistab; or if your application calls any
other external files, such astext files, PDF files, image files etc., you can specify them here
and deploy them to the Web server. Deploying DLL/OCX filesis used as an examplein this
guide.

If there are many large-size DLL/OCX filesin your application and they could be slow

to download from the Web server at runtime, you may prefer to use the DLL/OCX File
Packaging tool provided by Appeon to package the files into one setup program (see
Chapter 17, Extended Toolkit for detailed instructions), then distribute the setup program to
the users, and have the usersinstall the filesto each Client.

Click Option... in the Deploy External Files group box to open the Deploy External Files
dialog box (as shown in the following figure) and select the required external filesto be
deployed.
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Figure 4.16: External Files Automatically Deploy and Download

pt ] Deploy External Files @
External Files
Register  File Mame File Path Add
Delete
Select All
Unzelect Al
| ] | | Cancel |

The following table introduces the elements in the Deploy Exter nal Files dialog box.

Table 4.4: Deploy External Files dialog box

Column Description

Register Allows you to select whether the file will be automatically registered after it is
downloaded to the Client at runtime.

Click Salect All to select all filesand Unselect All to de-salect all of them.

If you choose not to automatically register afile, you can register it manually
after it is downloaded.

FileName |Liststhe added files. Click the header of this column to display thefilesin
alphabetical order. You can add any file of any type.

File Path Displays thefile location.

The following table describes how to add and remove files in the Deploy External Files
dialog box.

Table 4.5: Deploy External Files dialog box

To Do This Do This

To add files Click the Add button. A standard File Selection dialog box is
displayed. And then select the files from your local machine. The files
can be stored in any location.

To removefiles Select afile or multiple files using Ctrl or Shift keys, and click the
Delete button to remove the selected files from the list.

To savethe Click OK.
settings
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ToDo This Do This

Appeon will copy the filesto atemporary folder and then deploy them
to the Web Server during deployment.

How the deployed DLL/OCX files work on Web

To successfully call the deployed DLL/OCX filesin the Web application, you need to make
sure that the DLL/OCX files are successfully downloaded and installed to the Client during
the initial run of the deployed Web application.

Appeon Enterprise Manager (AEM) provides options for manually or automatically
downloading and installing the DLL/OCX files, and for specifying the installation location
(by default the files are saved to the "plugin” folder under the application directory on the
client machine). For detailed instructions, refer to Section 5.4.4.3, “DLL/OCX Files” in
Appeon Server Configuration Guide for .NET or in Appeon Server Configuration Guide for
J2EE.

Where the external file will be saved after downloaded to the client

The external file will be automatically downloaded and saved to the client when the deployed
application isrun for the first time. The default location is the "plugin” folder for each
application. For more details, refer to Section 5.1, “What files will go to the plugin folder and
how to access them” in Workarounds & API Guide.

4.2.1.2.4 Misc Settings

The Misc Settings tab page enables you to modify settings for command line arguments,
application languages, double-byte charset, and log-writing modes, and allows you to
configure the runtime performance and parsing options.
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Figure4.17: Misc settings

-

®& Application Profile Configuration @
WWweb Service Profiles Offhine Settings Runtime Settingz Summary
Basic Settings DE Settings Additional Files Mizc Settings

Command Line Argumentz

Configure how command line arguments used in the PowerBuilder

application will be handled on the Web or Mobile. [ Command Line Settings... ]

Language Options

Configure optionz for the application language and charset, =
Language Options...

Prampt Language: Englizh; Double-Byte Charzet: windows-336

Perfarmance

Configure additional settings to bweak the application's wn-time -
perfarmance. Performance Settings ...

Parzing Options
| Allow D eplovment \Wizard to rename the identifiers unsupported by JavaScript or ML

Appeon Developer Logz

Set the lag-writing made for Deploy Log and Analvsiz Log. Yaou may
view/manage theze logz in the Infarmation Manager.

Off mode @ Summary mode Debug mode

k., | | Cancel

Command Line Arguments

If an application needs to use command line arguments, enable the command line argument
option, as shown in the following figure.

Click Command L ine Settings on the Misc Settings tab. The Command Line Settings dialog
box is displayed, as shown in the following figure.
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Figure 4.18: Command Line Settings dialog box
rﬁ Command Line Settings @

-

Bequire a command line argument for the applicatiord

Y'ou can pasz a command line argument to an Appeon application by appending the string to the
application URL, for example, http:/Aw'ebdppld B LAndes. htm gt alie.

Launch &pplication from Developer Shortcut

Show the argurnent input/confirmation dialog

[ ] ]| Cancel |

Requirea command line argument for the application option: Enables the command line
argument option.

With this check box selected, the following two options will be enabled. Note that they are
effective only if you run the application from the Appeon Developer toolbar.

» Show argument input/confirmation dialog option: A dialog box is displayed after you
launch an application from the Appeon Developer toolbar but before the application starts.
This dialog box enables you to specify the arguments for the application.

» Specify the default command argumentsfield: The specified default arguments are
directly attached to the application URL when the application is run from the Appeon
Developer toolbar.

* If both options are selected: A dialog box pops up with the default argumentsfilled in, as
shown in the following figure. Y ou can either change the default arguments or |eave them
alone.

Figure 4.19: Command line argument dialog box

Request Parameter @

Pleaze zpecify the command ling argument to be pazzed to the application.

Click the Cancel button if you do not want to pazs command line argumett.

[ ] ]| Cancel |

To run an application with arguments from Clients, type the application URL with

the arguments. The format of an application URL with argumentsis: http://AppURL/
index.htm?ArgValue. ArgValue indicates the arguments that will be passed to the application.
The arguments must be separated by commas if there are more than one argument.

Application Language and Double-Byte Charset
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Step 1: Click Language Options on the Misc Settings tab. The L anguage Settings dialog
box is displayed, as shown in the following figure.

Figure 4.20: Application language settings
rﬁ Language Settings @-‘

Language
Fleaze specify the language for system promptz and meszages.

System Prompt Language: E nalish -

Charzet
Pleasze zpecify the charzet of the client machine.

Client Charzet; Litf-8 - |

[ ] ]l Cancel |

» System Prompt Language: Select alanguage from the System Prompt Language
dropdown list box (Only English available when you are using an English version of
Appeon for PowerBuilder).

System prompts are error messages, informational messages, warnings, notices, and
prompts that are displayed when you run Appeon applications.

» Client Charset: Skip thisif your application isa Web application or if your mobile
application does not use any string function that endswith " A", otherwise, select a
charset the same as that of your PowerBuilder development environment for the mobile
client.

If your application uses string functions that end with"A" (e.g. FillA, LeftA, LenA, MidA,
PosA, ReplaceA, and RightA) to process the double-byte character, these functions may
return different values on iOS and Windows, because iOS system uses UTF-8 encoding
while the Windows system uses UTF16 encoding. Due to this difference, in order for these
functions to return the same values on iOS and Windows, you need to specify the charset
here the same as the charset of your PowerBuilder development environment.

And make sure the mobile client supports the specified charset, otherwise, these functions
could not return the correct values or may even cause the application to crash. For the sake
of safety, we suggest you not use string functions that end with"A" (e.g. FillA, LeftA,
LenA, MidA, PosA, ReplaceA, and RightA) to process the double-byte character, use the
functions without “A” instead (e.g. Fill, Left, Len, Mid, Pos, Replace, and Right), so as

to avoid any potential issue that could be caused by specifying an improper charset or the
mobile client not supporting the specified charset.

Step 2: Click OK to save the settings.

Performance Settings

Appeon recommends that you take advantage of the performance settings to boost the
application's runtime performance. To achieve the best performance, perform the following

steps:
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Step 1: Click the Performance Settings on the Misc Settings tab. The Performance Settings
dialog box is displayed, as shown in the following figure.

Figure 4.21: Performance settings

®5 Performance Settings

Perfarmance Boosters

A0 Web file compressior:

Merge files

Perfarmance Analyzer [For Web only]

Data iz not encrypted duning the tranzmizsion if thiz ophion iz enabled. Strongly recommend
to dizable it when ransfer applications ta the live or praduction enviranment,

Perfarmance Analyzer compliance

Appeon Actives Download [Far Web anly]

Download ActiveX files in a single thread

ok ]

Cancel

Step 2: Select the performance features based on your needs.

The following table describes how to use the performance features.

Table 4.6; Performance features

Setting Description When To Use
10X Web File| Compresses files when they are transferred over the Always
Compression | network.
Mergefiles | Mergesthe small files during the application deployment. | In the
The small fileswill be downloaded to the client in onefile |production
package at one call, instead of being downloaded one by stage.
one at separate calls.
Performance | Enables the application to be deployed in a method Inthe
Analyzer compliant with the Performance Analyzer tool. development
i‘om\e{/lsgce The application deployed with this option can run with stage.
( orl_ e the Performance Analyzer tool at runtime to diagnose
aplp ICAONS | the performance issues. For more about the Performance
only) Analyzer tool, see Section 4.2, “ Appeon Performance
Analyzer” in Appeon Performance Tuning Guide.
Note: asthe datais not encrypted during transmission at
runtime, therefore, this option is recommended to use only
at the test or development stage.
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Setting Description When To Use
Download Downloads the two ActiveX filesin the same thread at Always
ActiveX runtime.

filesina

Using the same thread to download the two ActiveX

S]'; ngl\;evtgead files can speed up the download under particular network

( or el conditions.

applications

only) For more information about the Appeon ActiveX file, refer

to Section 5.1.2, “Installing Appeon ActiveX control” in
Supported PB Features for Appeon Web (Web only).

Parsing options

Unsupported identifiers refer to identifiers that are supported in PowerBuilder but
unsupported in Appeon, due to the different naming convention between PowerScript

and JavaScript/XML. For detailed explanation of such unsupported identifiers, refer to
Section 5.1.2.2, “Identifiers’ in Supported PB Features for Appeon Mobile (Mobile only) or
in Supported PB Features for Appeon Web.

With this automatic-renaming option enabled, when the Appeon Deployment Wizard deploys
an application, it automatically detects unsupported identifiersin the application and renames
these identifiers to supported onesin the files it generates for the application, while keeping
the application source code unchanged. After the deployment, you can get thelist of all

the identifiers that are renamed in the deployment log in Chapter 10, Using Information

Manager .

The automatic-renaming feature will not work if the option is disabled. In this case, you must
rename the unsupported identifiers by yourself, following the guidance of the UFA report and
Section 5.1.2.2, “Identifiers’ in Supported PB Features for Appeon Maobile (Mobile only) or
in Supported PB Features for Appeon Web.
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Figure 4.22: Parsing options
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Command Line Argumentsz
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Prompt Language: English; Double-Byte Charzet: windows-336
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Appeon Developer Logz

Set the log-writing mode for Deploy Log and Analvsis Log. 'ou may
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Off mode @ Summary mode Debug mode

0k, | | Cancel

Appeon Developer log-writing mode

The log-writing mode determines the content of the log files generated by Appeon Developer,
including the deployment logs and feature analysis logs. Select the desired mode from the
Appeon Developer Logs box, as shown in the following figure.
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Figure 4.23: Log-writing mode
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The logging options enable you to select the level of information contained in the logs
according to your needs:

Table4.7: Log writing options

Mode Description

Off mode Generates no log files.
This mode offers the fastest performance since nothing is written to alog file.
Summary Generates log files with basic execution information.
”E)oerde | Thisisuseful for tracking errors that have occurred, but inadequate for
(Default) | jetailed troubleshooting,
Use this mode once the application is stable.
Debug mode | Generates log files with detailed execution information for troubleshooting
obscure and esoteric iSsues.
Thisisuseful for technical support, but performance speed will slow down
when using this mode.
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You can view or delete these log files. For detailed instructions, refer to Chapter 10, Using
| nformation Manager.

4.2.1.2.5 Web Service Profiles

A Web service profile contains the settings for the Web service(s) to be invoked in the
Appeon deployed application, including the WSDL file, service name and port to be used by
the Web service.

After you specify the PBL files of the application in the Basic Settings tab, the Web
service proxy objects, WSDL files, service, and port, which are used in the application, are
automatically added to the Web Service Profiles tab, as shown in the following figure.

A valid WSDL file must meet the following requirements:
* The WSDL file must be a.wsdl or .asmx file.

» The WSDL file must reside on the local computer. Appeon cannot access the WSDL filein
aremote machine.

* WSDL files used in the same application cannot have the same name, even if they residein
different locations.

Figure 4.24: Web Server Profilestab

®5 Application Profile Configuration @
| B asic Settings I DB Settings I Additional Files I kizc Settings

Web Service Profiles | Offline Settings | Runtime Settings | Surmmary
“Wieb Service Configuration

TheWeb zervice proxy object acceszes the WSDL file for obtaining the service and port infarmation of

the ‘web zervice. Pleaze specify the comrect WSOL fle, service and port for each "Web service prosy

ahject.

dzed  Prowy Object WSOL File Service Puart
Select Al Dezelect Al Irvert Selection Configure...
] ] l Cancel
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Choose which proxy object(s) will be invoked in the deployed application by selecting

the Used column of the object. Click Select All to select all objects; click Deselect All to
deselect all objects; or click Invert Selection to select all objects which were not selected and
deselect the previously selected objects.

If the WSDL file, service and port are not automatically specified for a proxy object, follow
the steps below to select them:

Step 1: Select the proxy object and click Configure. The Configure dialog appears, as shown
in the following figure.

Figure 4.25: Configure dialog box

®5 Configure - achcheckverifysoap [=5]
Prowy Object: achcheckyverifuzoap
WSDL File: |

| Browsze

Service: -

Part: -

[ ] ] | Cancel |

Step 2: Click Browse to select aWSDL file on the local computer, and then select the service
and port.

A WSDL file may contain multiple services and each service may contain multiple ports.
Step 3: Click OK to save the configuration and return to the Web Service Profiles tab.

4.2.1.2.6 Offline Settings

This section is for mobile applications with offline capabilities and users that have purchased
the Enterprise edition with offline support.

Introduction

The offline feature enables devel opers to

* design an application that can read and write data from the local databases (SQL.ite or
UltraLite), and synchronize the local database with the back-end database server.

Y ou will need to first use the DBParm properties (see transaction object in Supported PB
Features for Appeon Mobile (Mobile only)) and then configure and deploy the database
fileto the local device through Appeon Developer, so the application can access the local
database. For detailed instructions, refer to Appeon Mobile Offline Tutorials (Mobile

only).
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To synchronize the UltraLite local database with the database server, you could

take advantage of the PB synchronization object M L Sync and the SQL Anywhere
synchronization server MobiL ink. To synchronize the SQL.ite local database with the
database server, you would need to devel op your own synchronization solution, because
SQL.ite cannot work with MobiLink or any other equivalent product or solution.

* deploy the application to start at the offline mode

If the application is deployed to start at the offline mode, the app can start without
connecting to the Appeon Server except for the first time when it needs to download the
configuration information for local use.

Local database requirements

The local database must be either UltraLite or SQLite. When using the local database, be
aware of the following requirements or limitations:

* Required database version.

According to the ASA/SQL Anywhere documentation, the Ultral ite database that works
on iOS must be at version 12 (Appeon Mobile 2015 only supports Ultralite 12.0.1 and
will work on to support the later versionsin the future versions), and the corresponding
MobiLink server must be at the same version. If they are not at the required versions,
upgrade them by following the stepsin the SQL Anywhere 12 help: SQL Anywhere 12.0.1
> SQL Anywhere 12 > Changes and Upgrading > Upgrading to SQL Anywhere 12.

The SQL ite database should be at version 3.x or later.

» Using ASA/SQL Anywhere for development.

When devel oping the PowerBuilder application, the ASA/SQL Anywhere database should
be used rather than the Ultral ite database, because there are many issues using Ultral ite
with PowerBuilder according to our test results. It is recommended that after finishing

the PowerBuilder application development, export the table schema and data from the
ASA/SQL Anywhere database to the Ultral ite database (by using the tool provided by
Mobilink), and then use the UltralL ite database in the offline application.

 Creating synchronization scripts for SQL.ite.

Unlike UltraLite which can synchronize data through the MobiLink server, SQLite cannot
work with MobiLink servers, or any other synchronization servers similar to MobiLink.
Therefore, you would need to develop your own synchronization scriptsif synchronizing
the SQL.ite local database with the database server.

Specify the offline settings for the application

The Offline Settings tab allows you to configure the offline capacity, the start mode, and the
local DB settings for the mobile applications. These configurations and configured files will
be deployed to the Appeon Server along with the application.
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Figure 4.26: Offline settings

pt] Application Profile Configuration
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-
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Additional Files
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[ ] ]| Cancel |

Offline Capacity: Check the Support Offline checkbox if your application needs to enable

support for the offline features.

If it is not checked, the application works as a standard Appeon Mobile application that

always connects to the Appeon Server.

Start M ode: Allows you to set whether an application to be launched online or offline. The
online mode requires network connections from the mobile device to the Appeon Server,

while the offline mode does not.

The following table describes the three start modes in details.

Table4.8: Start mode
Descriptions

Online
application starts and runs.

Network connection from the device to the Appeon Server is needed when the

If the application is set to start online, then it starts and runs the same way as the
standard Appeon applications (except that the application can access the local
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Start Descriptions

mode

database), which means, it must connect to the Appeon Server for loading the
application file, getting updates, managing user sessions, etc.

Offline | The application starts without connecting with the Appeon Server, except for the
first time.

For applications that starts offline, the application must connect to the Appeon
Server to download the configuration information only for the first time, after
that, the application can run locally without needing any network connection.

If your application needs to access the database, then you would need to enable
the local database accessibility using DBParm of transaction object in Supported
PB Features for Appeon Mobile (Mobile only) and configure the database file
deployment in the Local DB Settings table below, in order for the database file
to be downloaded and accessed on the local device.

Unlike the other Appeon applications, the offline application will not be
automatically updated, because it runs locally without connecting with the
Appeon Server; therefore, you will need to write code in the application to
call the APIsto get updates from the Appeon Server. Refer to the section
called “of_checkupdate” in Workarounds & API Guide and the section called
“of_applyupdate” in Workarounds & APl Guide.

Offline | The application will first try to start online (in an attempt to connect with the
if online | Appeon Server), if the online startup fails (due to the bad network connection,
startup  |wrong URL, etc.), then it starts offline.

failed

If the application has already run as an offline application and then is re-deployed as an
online application, it will need to get updates (the new start mode) from Appeon Server first
and then restart, then it will run as an online application. Which means, you will need to write
code in the app to call APIsto get updates first, and then the end user will need to quit and
run the application again as the application cannot automatically restart.

If the application has aready run as an online application and then is re-deployed as an
offline application, it will need to restart and then it will run as an offline application. Which
means, the end user will need to quit and run the application again as the application cannot
automatically restart.

Local DB Settings: Specify the data source/transaction name and the database file that will
be deployed to the Appeon Server, and later downloaded to the mobile device and accessed
by the application at runtime.

Y ou can specify these items by adding a new local database, editing, or deleting an existing
one.

» Toadd anew local database, click Add, and the L ocal Database Configuration window
appears.

In the L ocal Database Configuration window, specify the items (according to the
following table), click Test to test the connections, and then click OK to save the settings.
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Figure4.27: Add alocal database

Clatabaze File: | |
Uzer Name:
Password:

Encryption Key:

®%8 Local Database Cenfiguration @
Tive OB thisd O Transacion
Mame:
Databasze Type: SQLite @ Utralite 12

Test | [ QK ] | Cancel

The following table describes the itemsin the L ocal Database Configuration window.

Table4.9: Local database configuration

Items Descriptions

Type

Select Data Source or Transaction.

To use the transaction object to connect with the local database for the
application, select Transaction; to use the CacheName parameter of DBParm
in the transaction object to connect with the database, select Data Sour ce.

By using the CacheName DBParm, you can conveniently switch database
connections in the same transaction object. For more about the preferable
scenarios using the PB transaction object or using the CacheName DBParm,
refer to Section 4.1, “Connect with the local database” in Appeon Mobile
Offline Tutorials (Mobile only).

For more about the syntax of CacheName DBParm, see Section 4.3.1.21,
“Transaction” in Supported PB Features for Appeon Mobile (Mobile only).

Name

Enter a data source or transaction name.

If the Typeis Data Sour ce, the Name must be the same value of the
CacheName DBParm; if the Typeis Transaction, the Name must be the
exact name of the transaction object in the application source code.

Database
Type

Select SQLiteor UltraLite 12.
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Items Descriptions

Database | Specify the database file.

Rle The database file must exist and be valid, and the name cannot be

"appeondb.db”. The database file will be deployed to Appeon Server when the
application is deployed, and will be downloaded to the local device when the
application is downloaded for the first time.

The database file on the local device will not be updated unless you write code
in the application to call of applydbupdate in Workarounds & API Guide to
get the latest database file from the Appeon Server.

User Enter the user name for the database.

hame Thisfield isonly required for UltraL ite.
Password | Enter the password for the database.

Thisfield isonly required for UltraL ite.
Encryption Enter the encryption key for the database.

Key Thisfield only supports UltraLite. Y ou should input the same encryption
key which is specified when creating the UltraL ite database in the Create
Database Wizard in Sybase Central, so that the Appeon mobile application
can read/write the encrypted database.

For more about encrypting the Ultral ite database in Sybase Central, see
Section 4.4, “ See aso: Encrypt Ultralite database” in Appeon Mobile Offline
Tutorials (Mabile only).

To edit alocal database, select the local database in the Local DB Settings group box, and
then click Edit. In the L ocal Database Configuration window that appears, make the
changes according to your needs, and then click OK.

To delete alocal database, select the local database in the L ocal DB Settings group box,
and then click Delete. Click Y esto confirm the deletion in the popup message box.

4.2.1.2.7 Runtime Settings

The Runtime Settings tab specifies:

1.

the company name and the application name that will be displayed on the Appeon
Download Center when the Web application starts.

the mobile device type (tablet or smartphone) on which the mobile application will run.

the mobile application name, icon, and app description that will be displayed in Appeon
Workspace.

For optimal display quality, we recommend using icons with 86 x 86 pixels for low-
resolution screens (such asiPad 2), and 172 x 172 pixels for high-resolution screens
(such asiPad 4). But generally you can use icons with any size, because icons smaller
than the above recommended size will be automatically stretched to the proper size for
the corresponding devices; and icons larger than the above recommended size will be
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automatically shrunk to the proper size for the corresponding devices. Therefore, for

convenience, you can use icons with 172 x 172 pixels or above for all devices.

The recommended formats are PNG and JPG. For other supported formats, refer to
Section 2.10, “Image & Icon” in Mobile Ul Design & Development Guide (Mobile only).

If you leave the M obile App I con field empty, the default icon will be displayed in

Appeon Workspace.

Figure 4.28: Runtime Settings dialog box

%5 Application Profile Configuration @
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“Web Service Profiles Offline Settings Runtime Settings Summary
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Device Type: Bath - |

kobile App Mame: Sales App Dema

Maobile &pp | con; ChUzershPublichDocuments\AppeonDeveloper20l 3happect | Browse... |

Mobile &pp Description; A sales app that tracks customers, orders, and product information. r
] ] | Cancel

4.2.1.2.8 Summary

The Summary tab offers a summary view of al configurations of an application profile. It
lists the configurations in a treeview structure, and allows you to review and modify their

values directly.

Use the following two methods to input or modify the configuration (property values):

 For properties that you can input or select values by using atext field, radio buttons, or
dropdown list, such as Mode, Web Folder, PBL version, etc., you can directly double click

their Property Values column and then input, modify or select values.
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 For properties that you can add/del ete multiple items by using a dialog box, such as
application PBLs, INI files, etc., you can right click the property name in the Application
column and then select Add or Delete All from the popup menu.

The configuration changes you make in this Summary tab page will be immediately
synchronized to the other tab pages, but only after you click the OK button, the changes will
be saved.

Figure4.29: Summary tab
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4.2.2 Managing database type profiles

Database type profiles configuration is the easiest way to manage the database types that
Appeon Deployment Wizard supports for application deployments. Y ou can configure
database type profilesin the DB Type Profilestab, and apply a database type profile for
an application deployment by selecting the profile in the Appeon Developer Configuration
Wizard or in the DB Settings tab of the application profile settings.

Database type profilesin Appeon Developer are different from database profilesin
PowerBuilder:

* You only need to configure one database type profile for a given database type. For
example, if application A connects to Sybase ASA/SQL Anywhere database d1 and
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application B connects to Sybase ASA/SQL Anywhere database d2, you can use the
database type profile Sybase ASA | UltraLite for both applications, although the connection
information in the profile Sybase ASA | UltraLite sets up connection to Sybase ASA/SQL
Anywhere database d1.

» Database type profiles are not used for setting up connections with application databases.
Instead, they are mainly used by Appeon Deployment Wizard to call the relevant database
driver for converting PowerBuilder SQL statements.

To modify a database type profile, take the following steps:

Step 1: Click the Configur e button on the Appeon Developer toolbar, and select the DB
Type Profiles tab on the Application Developer Configuration page as shown in the
following figure.

The Database Type column lists all the database types that are supported by Appeon; and the
Configured column indicates whether a database type profile has been configured.

Figure 4.30: DB Type Profiles
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Step 2: Select a database type profile (for example, Sybase ASA | UltraLite), and click the
Configur e button to configure the database type profile, as shown in the following figure.
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Figure 4.31: Database Type configuration

pt s Database Type Profile Configuration @
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Step 3: Specify the information needed for setting up the database type profile.

Outer Join Syntax: Specify how Appeon format the SQL syntax for outer joins, you

can select corresponding format from the drop-down list in the Database Settings frame.
Regardless of the settings in PowerBuilder, it is recommended to use ANSI as the outer join
syntax format in Appeon.

ODBC Interface: Select thisoption if you use an ODBC interface. Specify the ODBC data
source, User ID, and Password.

Table 4.10: ODBC interface settings

Setting Instructions

Data Source | All the data sources configured in Windows ODBC Administrator are
listed. Select a proper data source of the configured database type from the
dropdown list. It is not necessary to specify the actual databases that the
application uses.

Click ODBC Administrator to configure an ODBC data source if it is not
available.

User ID Type in arecognized (set) user name to login to the database. If no user name
has been set, leave thisfield blank.

Password | Typein the password used to log in to the database. If no password has been
set, leave thisfield blank.

Native Interface: Select this option if you use a native database interface. Specify the server
name/IP, User 1D, Password, and the database name.
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Note: Not al the listed database types are supported by Appeon for the native database
interface. If Sybase 1Q, Sybase ASA | UltraLite or IBM DBZ2 is your database type, the
Native Interface option is disabled.

Table4.11: Native database interface settings

Setting Instructions

Server Enter the machine name or |P address of the server where the target database
resides.
User ID Type in arecognized (set) user name to login to the database. If no user name

has been set, |leave thisfield blank.

Password | Typein the password used to login to the database. If no password has been
set, leave thisfield blank.

Database Specify the name of the database that will be used by the application.
Release (ASE only) Specify the version number of ASE database.

Step 4: Specify the "Enclose table and column namesin double quotes’ option. It
determines whether Appeon Developer encloses the names of tables, columns, indexes, and
constraints in double quotes when it generates the database syntax during deployment.

Notes:

1) When this option is selected, verify that the quoted_identifier setting is set to ON in the
database server.

2) Clear the check box of this option when the updated table name of DataWindow contains
the owner name.

Step 5: Click Test Connection to test the connection to the database.

4.2.3 Managing server profiles

A server profile isaset of parameters for Appeon Developer to connect to, and deploy
applications to, a particular Appeon Server or Web server. Creating and using server profiles
isthe easiest way to manage your application deployments because you can:

» Select one or more Appeon Server profiles and Web Server profiles to set up a deployment
profile.

» Easily add, edit, and remove server profiles.

» Test connections in server profiles. If the connection is successful, it means that the
application can be deployed to the server configured in the server profile.

» Manage which applications are accessible from the Appeon Devel oper shortcut Run
button. The shortcut lists the applications that are deployed to the default server profiles.

4.2.3.1 Server Profiles tab page

There are two main parts on the Server Profilestab page, as shown in the following figure.
The upper part isfor management of Appeon Server profiles, while the lower part isfor
management of Web server profiles.
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Figure 4.32: Server Profiles
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4.2.3.1.1 Default server profiles

Y ou can select an Appeon Server profile or aWeb Server profile asthe DEFAULT server
profile on the Server Profiles tab page. Appeon Developer's Run shortcut reads the default
server profiles and lists the applications that are deployed to default server profiles, enabling
you to quickly access them. Applications that are deployed to non-default server profiles
are not available in the shortcut. For details about the shortcut, refer to Chapter 8, Running
Appeon Applications.

4.2.3.1.2 Edit, add or delete server profiles

Two sets of Edit, Add, and Delete buttons are available on the Server Profiles tab page for
you to modify, create, or remove Appeon Server or Web Server profiles. Section 4.2.3.2,
“Appeon Server profile settings’ and Section 4.2.3.3, “Web Server profile settings’ provide
instructions on how to configure the properties for an Appeon Server or Web Server profile
when you modify or create a new server profile.

4.2.3.2 Appeon Server profile settings

Before you edit or add an Appeon Server profile, make sure that the Appeon Server specified
in the profile is running, and that the Appeon Developer computer can successfully connect
to the Appeon Server computer.

If you want to deploy the application to an Appeon Server cluster, you must create profiles
for each participating Appeon Server and deploy the application to all Appeon Serversin the
cluster.
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The following figure shows the Appeon Server Profile Configuration window that displays
when you click the Edit or Add button in the Appeon Server group box of the Server
Profiles tab page.

Figure 4.33: Appeon Server Profile

rﬁ Appeon Server Profile Configuration @ﬂ
Profile Settings Appeon Server Settings
Profile Name: Server Type: JZEE @ MET
Server: localhost

Server Port [hitp]: 20

AEM Settings Deployment Security Settings
YWhen using HTTPS, please make sure vou have Deployment Security:  Dizabled Get State
configured a liztener for the S5L connection to this -
Appeon Server.

Ilzername and Password should be configured in AEM.
AEM  http/? localhost: B0AAEM

Connection Method: i@ HITP HTTFs

Test Settings

After entering the Appeon Server settings, we recammend you test the settings by clicking the button below.

Test Appeon Server Settings...

[ ] ]| Cancel |

The following table lists detailed instructions on how to specify the properties for an Appeon
Server profile.

Table 4.12: Appeon Server profile properties

Property Instructions

Profile Profile Name | Assign aname to the Appeon Server profile.

Settings Y ou should use names that are easy to remember and

identify (for example "Appeon Server for Test" or "Remote
Appeon Server").

Appeon Server Type Select J2EE if Appeon Server isinstalled to EAServer,
Server JBoss, JEUS, WebL ogic, NetWeaver, or WebSphere; select
Settings NET if Appeon Server isinstalled to Microsoft .NET
Framework.

Server Enter the IP address or the machine name of the Appeon
Server.

Server Port Enter the HTTP port number used by Appeon Server.
(http)

Note: Do not enter an HTTPS port here, Appeon Devel oper
must use an HTTP port to connect with Appeon Server,
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Property

Instructions

though the Appeon deployed application can be connected
with an HTTPS port.

AEM
Settings

AEM URL

The URL for Appeon Enterprise Manager (AEM) will be
automatically generated after you specify the Server and
Server Port. The URL will bein the following format:
http://server:port/ AEM, (for example, http://localhost:9988/
AEM).

Note:

1) If you use EA Server as Appeon Server, the Appeon
installation program creates an HTTP listener (localhost:
9988) for Appeon Server. If the Appeon Server configured
isalocal computer, the following URL should always
work: http://localhost:9988/AEM.

2) Do not use a"locahost” listener in a production
environment.

Connection
method

Select HTTP or HTTPS to connect to AEM.

If the Web server is configured as an SSL Web Server,
check the HTTPS (secur e) option. Otherwise, check the
HTTP (insecure) option.

Deployment
Security
Settings

Deployment
Security

The Get State button can get the state of the Deployment
Security settingsin AEM. If Deployment Security is set
to ON, the state will be "Enabled" and you must specify
the deployment user name and password. By defaullt,

the Deployment Security in AEM is OFF, so the stateis
"Disabled".

Username

Enter the username used to deploy the application.

The username and password for the deployment security
feature are configured in Appeon Enterprise Manager
(AEM).

The username can be left blank if the deployment security
featureisturned off in AEM.

Password

Enter the password used to deploy the application.

The username and password for the deployment security
feature are configured in AEM.

The password can be left blank if the deployment security
feature isturned off in AEM.

After profile configuration, perform the following steps to make sure the Appeon Server
profile can be successfully used for application deployments:

» Check whether the deployment security settings are configured correctly. The username
and password in the deployment security settings must be the same as those configured in
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AEM. Make sure you get the correct deployment username and password from the AEM
administrator.

» Test Appeon Server settings by clicking the Test Appeon Server Settings button. Do
NOT proceed to the next step until the testing succeeds.

4.2.3.3 Web Server profile settings

Before you edit or add a Web Server profile, make sure the Web Server specified in the
profile is running and that the Appeon Developer computer can successfully connect to the
Web Server computer.

The following figure shows the Web Server Profile Configuration window that displays when
you click the Edit or Add button in the Web Server group box of the Server Profiles tab
page.

Figure 4.34: Web Server profile configuration window

r R
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Profile Settings YWeb Server Seftings
Profile Manme: Server Type: Microsaft 115 - |
File Transfer Type: | Lacal Server - HTTF Server. localhost
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Local Server Settings FTP File Tranzfer Settings
"Wieh Boat Path: C:hinetpubhwnssroot 1

[E.q.. for EAServer WWeb Server, thiz should be the

full path to ZlAGUARZ RtmL )
Browse. ..

Test Settingz

After entering the ‘Web Server zeftingz, we recommend that you test the zettingz by clicking the button below.

Test Web Server Settings...

[ ] ]| Cancel |

The following table lists detailed instructions for how to specify the properties for a Web
Server profile.

Table4.13: Instructionsfor creating a Web Server profile

Property Instructions

Profile Profile Name | Assign aname to the Web Server profile.
Settings
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Property

Instructions

Y ou should use names that are easy to remember and
identify such as"Web Server for Test" or "Production Web
Server".

File Transfer
Type

Use Loca Server if the Web Server is on the local
machine.

Use Remote Server if the Web Server locates remotely.

Web Server
Settings

Server Type

Select the Web server type.

Appeon supports the following Web Server types. Apache,
EAServer, 1S, JBoss, WebL ogic, WebSphere, NetWeaver,
and JEUS.

HTTP Server

Enter the | P address or the machine name of Web Server.

HTTP Port

Enter the Web Server port number.

Note: Do not enter an HTTPS port here, even though the
Web server is configured as an SSL Web server, because
Appeon Developer must use an HTTP port to connect
with Web server. However, you can access the deployed
application with the HTTPS port.

Local Server
Settings

Web Root Path

Enter the home directory of the Web server (for example:
for Apache, the home directory is <apache root>\htdocs

for EA Server, the home directory is C:\Program Files
\Sybase\EA Server6\html;

for I1S, the home directory is C:\Inetpub\wwwroot;

for JBoss 5, the home directory is <jbossb root>\server
\<instance name>\deploy;

for JBoss 7, the home directory is <jboss7 root>\standal one
\deployments;

for WebL ogic 8, the home directory is C:\bealuser_projects
\domains\appeon_domain\applications,

for WebLogic 9/10, the home directory is C:\bea
\user_projects\domains\appeon_domain\autodeploy;

for WebSphere, the home directory is C:\IBM
\WebSphere6\AppServer\installableApps,

for JEUS, the home directory is

1. <jeus root>\webhome\app_home\autodeploy (for
automatic deployment);

2. <jeusroot>\webhome\app_home (for manual
deployment).
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Property Instructions

For NetWeaver Application Servers, specify any path and
then deploy the War file in the NetWeaver's administrative

console.
Click the Browse button to select the home directory of the
Web server.
FTPFile FTP Port Enter the FTP server port number. Thetypical FTP port is
Transfer port 21.

Settings If you use a remote Web Server, Appeon Developer will

upload the filesto Web Server using FTP protocol. Note
that Appeon Developer works as a passive FTP client when
uploading files. So you need to make sure that you are
using passive FTP and the FTP data port and command
port are configured properly in the firewall.

FTP Username | Enter the username for FTP login.

If the FTP server offers anonymous access then the
username should be anonymous.

FTP Password | Enter the password for FTP login.

If no password is set for the FTP server or the FTP
Username is anonymous, leave this field blank.

After the profile configuration, perform the following steps to make sure the Web Server
profile can be successfully used for application deployments:

» Test Web Server settings by clicking the Test Web Server Settings button. Do NOT
proceed to the next step until the testing succeeds.

If the Web Server is aremote server, refer to Section 4.2.3.3.1, “Two requirements for FTP
settings” to make sure the configuration for the Web Server profile is successful.

If the Web Server isan SSL Web server, refer to Section 4.2.3.3.2, “If the Web Server
isan SSL Web Server” to make sure the configuration for the Web Server profileis
successful.

4.2.3.3.1 Two requirements for FTP settings

If you configure aWeb Server profile for aremote Web Server, make sure the FTP settings in
the Web Server profile meet the following two requirements:

» The user name and password for accessing the FTP server should have permission to read
and write filesto the FTP server of the Web Server.

» The FTP home directory should be mapped to the Web root of the Web Server.

The following steps use the Microsoft 11S FTP service as an example to show you how to
fulfill the requirements. Y ou should find that the settings for other FTP types are similar to
the settings for Microsoft IS FTP.
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Step 1: On the FTP server (Web Server), open the Internet Services Manager in
Administrative Tools, as shown in the following figure.

Figure 4.35: FTP configuration

'Tﬂ Internet Information Services (I5) 6.0 Manager = [ ===
3 File Action  Wiew Window  Help - [=
e Rz Bm 2|

iihJ InternetInformation Service Description Identifier State IP address Pe
4 SN TESTOZAIVISTA llocal ecl| @Ree U FTH Site 1 Running %8Il Unassigne.. 11

4 | FTP Sites
% Default FTP Site
4 1 ] m b

Step 2: Right click on Default FTP Site and select Propertiesin the popup menu. The
Default FTP Site Properties window is displayed.

Step 3: Go to the Home Directory tab and verify that:
» TheLoca Path isthefull path to the Web Server document root.

» The Write property of the FTP Site Directory is enabled.
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Figure 4.36: FTP site properties
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Step 4: Go to the Directory Security tab and verify that the Granted Access option is checked,

as shown in the following figure.
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Figure 4.37: Directory security

Default FTP Site Properties (-7 | [
FTP Site | Security Accounts | Messages | Home Directory DIFEE'I':'W5EE'-IFI'I':-“
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4.2.3.3.2 If the Web Server is an SSL Web Server

If the Web Server isan SSL or secure Web Server, you can configure the Web Server profile
following the configuration instructions for non-SSL Web Servers, except for the following
two points:

1. You need to configure an HTTPS listener and port number for the Web Server.

2. You must specify an HTTP (not HTTPS) listener and its port number in the HTTP server
settings of the Web Server profile, because Appeon Developer must use the HTTP
protocol when deploying the Appeon application files to the server. After the application
is deployed to the Web server, you can input "https" instead of "http" and the HTTPS port
in the URL to access the application, (for example, https://192.0.0.80:8181/appeondemo/).

4.2.4 Managing deployment profiles

A deployment profile associates specified Web Server(s) and Appeon Server(s) as a group
used for Web or mobile deployment. Y ou may create several deployment profiles (e.g. local
deployment, test deployment, production deployment, and so on), and set the most commonly
used profile as the default profile.

A deployment profile is based on server profiles. Before configuring the deployment profiles,
make sure you have set up one server profile for each of the Appeon Servers and Web
Serversto be used for the Web or mobile conversion. Y ou can add as many deployment
profiles as you need, but there can be only one default deployment profile.
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4.2.4.1 Deployment Profiles tab page

On the Deployment Profile tab, you can edit, add, or delete deployment profiles and specify a
default deployment profile.

Figure 4.38: Deployment Profile tab page

95 Appeon Developer Configuration @

| Application Profiles I DB Type Profiles I Server F'ru:ufiles| Deployment Profiles | Data Source Praofiles

Deplovment Profiles

Configure the deployment profiles for your applications. & deplovment profile iz a collection of Appeon Servers and
Wieb Servers that pou will deploy 'w/eb or Mobile applications to.

Default  Profile Mame Deplopment Type Mumber of Servers Edi...

m Local Deployrnent MET

IJ}|:
[l
[N

Delete

[ OF. ][ Cancel ]

The following table describes the tasks you can perform on the Deployment Profile tab.

Table 4.14: Instructionsto use the Deployment Profile tab
Usethisbutton To

Default radio Specify the default deployment profile used for Web or mobile
button deployment.
Edit button Modify an existing deployment profile. Thiswill open the Deployment

Profile Configuration dialog box.

Add button Create a new deployment profile. Thiswill open the Deployment
Profile Configuration dialog box.

Delete button Remove a deployment profile.

4.2.4.2 Deployment profile settings

In the Deployment Profile Configuration dialog box, set up the necessary configuration, as
shown in the following figure.
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Figure 4.39: Deployment Profile

ot Deployment Profile Configuration @
Erofile M arne:
Appeon Server Wb Semver
Deploy to one ar mare Appeon Servers. Deploy to one or more “Web Servers.
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The following table describes the settings on the Deployment Profile Configuration dialog

box.

Table 4.15: Deployment Profile settings

Inthisfield Youcan

Profile Name

Type the deployment profile name.

Y ou can use names that are easy to remember and identify such as Test
Deployment, Remote Deployment.

Appeon Select a check box to include the Appeon Server in the deployment profile.

Server All the Appeon Server profiles you have created are listed. More than one
Appeon Server can be selected.

Web Server | Select a check box to include the Web Server in the deployment profile.

All the Web Server profiles are listed. More than one Web Server can be
selected.

Note: If the server type of Appeon Server profileis.NET, then the server
type of Web Server profile must be Microsoft I1S.

Click OK to save the new settings and return to the Deployment Profiles tab.
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4.2.5 Managing data source profiles

Note: This Data Source Profiles tool works for Microsoft .NET Framework\IIS, but does not
work for EAServer 6.x, JBoss, JEUS, WebL ogic, NetWeaver, and WebSphere.

To create data source for EAServer 6.x, JBoss, JEUS, WebL ogic, NetWeaver, and
WebSphere, refer to Chapter 4, Database Connection Setup in Appeon Server Configuration
Guide for J2EE.

Appeon applications use JDBC data sources created in Appeon Server to connect to the
database. The Data Source Profile tab allows you to maintain a storage of data sources which
you can specify to use for Appeon applications. Its function is the same as the one provided
in AEM, and changes made on the tab or AEM are automatically synchronized.

Figure 4.40:; Data sour ce profile

95 Appeon Developer Configuration @

| Application Profiles I DB Type Profiles I Server Profiles | Deployment Profiles | ['ata Source Profiles

[ata Source

Configure the data zource anly if your Appeon Server iz installed on 15, Data sources in the selected Appeon
Servers will be automatically displaged.

Appeon Server: -
Marme DB Host Edit...
Add...
Delete
[ QK ] I Cancel

Follow the instructions below to create a data source on the Data Source Profile tab:

Step 1: Select an Appeon Server from the Appeon Server list box. Only the configured
Appeon Server profiles are listed.

The data sources existing on the application server will be displayed.
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Figure 4.41: Data sour ces existing on the application server
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Step 2: Click the Add button to create a data source in the application server. The Add dialog

box is displayed.
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Figure 4.42: Add a data source

ﬁ Add Data Source @
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The following table provides instructions for how to specify the data source settings.

Table 4.16: Instructionsto specify data sour ce settings

Settings Instructions

Name Type the name of the data source.
The data source name can contain a combination of letters, underscores
("_"), and numbers. Do not use double-byte characters (such as Chinese,
Korean, Japanese characters, etc.) or spaces.

Driver Select the driver type for the data source.

Host Type the database host.

Port Type the database port.

Database Name | Type the database name.
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Settings Instructions

ODBC Data Type the data source name only when the driver typeis ODBC-JDBC
Source Bridge.

User Name Type the database |ogin username. The username is set on the database
server.

Password Type the database |ogin password. The password is set on the database
server.

Maximum Specify the maximum number of connections Appeon Server opens and

Connection pools on startup.

Pool Size

Minimum Specify the minimum number of connections Appeon Server opens and

Connection pools on startup.

Pool Size

Connection Specify the timeout period for the connection.

Timeout

Command Specify the timeout period for the commands.

Timeout

Connection Specify the lifetime period for the pooled connection.

Lifetime

To be specific, you can specify the timeout period from the time a
connection is created to the time when the connection returns to the pool.
If the actual lifetime of a connection exceeds that specified in Connection
Lifetime, the connection will be terminated. It is recommended to be
used in cluster configuration when forcing the load balancing between a
running server and a server just brought online.

If the valueis set to O, the pooled connection allows the maximum
connection timeout.

Other Options | Specify the connection_authentication property for Sybase ASA/SQL
Anywhere database.

The value should be "authentic_code=###". "authentic_code" is the key
word, text after "=" should be the authorization code.

Appeon Server will automatically set the connection_authentication
property when connecting with the Sybase ASA/SQL Anywhere database.

This setting is effective to Sybase ASA/SQL Anywhere database only.

Dynamic Select whether to enable dynamic database connection.
Database

When it ison, the LoglD and LogPass of the Transaction object will

Connection be used to connect to the database; when it is off, the user name and
password specified in the data source will be used to connect to the
database.

Pooling Select whether to use the connection pool.
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Refer to Section 4.4, “ Setting up Appeon Server data sources’ in Appeon Server
Configuration Guide for .NET or in Appeon Server Configuration Guide for J2EE for how to
specify the settings for different JDBC drivers and database types.
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5 Using UFA Tool

Unsupported Features Analysis (UFA) tool helps you analyze an application for unsupported

features.

The following table gives brief descriptions of the unsupported features report.

Table5.1: UFA Report

UFA Report

Purpose of the report

Enables you to work around or remove unsupported features
in order to make the PowerBuilder application suitable for
Appeon Web or mobile migration.

What is reported

Most of the unsupported PowerBuilder coding features
including keyword, event, data type, system function, control
(itself and its property, function, event), object (itself and its
property, function, event).

IMPORTANT: There are till some unsupported features
that cannot be reported. These undetected features, though
only asmall number, may make up the largest proportion
of your workload depending on how they are used, so

we strongly recommend you carefully check thelistin
Section 5.1.4, “Undetected Unsupported Features’.

How to generate the report Use the Unsupported Features Analysistool, or perform the
first two tasks in Appeon Deployment Wizard.
Features These features apply for the report:

Automatic incremental analysis. After the first analysis,
the subsequent analysisis automatically incremental to
save time, but the report generated still contains all the
information asif it were afull analysis.

Analysis at application, PBL or object level. Y ou can choose
to generate UFA Report for an application, PBL(S) in the
application, or object(s) in the application.

This chapter describes:

» How to use the UFA tool to analyze an application and generate the UFA Report.

» Undetected unsupported features. There are a small number of unsupported features that
the UFA Report cannot detect.

» How to use the UFA tool to work around unsupported features effectively.

* How to use the UFA tool to manipulate the UFA Report. For example, you can adjust the
view of the UFA Report so it suits your preferences.
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5.1 Analyzing an application

5.1.1 Tasks required before you perform feature analysis

Step 1: Perform an incremental build or object regeneration for the PowerBuilder application.
Right-click on the application target and select a build option (for example, I ncremental
Build) as shown in the following figure.

Figure5.1: Incremental Build

AppecnDeme - PowerBuilder EI@

File Run Tools Window Help

Moo/ dRa @) 8| o= S| X x| F
_EIZF_J.|‘H§5@. XV|mﬁ‘|@%

x
= -:'!r nppeonDemo (C:\Wsers'Public\Documents\Appeon'\Developer2013 appeonDﬁ
(®) appeon_acf_demo {C:\Users\Public\Documents!\Appeon \Developer 20 13YAr
appeon_code_exampl New... m
appeon_code_exampl Appeon\Deve
@ appeonmobiledemo {C Search... tloper2013\A
+-(E] mobile_order (C:\L Set as Current Target Developer:
Remove Target
Library List...
Migrate...
Incremental Build
Full Build
Deploy
Run
Debug
Show 3
Properties..
4 m b Version 11.5 Build 1502

Ready

The following table shows you which type of build options you should select for the
application.

Table 5.2: Recommended build options

Build Option What It Does Recommended For

Regenerate | Refreshes the timestamp for a| Object-level Features Analysis. If the object
PowerBuilder object. is regenerated, the object will be analyzed
even if no change has madeto it.

Incremental | Refreshes the objects that Application-level Features Analysis.
have been changed.

Full Refreshes al objects. Not recommended.

Step 2: Perform PBL optimization for the PowerBuilder application.

The purpose of PBL optimization is to remove gaps from libraries and defragment the storage
of objectsto get rid of potentia problemsin PBL files.
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5.1.2 Accessing the UFA tool

Click the Analyze button (#3) in the Appeon Developer toolbar to launch the UFA tool. The
Unsupported Feature Analysis Report window (UFA Report window) will be displayed.

Figure5.2: UFA Report Window

& Unsupported Feature &nalysis Report - sales_application_dermo E=n| Hol (="
Eile Edit Miew Tools Help
DEd#a 0 AEge X X

UFA Summary

e Unsupported object 1]

|Unsupported powerscript 1]
Unzupported embedded SOL 0
Other i}

UFA Report window provides avariety of menus to help you manage unsupported features.
The following table gives a brief description of these menus. Some of them are also listed as
shortcut menus on the tool bar.

Table5.3: UFA Report Window

Menu Description

File Generates a UFA report. See Section 5.1.3, “Performing feature analysis’.
Opens or saves a UFA report. See Section 5.2.2.1, “Opening or saving a UFA
Report”.

Edit Opens and modifies the unsupported source code in the PowerBuilder painter.

See Section 5.2.1, “Modifying unsupported features’.

Searches for the unsupported features. See Section 5.2.2.3, “ Searching for UFA
Report items”.
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Menu

Description
Filters the unsupported features according to objects, unsupported feature types
or priorities. See Section 5.2.2.4, “Filtering UFA Report items”.

Expands or collapses treeview.

Displays the report in the specified level. See Section 5.2.2.5, * Specifying report
display level”.

View

Selects a display mode of the objects in the Unsupported Feature List treeview.
See Section 5.2.2.2, “ Selecting report view mode”.

Tools

Accesses the workaround for the selected unsupported feature.

Defines the priority settings of UFA Report items. See Section 5.2.2.6, “Defining
the priority settings of unsupported features’.

Customizes the general settings of the UFA Report. See Section 5.2.2.7,
“Customizing the general settings of the UFA Report”.

Help

Provides the version number of the UFA tool.

5.1.3 Performing feature analysis

There are two ways to perform afeature analysis of an application:

» Usethe Unsupported Features Analysis tool. This option enables you to do afeature
analysis of the whole application, or PBL(S) in the application, or objectsin the
application.

» Usethefirst two tasksin Appeon Deployment Wizard. When you use Appeon Deployment
Wizard to deploy an application, the first task the wizard performsis a feature analysis of
the whole application.

This section mainly gives instructions on the first option (using the Unsupported Features
Analysistool). For more information about the second option, refer to Section 6.2
“Deployment process’.

Step 1: Select the File> New Report menu in the UFA Report window. The New UFA
Report dialog box appears, as shown in the following figure.
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Figure5.3: New UFA Report dialog box
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The following table gives a brief description of the elements in the New UFA Report dialog

box.

Table 5.4: New UFA Report window

Element Description

Application profile

Provides alist of application profilesfor you to select and analyze.

dropdown list Only application profiles configured in the Appeon Developer
Configuration window will be listed.
Search field Searches for PBLS or objects that contains the text you enter.

Treeview of objects

Givesthe treeviews of PBLs and objects for the application selected
in the application dropdown list and allows you to select the whole
application or only some objects to analyze.

Display Full Path Gives you options to display or hide the full path of the PBLs and
option objectsin the treeview.
Refresh button Refreshes the PBL and object list in the treeview.

Step 2: Select the application that you want to analyze from the Application profile

dropdown list.

The default target to analyze is the default application profile in the Appeon Developer
Configuration window.
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Step 3: Check the PBLs and/or objects in the treeview for which you want to generate the
UFA Report.

Thetreeview lists all the PBLs and objects contained in the selected target. By default, all
objects are selected.

Step 4: Click the OK button to start the feature analysis.
The feature analysis of the selected objects begins, as shown in the following figure.

Figure 5.4: Unsupported Features Analysis Process dialog
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Step 5: Click Close when the analysisis completed. The UFA Report isloaded into the UFA
Report Window.

5.1.4 Undetected Unsupported Features

Appeon Unsupported Features Analysisis capable of highlighting the majority of
unsupported features contained in the PowerBuilder application. There are still a small
number of features that the Unsupported Features Analysis will not detect, so they will not be
listed in the UFA Report.

An application containing unsupported features can still be converted to the Web or to the
Mobile and may work correctly, depending on the type and number of unsupported features.
If the deployed application does not work correctly and the UFA Report does not indicate any
unsupported features that are likely to cause such problems, the problems may be caused by
unsupported features that have not been detected. In this caseg, it is strongly recommended
that you carefully read the undetected features listed below and examine your application to
determine if it contains any of these features.

Table5.5: Undetected features

Naming conventions » Duplicate object names. No two objects should have the same
name in an application, whether they are of the same type or
not. The Unsupported Features Analysis cannot detect whether
object names are duplicated in an application.

Appeon Developer User Guide Page 74



Using UFA Tool

Appeon® for PowerBuilder® 2015

» More than one application object. Having more than one
application object in an application is unsupported. The
Unsupported Features Analysis cannot detect whether more
than one application object is present.

» Applications named as objects or controls. Application names
that have the same name as PowerBuilder control/object
types are not supported. The Unsupported Features Analysis
cannot detect whether this unsupported issue is present in an
application.

Null values

» Unsupported operation

» Expressions with Null values

ASCII characters

Unsupported special ASCII characters:

* Vertical tab (~v)

Non-visual User Object

A NonVisual Object object assigned to an autoinstantiated NVO
or an autoinstantiated NV O assigned to a NonVisual Object
object.

Variables and constants

* Instance variables have identical names as global variables.
 longlong variable

e PUBLIC, PROTECTED, PRIVATE qualifier in the variable
declaration

Forced conversion

Forced conversion between types

Window

Multiple MDI windows in an application.

Overloading,
overriding functions

» Dynamic caling for overloaded functions

» Dynamic calling for overriding functions

Using thereturn value
of some supported
functions

The return value of the Open or OpenSheet functions

Operators

The operator ‘" with embedded SQL statements.

Stored procedure

 Stored procedures declared in the conditional statement
» DB2 stored procedures
» Stored procedures placed inside an Oracle package

* Oracle stored procedures with Appeon unsupported features

Cursor declare
requirement

» Cursor declared in the conditional statement;

 |If acursor isdeclared for retrieving rows from table X, the
table X (insert, delete, update) is modified during the cursor
declare-close period.
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Cursor statements

» Thefollowing two syntax:

1. UPDATE TableName SetStatement WHERE CURRENT
OF CursorName;

2. DELETE FROM TableName WHERE CURRENT OF
CursorName.

DatawWindow
expression function

lastpos lastposw mode pageAcross

pageCountAcross | profileint profilestring |stdev

var varp

Partially supported
features

Some partially supported features, for example, reading
Object.DatawWindow.CrossTab.Rows is supported by Appeon,
but writing is not, therefore, using Datawindow Modify function
or equivalent to write this property cannot be detected by UFA.

User interface
inter actions

Unsupported features in the Ul such as shortcut key.

Enumerated data type

Default values of enumerate type variable

Data source

The data sources of dynamically created DataWindows are stored
procedures with input parameters.

Dynamic calls

» Dynamically call the method of a menu object.

» Dynamically call the method that contains reference
arguments.

Others

« PBX
* PSR, for example: dw.dataobject="*.psr’

» Unsupported DBParm parameters

» Encoding parameter of the Blob functions

* filename & importtype arguments of ImportFile, ImportString,
& ImportClipboard (filename can only be atext file (TXT))

» Property defined in the string variable

* Structure member has comment property

System events

For acomplete list of undetected system events, refer to
Chapter 12, Undetected Unsupported Features in Supported PB
Features for Appeon Mobile (Mobile only) or in Supported PB
Features for Appeon Web.

5.2 Working with UFA Report

This section describes:
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» How to modify unsupported features. Y ou can use the UFA Report to effectively remove
unsupported features in the application.

» How to manipulate the UFA Report in the UFA Report Window. Y ou can adjust the view
of the UFA Report so it suits your preferences.

5.2.1 Modifying unsupported features

When the UFA Report isloaded, you can view al the unsupported featuresin the left
treeview and modify them one by one.

Step 1: Expand the unsupported feature list treeview and select the unsupported item.

The detailed analysis of the selected method will be displayed on the right of the window, as
shown in the following figure.

Figure5.5: Unsupported feature details
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The right text box shows a detailed code diagnosis on the unsupported code in seven aspects.
the Unsupported Code, Line Number, Location, Unsupported Item, Type, Reason, and
Priority.

Step 2: View the workaround for the unsupported item by right-clicking the unsupported item
in the unsupported feature list treeview and selecting Wor kar ounds solutions.
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* Go To Workarounds Online: Opens the online Workarounds & APl Guide at URL: http://
www.appeon.com/support/documents/appeon_online_help/workarounds and_api_guide/.

* Go To Loca Workarounds. Opens the local Workarounds & APl Guide installed with
Appeon Help, as shown in the following figure.

Figure 5.6: Local Workarounds Guide
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Step 2 - Call the interface function of the component and pass the Pipeline object name and relevant parameters fo it

Step 3 - Call the functionz, properties or evenis of the Pipeline object in the component to implement the same functionalities as the
ariginal PipeLine object

The limitation of this workaround is that only the system Pipeline object can be used in the NVO. That is to say, user-defined objects
inherited fram Pipeline objects are unsupparted in the NVO

Prev Up Next
System Objects Home Application object

Step 3: Modify the unsupported source code in the PowerBuilder painter according to the
Workarounds & API Guide.

Right click the unsupported item in the unsupported feature list treeview, and select Edit or
Edit Sour ce to open the source code in the PowerBuilder Script view.

 Edit: Displays the source code of the event or function, which contains the unsupported
feature. This button is available only if the unsupported code residesin an event or
function and it is not DataWindow-rel ated.

 Edit Source: Displays all source code of the object, which contains the unsupported
feature. This button is aways available.

The PowerBuilder Script view automatically opens, as shown in the following figure.
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Figure5.7: Unsupported codein the Power Builder painter
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5.2.2 Manipulating the UFA Report

5.2.2.1 Opening or saving a UFA Report
Y ou can open or save a UFA Report using the File menu in the UFA Report window.

» To open an existing UFA Report, select the File > Open Report menu. The Open UFA
Report dialog box is displayed. If thereisno UFA report available, select New Analysis
and click OK to analyze an application.

Figure 5.8: Open UFA Report

Open RS Report [5]

@ Open the exsting IUFA report of an application

zalez_application_demo | - |

Open the UFA repart from:
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O Mew Analysiz

| 0k, | I Cancel

» To save aUFA Report, select the File > Save menu.
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» TosaveaUFA Report with anew name, select the File > Save As menu.

5.2.2.2 Selecting report view mode

Y ou can view the UFA Report in four different modes. Go to the View menu in the UFA
Report window and select the desired mode:

» Category: Enables you to view the unsupported features in the following categories:
Unsupported Objects, Unsupported PowerScript, Unsupported Embedded SQL and Others.

» Hierarchy: Enables you to view the unsupported featuresin hierarchical order: PBL,
Object, Control, Method (Event/Function).

* Priority: Enables you to view the unsupported features in priorities (you can go to the
Tools > Define Priority menu to define the priorities of the PowerBuilder features): Have
to modify, Suggest to modify, Can be ignored.

e Summary: Enables you to view summary information of each unsupported feature.

Y ou can set the default view mode in the Tools > Options menu. For detailed descriptions,
refer to Section 5.2.2.7, “ Customizing the general settings of the UFA Report”.

5.2.2.3 Searching for UFA Report items

To do aquick search, you can directly enter the text that you want to search in the search
field of the UFA Report window. Or follow steps below to use the standard Find Text dialog
box:

Step 1: Select the Edit > Find menu. Or right click in the unsupported feature list treeview
and select Find.

Step 2: Inthe Find Text box, enter the text that you want to search.
Step 3: Select any other options that you want.
Step 4: Click Find Next.

Figure5.9: Find Text

Find Text @
L i ciine] 2 Find Next
tatch caze | Cloze |

Uze * az wildcard

Wwrap at beginning or end
Help

5.2.2.4 Filtering UFA Report items

Filtering helps you restrict the number of the unsupported features displayed in the UFA
Report and quickly find the target unsupported features, especially when there are alarge
number of unsupported features in the application.
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Y ou can filter the unsupported features by the objects they reside in, or by the feature types,
or by the priorities.

5.2.2.4.1 Filtering by objects

Step 1: Select the Edit > Filter by Object menu. Or right click in the unsupported feature list
treeview and select Filter by Object.

The Filter by Object dialog box is displayed, as shown in the following figure.

Figure5.10: Filter by object
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Step 2: Make sure that the unsupported objects you want to display in the report are on the
right list box, whereas the unsupported objects you want to hide are on the left listbox. Click
OK.

To quickly select all objects of the same type, right click the list and select an object type.

The UFA Report hides the unsupported objects that are on the left listbox in the Filter by
Object window.

5.2.2.4.2 Filtering by categories

Step 1: Select the Edit > Filter by Category menu. Or right click in the unsupported feature
list treeview and select Filter by Category.

The Filter by Category dialog box is displayed, as shown in the following figure.
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Figure5.11: Filter by Category
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Step 2: Make sure the categories of the unsupported features you want to display in the report
are on the right listbox, whereas the categories of the unsupported features you want to hide
are on the left listbox. Click OK.

The UFA Report hides unsupported features that belong to the categories that are on the left
in the Filter by Category window.

5.2.2.4.3 Filtering by priorities

Step 1: Select the Edit > Filter by Priority menu. Or right click in the unsupported feature
list treeview and select Filter by Priority.

The Filter by Priorities dialog box is displayed, as shown in the following figure.
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Figure5.12: Filter by Priority
Filter by Priority =
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Suggest to modify
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Step 2: Uncheck the priorities of the unsupported features which you want to hide. For
example, if you want to hide the features that can be ignored, uncheck the Can beignored
option.

Step 3: Click OK.
The UFA Report only displays unsupported features of the specified priorities.

5.2.2.5 Specifying report display level

Y ou can quickly expand or collapse a node of the unsupported feature list treeview by
selecting Expand Sub-node or Collapse Sub-node from the Edit menu or from the popup
menu on any node.

Y ou can also specify the display level using the following steps:

Step 1: Select the Edit > Display L evel menu.

Step 2: In the Display L evel box, enter the number of the level at which the unsupported
feature list treeview will display.

Figure5.13: Display Level
Display Lewel ==

Select hierarchical level of the tree view display.

Levels; || | - |

Step 3: Click OK.
The UFA Report only displays unsupported features of the specified level.
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5.2.2.6 Defining the priority settings of unsupported features

By default, Appeon divides all unsupported features into three priority levels:

» Haveto modify: The features flagged with Have to modify are important in the

application and will cause significant functionality lossif they are not modified or worked

around.

» Suggest to modify: The features flagged with Suggest to modify will not necessarily cause
functionality lossif they are not modified or worked around. Y ou can decide whether to
modify them according to their functionalitiesin the application.

» Can beignored: The features flagged with Can beignored are small or trivia features
which will not compromise application functionality even if they are not modified or

worked around.

To customize or change priority levels for unsupported features, take the following steps:

Step 1: Select the Tools > Define Priority menu. The Define Priority window is displayed,

as shown in the following figure.

Figure5.14: Define Priority dialog box
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Step 2: Add, modify or delete the system default prioritiesin the left Priority L evel box.

Step 3: Change priority levels of unsupported feature types by selecting a priority level in the

Priority Name column.

Step 4: Click Save to save the priority settings.
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Click Reset to Default to restore the system default priority settings.

5.2.2.7 Customizing the general settings of the UFA Report

Y ou can define your preference settings of the UFA Report window. These settings include
default report view mode, display formats of PBLS, feature count, unsupported source code
edition, and filtering. The new settings will be saved as the default settings.

Select the Tools > Options menu in the UFA Report window. The General Settings
window is displayed, as shown in the following figure.

Figure5.15; General Settingsdialog box
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» Default Report View group box: Select the default view mode of the UFA Report. For
detailed description of each view mode, refer to Section 5.2.2.2, “ Selecting report view
mode”.

» Display Full Path of PBL Files: Displays the full path and the file name of the PBLsin the
UFA Report.

» Display Unsupported Feature Count: Displays the total number of the unsupported
featuresin the UFA Report.

» Auto start PowerBuilder and load target application: Enables PowerBuilder to
automatically start and load the target application when you click the Edit or Edit Source
button in the UFA Report window.

* Filter Previous Results: Allowsyou to filter only the results of a previous filter. It narrows
afilter that resulted in too many data the first time. If you want to search al data of the
report, leave this option as unsel ected.
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6 Deploying PowerBuilder Applications

Appeon Deployment Wizard deploys PowerBuilder applications to be Web or mobile
applications. The deployment should take place only after the application has undergone
careful analysis and isin compliance with the Basic and Architectural Requirements defined
in Chapter 2, Basic Requirements and Recommendations in Supported PB Features for
Appeon Mobile (Mobile only) or in Supported PB Features for Appeon Web.

The Appeon Deployment Wizard handles the deployment in five steps:
1. Exportsthe PowerBuilder application source code.

2. Analyzesthe PowerBuilder application to verify that it does not contain unsupported
features.

3. Parsesthe PowerBuilder source code (PBL files) into Web or mobile application files that
are stored on the local machine.

4. Uploads the DatawWindow syntax to Appeon Server.
5. Transferslocal application filesto the Web Server by either file copy or FTP.

Notes:

1) Deploying to an SSL Web Server is no different than deploying to a standard Web
Server. You only need to make sure that the SSL Web Server is set up correctly and isfully
functional. For detailed instructions on configuring a Web Server as an SSL Web Server,
refer to the corresponding documents provided by the Web server vendor.

2) If you want to re-deploy an application which is now running online:

* You can incrementally deploy the application while keeping the application running
online, if non-database related source code and image files are changed.

* You must shut down the running deployed application and then full or incrementally
deploy the application if the INI files or database-related source code are changed.
Otherwise, the application may have runtime problems such as database connection failure
or missing tables or fields.

6.1 Deployment performance

The deployment process can be very CPU and memory intensive, so we recommend that
you use a developer computer that conforms to the recommended specifications outlined in
Chapter 3, Installation Requirements in Installation Guide for .NET for a Developer PC to
run Appeon Developer.

Be sure to close any unnecessary programs and Windows services in order to have an optimal
amount of memory available for the deployment process.

6.1.1 Speed of Deployment Process

The table below benchmarks the time taken or speed to compile various applicationsin
PowerBuilder and deploy to the Web or mobile with Appeon. In general, the results indicate
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that the speed of the Appeon deployment processis similar to the speed of the PowerBuilder
compilation/build process.

Table 6.1: Appeon Application Deployment Time Benchmarks
PB EXE w/ PBDs PB EXEw/DLLSs Appeon

Sales Application 20 seconds 50 seconds 22 seconds

Demo (5.55M)

Appeon Code 1 minutes 3 seconds | 12 minutes 37 1 minutes 12 seconds

Example Demo seconds

(20.5M)

ACF Demo (21.5M) |2 minutes 5 seconds | 24 minutes 46 2 minutes 12 seconds
seconds

Asagenera rule of thumb, each additional megabyte of PBLs will add approximately 8
seconds to the full deployment process. For example, it would take 4 minutes to deploy
a30MB PFC application. Thiswould only apply for theinitia or full deployment. All
subsequent deployments should take no more than few minutes or even possibly aslittleasa
few seconds.

This rule of thumb applies to hardware configurations that meet the minimum Developer PC
requirements stated in Chapter 3, Installation Requirementsin Installation Guide for .NET.
Machines with a slower clock-speed will take longer to perform the deployment.

6.1.2 Deployment duration for full deployments

Remember the following main points regarding the deployment time:

» The processisvery CPU and memory intensive.

» Thesize and complexity of the application affect the deployment time.

The following is an example of how long it takes to deploy an application with 3.69 MB in
PBLs and images using full deployment:

Table 6.2: Deployment duration

Deployment Task Elapsed Time

Task 1: Application Source Code Export 8 seconds
Task 2: Application File Generation 27 seconds
Task 3: Web or Mobile Deployment 15 seconds (for alocal deployment)

Test environment: asingle CPU Intel P4 1.8 GHz with 256 MB RAM and 60 GB IDE hard
drive

All of the generated application files deployed to the server are acombined 1.25 MB in size.

6.1.3 Deployment duration for incremental deployments

Sincetheinitia full deployment can be time-consuming, Appeon provides an Incremental
Deployment for maintaining or upgrading an already-deployed application. This feature
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only re-deploys the incremental changes that have been made in the application. Appeon can
detect whether an object has been modified and re-deploy only the changed objects.

6.2 Deployment process
6.2.1 Preparing the PowerBuilder application
Appeon recommends that you perform a build and PBL optimization on the PowerBuilder

application before performing an Appeon Application Deployment. The following table
shows you which type of build options you should select for the application.

Table 6.3: Build options

Build Option What It Does When To Perform
Incremental build Refreshes the objects that have been | Before afull or
changed. incremental deployment.
Full build Refreshes all objects. Not recommended.
Optimize PBLs Removes unused spaceinthe PBLs | After building the
as stored on disk, and reduces object | application but prior to
fragmentation. deployment.

Performing an incremental build in PowerBuilder is necessary because when modifications
are made to a parent class, the child class does not reflect the changes unless one of three
things occurs:

1. The child classis opened and saved.

2. Anincremental build is performed.

3. A full build is performed.

6.2.2 Specifying the deployment settings

Click the Deploy button (‘ﬁ) in the Appeon Devel oper toolbar. The Appeon Deployment
Wizard is displayed.
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Figure 6.1: Appeon Deployment Wizard
r‘ﬁ Appeon Deployment Wizard - sales El [=] @-‘
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Fleaze ensure that the corect PowerB uilder application and deployment settings have been
zelected and press Mest to continue.
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| Generate Unzupported Features Analyzis Report

[ Mext » ] | Cancel |

The following table describes how to specify the deployment settings for an application:
Table 6.4: Appeon Deployment Wizard settings

Setting Description

Application to be | Select an application to be deployed.

deployed list box | 10 gefauit application is listed by default. The application chosen
for deployment will become the default application under Application
Profilesin Appeon Developer Configuration.

Deployment Select a deployment profile to be used in the Web or mobile deployment.

Profile list box The selected deployment profile determines which Appeon Server(s) and

Web Server(s) the application will be deployed to. Y ou must make sure
the Appeon Server(s) and Web Server(s) are started before you perform

the deployment.
Deployment Select one of the three available deployment modes:
Mode list box

 Full Application Deployment

* Incremental Application Deployment

» Deploy Already Generated Application
Unattended Specify whether the whole deployment process will automatically
Deployment proceed without displaying the Next button or waiting for interaction.
check box

If you want to view the messages or reports generated at each step, you
can set the unattended deployment to false; the wizard will require you to
click the Next button to start the next task until the whole conversion is
complete.
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Advanced button | Select the types of objects or files that will be uploaded to servers:
DataWindow objects, other objects, INI files, external DLL/OCX files, or
image files. By default, al objects and files will be uploaded.

This button is effective only for the Deploy Already Generated
Application option.

When use this function, verify that the target servers are the same ones
used in the application deployments.

Generate Specify whether to generate an unsupported feature analysis report during
Unsupported deployment.

;ea;lurqﬁ R Thisreport lists all unsupported PowerBuilder coding featuresin the
chnecIi/ ?acs)x eport application. Y ou can use this report to remove or work around the

unsupported features. For detailed instructions, refer to Section 5.2
“Working with UFA Report”.

6.2.2.1 Selecting the deployment mode

The following table describes the three different deployment modes and guides you in
choosing the proper deployment mode.

Table 6.5: Deployment mode

Deployment What It Does Elapsed Time When ToUse It
Mode
Full Exports all PowerBuilder Depends on 1. Thefirst time an
deployment | application objects and code, the size and application is deployed
generates the corresponding complexity of to the Web or to
filesfor the Web or mobile the PowerBuilder | mobile.
f\ppllcatlon, and deploys all files| application. 2. After making
o the server.

changesto any ESQL.

Incremental | Exports objects, re-generates Upto80%less |After making changes
deployment | and re-deploysfiles for the time than a full to an already fully-

changed objects only. deployment. deployed application's
The Deployment Wizard source code or features
in the application

continues even if it finds

unsupported features during this profile.
process.
Deploy Bypasses the object exporting | Much lesstime | When you intend to:
Already and file generation tasks and than aFull or :
1) deploy thefil
Generated only re-deploys the Web or Incremental f c))r tﬁ; (c):i/}angetlj s
Application |mobilefilesfor the changed Deployment. objects to the server

objects or for the entire

application after an Incremental

Deployment has been
cancelled during

the Web or mobile
deployment (Task 3).
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Deployment What It Does Elapsed Time When ToUse It
Mode

2) refresh the set of
fileson the server after
a Full Deployment has
been cancelled during
the Web or mobile
deployment (Task 3).
3) deploy the
application to a
different server.

Appeon Developer will automatically set the default deployment mode by detecting whether
afolder named after the application exists in the %A ppeon%\Devel oper2015\Projects\
directory on the Developer machine. If the folder is detected, the application will be regarded
as an already deployed application and incremental deployment mode is selected; otherwise,
full deployment mode is selected. This detection can mislead Developer into selecting
incremental deployment mode, because the folder will exist in the following situations:

Table 6.6: Situationswhen thefolder exists

Thefolder will exist if you have... In thiscase,
choose ...

Performed an unsupported feature analysis on the application before | Incremental

it has undergone afull deployment. The folder is created during deployment mode.

analysis.

Undeployed an Appeon deployed application from servers using the | Full deployment

Application Undeployment Wizard. The folder is preserved. mode.

Deployed the application using a previous version of Appeon Full deployment

Developer. Thefolder is preserved unless you delete it manually. mode.

This legacy folder can be detected by the new Appeon Developer.

6.2.3 Deploying the PowerBuilder application

The deployment process of an application contains three major deployment tasks. Different
deployment modes perform different tasks. The following table describes the tasks performed
during each deployment mode.

Table 6.7: Different tasks performed during each deployment mode

Deployment Task Full Incremental Deploy Already
Deploymeni Deployment Gener ated

Application
Task 1: Application Source Code Export Y Y N

Exports the source code of the original
PowerBuilder application.

Task 2: Application File Generation Y ‘Y (Partial) ‘ N
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Deployment Task Full Incremental Deploy Already

Deploymeni Deployment Gener ated
Application

Analyzes unsupported features and generates
Web or mobile application files.

Task 3: Web or Mobile Deployment Y Y (Partid) |Y

Deploys the generated Web or mobile
application files to Appeon Server.

Figure 6.2: Full application deployment

=8 Appeon Deployment Wizard - sales El [=] @

The Application Deployment Wizard will quide vou through the automated conversion process.
Fleaze ensure that the corect PowerB uilder application and deployment settings have been
zelected and press Mest to continue.

PowerBuilder Applicatian

Application to be deployed: | sales - |
Deplopment profile: | Local Deploprent = |
Deployment mode: | Full &pplication Deployment - |
| Unattended Deployment Advanced...

Feporting Options

| Generate Unzupported Features Analyzis Bepaort

M et ] | Cancel

As shown in the above figure, the application to be deployed is the sales application_demo,
and the deployment mode is Full Application Deployment.

The following are the compl ete steps in the deployment process:

Step 1: Click Next. The Appeon Deployment Wizard begins Task 1, Application Source
Code Export, as shown in the following figure.
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Figure6.3: Task 1: Application Source Code Export
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After Task 1 iscompleted, Task 2, Application File Generation, will automatically start (as
shown in the following figure) if the Unattended Deployment option is selected, otherwise,
you must click Next at the bottom of the Appeon Deployment Wizard to begin Task 2.
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Figure 6.4: Task 2: Application File Generation
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After Task 2 is completed, Task 3, Web or Mobile Deployment, will automatically start
(as shown in the following figure), or click Next at the bottom of the Appeon Deployment
Wizard to begin Task 3 if the Unattended Deployment option is not selected.

Confirm that the Web Server and Appeon Server have been started and correctly configured
in Appeon Developer Configuration; otherwise, deployment will fail. If deployment fails,
aRetry button appears so you can retry Task 3 without running through a full deployment

again.
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Figure6.5: Task 3 Web or M obile Deployment

= Appecn Deployment Wizard - sales E [=] @

Deployment Tazk Statuz

Deployment Tazk Status Time
Taszk 1: Application Source Code Expart Completed < 1 Minutes
Tazk 2 Appecn Application File Generation Completed < 1 Minutes
Tazk 3: Appeon Application Deployment In Progress

Deployment Information

Appeon Deplopment Wizard deploys all required files to the Appeon Server(z] and *Web Server(s]. “ou can run the deployed
application once the deplayment iz finizhed.

Time Run Information

@ 13:36:45  Connecting to Appeon Server: localhost
@ 13:36:45  Deploving application name to Appeon Server localhost.

0%

Click the Cancel button or press the Esc key to terminate Task 3. If you cancel Task 3 during
a Full Deployment, only some of the application files will have been uploaded to the server
and the application will not run correctly. To correct this, select Incremental Deployment or
Deploy Already Generated Application as the deployment mode the next time you attempt to
deploy the application.

Step 2: After Task 3 has been completed, click the Next button at the bottom of the Appeon
Deployment Wizard to display the deployment report page, as shown in the following figure.
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Figure 6.6: Appeon Deployment Wizard
= Appecn Deployment Wizard - sales E [=] @

Deployment Information

Application deployed: zales
Deployment mode: Full &pplication Deplayment
Deployment profile uzed: Local Deployment

Deployment Task Summary

Tazk Status Time

Tazk 1: Application Source Code E zport Completed < 1 Minutes
Tazk 2 Appeon Application File Generation Completed < 1 Minutes
Tazk 3 Appeon Application Deployment Completed <1 Minutez
Tatal Time Elapzed far Automatic Corversian < 3 Minutes

Log Informatian

W arnings and Emorg Surmmar,: Errarz O ; “Wwarnings: 0 “iew Loa...
Reportz
Featurez Analysis report available: | Analpzis Report...
Finizh Finizh and D ebug Finizh and Burn...

Table 6.8: Deployment report page

Element Description

Deployment Displays the name of the application deployed, the deployment mode
Information used, and the deployment profile used.

Deployment Task Displays the status and time of each of the three deployment tasks,
Summary aswell asthetotal time for the entire PowerBuilder-to-Web or
PowerBuilder-to-mobile conversion process.

Log Information Displays the number of errors and warnings that occurred during the
deployment process.

Click the View L og button to view the errors and warnings
generated during the deployment process. The log file can be
managed in the Information Manager. For detailed instructions, refer
to Chapter 10, Using Information Manager.

Available Reports Displays the reports (Analysis Report) generated during the
deployment process (mainly Task 2).

Analysis Report button: This report is available if the Gener ate
Unsupported Feature Analysis Report option on the Appeon
Deployment Wizard is selected before deployment. After you click
this button, the UFA Report Window will be displayed. For detailed
instructions, refer to Section 5.2, “Working with UFA Report”.
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Step 3: Click the Finish button to close the Appeon Deployment Wizard, or click Finish and
Debug to close the Appeon Deployment Wizard and open Appeon Debugger to debug the
application, or click the Finish and Run button to close the Appeon Deployment Wizard,
and then select a project loader from the dialog box that appears to automatically launch the
newly deployed application.

Note: When you click Finish and Debug or Finish and Run to run the application, please
make sure the database connection from Appeon Server to the database server has been
properly configured. For detailed instructions, refer to the Chapter 4, Database Connection
Setup in Appeon Server Configuration Guide for .NET or in Appeon Server Configuration
Guide for J2EE.

Figure6.7: Project L oader

" I 1

Select Project Loader

Project Loader: | IE Browser - |

Orientatior: Landscape

[ k. ]l Lancel |
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7 Debugging Appeon Web Applications

Sometimes a deployed application may not behave well although the original application
does. In these situations, you can examine the execution results of the JavaScript code in the
deployed application using Appeon Debugger.

The usage of Appeon Debugger is similar to that of PowerBuilder Debugger. Y ou set
breakpoints or watch variables in the PowerBuilder source code, same as in PowerBuilder
Debugger. The main difference is that Appeon Debugger runs the generated JavaScript code
but not the PowerBuilder source code, and shows the execution results of the JavaScript code.

This chapter assumes that you are familiar with the functions of PowerBuilder Debugger;
therefore it does not provide descriptions of common debugging features, but focuses on
introducing the specialties of Appeon Debugger. For common debugging features, refer to the
Debugging an application section in the PowerBuilder User's Guide.

Note:
1. Appeon Debugger can work on both 32-bit and 64-bit machines.

2. Appeon Debugger can only work with Internet Explorer (9.0 or later, both 32-bit and
64-bit), and does not work with other Web browser such as |E 7/8, Chrome, Firefox, &
Opera. However, you can run (not debug) the Appeon Web application in the other Web
browser.

3. Appeon Mobile provides no debug tool, but you can still take advantage of Appeon
Debugger to debug the business logic of the mobile application in Internet Explorer.

7.1 Important Requirements
To start and use Appeon Debugger successfully, be aware of the following important
prerequisites and note:

1. Microsoft script debugger must have been correctly installed and registered on the same
machine and script debugging is enabled in Internet Explorer. Otherwise, you may
encounter problems in starting and using Appeon Debugger.

* Modify the Windows registration table: In order to make sure that the Appeon
Debugger work correctly, you need to modify the Windows registration table after the
installation of the Microsoft script debugger.

For 64-bit machines, follow the steps below:

1) Goto HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\I nternet
Explorer\Main\

2) Add one DWORD value: TabProcGrowth =0

For 32-bit machines, follow the steps below:

1) Goto HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main\
2) Add one DWORD value: TabProcGrowth =0
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» Enablethe script debugging option: Simply uncheck the Disable script Debugging
checkbox under the Advanced I nter net Options menu.

If you encounter any error when starting the Appeon Debugger, refer to the solutionsin
Section 2.4, “ Appeon Debugger” in Troubleshooting.

2. A script in the deployed application must meet all of the following requirements to be
debugged; otherwise Appeon Debugger will ssimply ignore it:

» Thescript is deployed in the Debug JS or Debug PS/JS mode, using the local Appeon
Developer.

If you have changed the application PBLSs, or the local application files and the remote
application files are not the same, you must re-deploy the application. Or the newly-
added code will not be selectable in Appeon Debugger.

» Theoriginal PowerScript code of the script is supported by Appeon.

If the code is unsupported, it is marked with a #* icon in the Appeon Debugger Sour ce
view, and cannot be set as breakpoint, nor be located with the Run To Cursor or Set
Next Statement commands in the debugger.

7.2 Introduction to the debugging procedure

Although Appeon Debugger is used for debugging the JavaScript in the deployed application,
breakpoints are not set in the JavaScript, but directly in the PowerBuilder code loaded in

the Appeon Debugger Source view. The generated JavaScript is invisible throughout the
entire process, however the results shown in the Watch view are the execution results of the
JavaScript.

The debugger procedure with Appeon Debugger isthe typical 5-step procedure as with
PowerBuilder Debugger:

Step 1: Start the debugger.
Step 2: Set breakpoints.
Step 3: Run the application in debug mode.

Step 4: Examine the application at the breakpoints by watching variables and expressions,
and monitoring the call stack. Y ou may also step through the application after a breakpoint to
closely examine the effects of each code.

Step 5: Fix the code.

The actions performed in each step are not very different from those required in
PowerBuilder Debugger. However, there are some specia requirements related with the
actions, and the action results are from the running of JavaScript. Continue reading the
following sections for detailed descriptions of these debugging steps.

7.3 Starting Appeon Debugger
To start Appeon Debugger:
Step 1: Close the other Appeon Developer tools.
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Step 2: Start Appeon Server and the Web server that host the Web application.

Step 3: Click Appeon Debugger (™) on the Appeon Developer toolbar.
The "Select atarget" window is displayed.

Figure 7.1: Select an application
<My Select a target ==

Select the target to debug locally:

B E||E:E:_ ap |:||il:: atio n_ dermo

' appean_code_examples
' appeon_act_demo

' pet_world

' appeontest

[ Ok ][ Cancel ]

Step 4: Select an application from the list and click OK.
Appeon Debugger starts and the selected application isloaded in the Appeon Debugger.

The menu bar of the debugger provides three ssmple menus: File, View and Help. The toolbar
isamost the same as that in PowerBuilder Debugger, except that the " Start Remote” button is
currently unavailable.
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Figure 7.2: Appeon Debugger

B Debuager - [E=R(ECR(C<E
File  Wiew
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-4 User Objects
Functions
/7 Arguments:
H string commandline
s it
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/7 Author: laihaichun Date: 2883/12/38
H-—-—-—----"---"--"--"-""-—-——"-—"-"\——-———«
£/ Wodify History: ~
¥ n P 1] * [ Source Browser 4 Source History
A » [ Local A Global % Instance 4]+ [ Call Stack A Breakpoints % ‘watch

7.3.1 Views in Appeon Debugger

Appeon Debugger contains all the views provided by PowerBuilder Debugger except for
Instances View and Objects in Memory view. Each Appeon Debugger view shows almost
the same information as its counterpart in PowerBuilder Debugger. The following table
summarizes the general differences between the two.

Table 7.1: Comparing the viewsin Appeon Debugger and Power Builder Debugger

Unique to Appeon Debugger Unique to Power Builder Debugger
(Unavailablein PowerBuilder | (Unavailablein Appeon Debugger)

Debugger)
Source Identifies Appeon unsupported | ¢ Ancestor Script popup menu item
features with the icon (%) _ _
» Descendant Script popup menu item
Source None List of system events, or the events
Browser and functions defined in parent classes,
or some special events (such as Menu
OnCreate event)
Source None None
History
Variables The values of variables » Parent and Shared views
unsupported by Appeon are .
marked as "unsupported". * Parent popup menu item
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Unique to Appeon Debugger Unique to Power Builder Debugger

(Unavailablein PowerBuilder | (Unavailablein Appeon Debugger)
Debugger)

The Global view displaysall
global variables used in the
application, while PowerBuilder |* Break on changes popup menu item
Debugger only displays
instantiated global variables.

 Shared popup menu item

Call Stack None None
Breakpoints | None » Setting special breakpoints

 Setting occasional or conditional
breakpoints

 Setting a breakpoint when avariable
changes

Watch Appeon Debugger handles some | Break on changes popup menu item
expressionsin a unique way.

Although the views of Appeon Debugger and PowerBuilder Debugger ook similar, they
cannot be used together. For example, the breakpoints set in Appeon Debugger cannot be
recognized by PowerBuilder Debugger, and vice versa.

7.4 Setting breakpoints

7.4.1 Code lines that can be set as breakpoints

Pay attention to the following do's and don'ts before setting breakpoints:
1. Do set breakpoints to the code lines supported by Appeon.

2. Do set simple breakpointsto script, don't set special breakpoints, such as breakpoints
triggered when a statement has been executed a specified number of times (an occasional
breakpoint), when a specified expression is true (a conditional breakpoint), or when the
value of avariable changes.

3. To set aSQL statement that spans multiple lines as a breakpoint, do set the breakpoint at
thefirst line, don't set breakpoints at the other lines. If you try to set a breakpoint at the
other lines, the breakpoint will be set to the line that follows the SQL statement.

4. To set a PowerScript non-SQL statement, which spans multiple lines with continuation
characters (&) as abreakpoint, do set the breakpoint at the last line of the statement, and if
it is set at the other lines, the breakpoint icon is still added to the last line.

Note: you can set a breakpoint to the FOR statement, but the application will be suspended
for only once when this statement is executed.
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7.4.2 Methods for setting breakpoints

Y ou can set breakpoints in the Source, Breakpoints, Variables, or Watch view, before or after
the application starts to run in debug mode.

Method #1: Setting a breakpoint in the Source view
Step 1: Select the script to display in the Source View.

Select afunction or event in the Source Browser view to display its script in the Source View,
or right click on the Source view and select Select Script from the popup menu to select the
script to be displayed.

Step 2: Right click alinein the Source view and select I nsert Breakpoints from the popup
menul.

Once a breakpoint is set, ared circle displays at the beginning of the line.
Figure 7.3: Breakpoints are set

E Debugger - [F=H = =3

Eile  iew

i Application
E Wik d s
E tdenius
‘5 User Objects
Functions

®3(QLCA.DBMS = “ODDBC
SOLCA-AutoCommit = False
SQLCA.DBParm = “Connect3tring="'DSH=AppeonSample;UID=dba;P
COMHECT ;

®If SQLCA.S5QLCode <> A Then =
MessageBox{'fAlert’ ,”"Connection to database failed.")
Halt CLOSE
Return
End If

®0PEN{w _logon)
If Message.StringParm <> *1' Then
// messagebox{’'Alert’,”Connection to database failed.™
Halt CLOSE -

4 T 3 1] » i Source Browser 4 Source History

hl |> | Local ,( Global 3 Instance Al | Ld | Call Stack ;( Breakpoints % ‘watch

Method #2: Setting a breakpoint in the Breakpoints, Variables, or Watch view
Step 1: Right click the Breakpoints, Variables, or Watch view;

Step 2: Select Breakpoints from the popup menu to add a breakpoint using the Edit
Breakpoints dialog.

Method #3: Removing or adding a breakpoint at runtime

When the application is aready running in debug mode, you can still change the way the
debug works by removing or adding breakpoints at runtime:

Double-click aline in the Source view, or select I nsert Breakpoint from the popup menu in
the Source view.
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7.5 Running the application in debug mode
Click Start (i') on the Appeon Debugger toolbar. The application starts to run in the

Internet Explorer. It works normally until it reaches a statement containing a breakpoint. At
this point it stops so that you can examine the application in the Appeon Debugger.

Figure 7.4: Application running in debugger mode
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7.6 Examining an application at a breakpoint

Appeon Debugger provides a Quick Watch function, and the Variables, Watch and Call
Stack views that work the same as PowerBuilder Debugger for examining the state of the
application. It does not provide Break on Changes and TipWatch functions, nor the Object in
Memory view.

7.6.1 Special variable and expression handlings

Appeon Debugger watches the variable and expression results out of JavaScript code but not
PowerBuilder code. Thisisthe main difference with PowerBuilder Debugger. Despite the
difference, the results shall be mostly the same asin PowerBuilder Debugger. If the results
are different, there are two possible reasons:

1. The deployment of the application contains an error. In this case, determine the cause of
the error and correct the problem.
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2. Appeon Debugger handles some variables and expressions differently from PowerBuilder
Debugger. Such differences are introduced below. Be aware of them, so not be false
alarmed and conduct unnecessary complex examination work.

Appeon Debugger does NOT support the following when examining variables:
» Expanding the values of ClassDefinition, PowerObject, and Any variables;
» Expanding the runtime values of System variables. Instead, it just expands the inherent

properties of such variables.

For example, with a Window type variable w_1, PowerBuilder Debugger shows al the
values of all the controls and variables contained in w_1, while Appeon Debugger only
shows the values of the Window properties of for w_1.

Appeon Debugger gives different results when evaluating the following expressions:
* It reports errors for expressions that contain unsupported code;

* If the same expression is added multiple times -- in different context -- into the Watch,
Appeon Debugger regardsit as one expression, and evaluates its value according to the
context of the breakpoint;

» Appeon Debugger does not validate expressions. Therefore, if an expression does not pass
validation in PowerBuilder, PowerBuilder Debugger does not give evaluation results,
however Appeon Debugger may give aresult, sometimes even an incomprehensible result,
such as "[object]+3" for the expression "this + 3".

* If two expressions are interconnected, because the evaluation results of the expressions are
dependent on the orders they are executed, and the ordering may follow different rulesin
PowerBuilder Debugger and Appeon Debugger, Appeon Debugger may produce different
results from PowerBuilder Debugger.

7.6.2 Adding variables or expressions to Watch view
Method #1: Adding variablesor expressionsto Watch with the Quick Watch

Step 1: Select avariable or expression or place the cursor to a variable or expression in the
Source view, right click and select Quick Watch from the popup menu or press Shift+F9.

The variable or the expression will be added to the Expression box on the Quick Watch
dialog.

Step 2: Click the Add Watch button to add the variable or expression to the Watch view.
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Figure 7.5: Quick Watch
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Method #2: Adding variables or expressionsdirectly in the Watch
Step 1: Right click the Watch view and select I nsert from the popup menu.

Step 2: Type valid PowerScript expression in the New Expression dialog box, and click OK
to add it to the Watch view.

7.6.3 Changing the value of a variable or expression
To change the value of a variable in the Watch view:

Step 1: Double click avariable or right click avariable and select Edit Variable. The Modify
Value dialog box will be displayed.

Step 2: In the Modify Vaue dialog box, type a new value for the variable in the New Vaue
box, click OK to close the Modify Value dialog box and continue debugging the application
with the variable set to the new value.

Figure 7.6: Modify value

FModify Walue
Wariable; gtring commandline
Current Value: ™
Mull: B Cancel |
Mew W alue:

To modify an expression in the Watch view:

Step 1: Double-click an expression or right click an expression and select Edit Expression.
The Modify Expression dialog box will be displayed.
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Step 2: In the Modify Expression dialog box, type the new expression in the New Value box
and click OK.

Notice that it is unsupported to select the Null check box in the Modify Vaue or Modify
Expression dialog to set the value of the variable or expression to null.

7.6.4 Evaluating an expression

To evaluate an expression in the Quick Watch dialog box and add it to the Watch view:
Step 1: Change the variable or expression in the Expression box.

Step 2: Click Reevaluate to display the new value in the tree view.

Step 3: (Optional) Click Add Watch to add the expression to the Watch view.

7.6.5 Examining context in Call Stack view
Y ou can examine the context of the application by clicking the code linesin the call stack.

To show adifferent context from the Call Stack view: double-click aline or right-click aline
and then select Set Context.

Once afunction is selected in the Call Stack view, the Variable views, the Source view, and
the Watch view will al be updated.

7.6.6 Stepping through the application

Y ou can use the Step In, Step Over, Step Out, Run To Cursor, and Set Next Statement
commands to step through an application. Using these commands in Appeon Debugger is no
different from using them in PowerBuilder Debugger.

7.7 Fixing the code/stopping the debug procedure

Once you locate the cause of the erroneous execution results, you can stop the debugging
procedure, return to the PowerBuilder application to fix the code, and re-deploy the
application to verify that the error has been corrected.

To stop the debugging process: close Internet Explorer where the application is running, or
select Stop on the toolbar. The breakpoints you set to the application will be saved when
Appeon Debugger is closed, and will be available when Appeon Debugger is re-opened.

When fixing the code, you must return to the PowerBuilder IDE and make code changesin
the original PowerBuilder application. Redeploy the application and run the application in
Internet Explorer to verify if the problem has been corrected. If the problem still exists and
you need to return to Appeon Debugger to redeploy the application. Otherwise, the latest
code changes will not be reflected in Appeon Debugger.
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8 Running Appeon Applications

Appeon Web applications are accessed via Web browsers and Appeon Mobile applications
are accessed via Appeon Workspace.

Confirm that the Web Server(s) and Appeon Server(s) hosting the Web or mobile
applications are running, and verify that the Web browser meets the necessary requirements
outlined in Chapter 3, Installation Requirementsin Installation Guide for .NET.

8.1 Requirements

8.1.1 Windows account privileges
Note: Thisisrequired for the Web application only.

When you run an Appeon Web application for the first time, the Xcelerator plug-in (ActiveX
controls for improving the runtime performance of Web applications) must be downloaded to
the client.

* If using the Firefox, Chrome, or Opera Web browser, you can log into the machine as a
normal user, because you need no special privileges to download and install the ActiveX
control.

* If using Internet Explorer, then different Internet Explorer versions require different
privileges for installing the ActiveX control.

If using IE 8.0 or 9.0 on Windows Vista/7/2008, you can log into the machine as a normal
user, because you need no special privileges to download and register the ActiveX control.
However, if using |E 8.0 or 9.0 on Windows 2003, or if using |E 7.0 or earlier, you must
log in as amember of the Administrator group so you have the permissions to successfully
download and register the ActiveX control.

8.1.2 Internet Explorer settings

Note: Thisisrequired only if you run the Web application in Internet Explorer. If you run the
Web application in other Web browsers such as Firefox, Chrome, & Opera, you can skip this
section.

Settings in Internet Explorer can affect the deployed Web application. Sometimes outdated
filesthat are cached in the browser can interfere with how a Web application functions and
can cause errors when they are re-deployed many times. Internet Explorer's settings may also
block proxy connections or ActiveX control downloads when the Web application is opened.
Therefore, you need to make sure you configure Internet Explorer's settings accordingly.
Note that you may need to have the administrator rights to modify certain settings.

8.1.2.1 Settings for temporary Internet files

Sometimes cached filesin Internet Explorer can cause problems when accessing the
converted Web application after deployment. In order to avoid the risk of providing stale
data, it isimperative that Internet Explorer has the cache options set to Automatically and
that there is sufficient disk space on the Client to enable the Web files to be cached.
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To set the cache options:

Step 1: Open Internet Explorer and select Tools > Internet Options, as shown in the
following figure.

Figure8.1: Internet Optionsin Internet Explorer
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aeneral |Security | Privacy I Content | Connections I Programs I .ﬂ.dvanced|

Horme page

To create home page tabs, bype each address on its own line,

.] .

about:blank M

[ Ise current H Ize defaulk ” Ize blank.

Browsing hiskory

Delete tempaorary files, histary, cookies, saved passwords,
and weh Form infarmatian,

Delete... ] [ Setkings ]

Search
f’_k‘ Change search defaults, Setkings
'__,l s
s
Tabs
Change how webpages are displayved in Setkings
kabs.
Appearance
Colors ] [ Languages ] [ Fonks ] [ Brccessibility ]

[ (04 ][ Cancel ] apply

Step 2: Click the Settings button in the Temporary Internet Files group box.

Step 3: Select the Automatically radio button to check for newer versions of stored pages, as
shown in the figure below.
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Figure 8.2: Temporary Internet File Settings
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Step 4: Verify that the Disk spaceto use scroll box is set to at least 200 MB. Click OK inthe
Settings window.

8.1.2.2 Advanced settings for temporary Internet Explorer files folder

During development, the Temporary Internet Files folder should be set to automatically
empty each time Internet Explorer is closed. Thiswill force Internet Explorer to re-download
the entire application every time it is opened, to ensure the latest version of the applicationis
present, and to prevent interference from outdated cached files.

Here are the necessary steps required to configure Internet Explorer to flush its temporary
files each time the browser is closed:

Step 1: Click the Advanced tab in the I nter net Options window, as shown in the following
figure.

Step 2: Check the Empty Temporary Internet filesfolder when browser isclosed check
box under the Security section, as shown in the following figure.
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Figure 8.3: Empty Temporary Internet Filesfolder when browser is closed
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Step 3: Click Apply in the Advanced tab and then OK in the I nter net Options window to
allow the settings to take effect.

Allowing the temporary Internet files folder to be emptied each time the browser is closed,
is recommended only during the development stage. Once your Web application is ready
for production deployment, and frequent changes are not being made to the application,
this setting can be disabled once again (unchecked). This setting should be reset once
development is complete so the Web application can be cached in each Client PC for better
Client-side performance. Using this set of guidelines, caching files should be enabled when
they are needed for performance improvement, and disabled during the development and
debugging stages.

8.1.2.3 Advanced settings for proxy server

If the Client visits the Web application through a proxy server, you need to select the Use
HTTP 1.1 through proxy connections option under the HTTP 1.1 settings section, as shown in
the following figure.

The following steps detail the configuration needed in Internet Explorer:

Step 1: Click the Advanced tab in the I nter net Options window, as shown in the following
figure.
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Step 2: Check the Use HT TP 1.1 through proxy connections check box under the HTTP
1.1 settings section, as shown in the following figure.

Figure 8.4: Proxy connection settings
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Settings

() Mewver L
[7] Use inline AukaComplete
[] Use most recent order when switching tabs with Chrl+Tab
Ise Passive FTP (for firewall and D3L modem cormpatibiliky
Use smooth scroliing
& | HTTP 1.1 settings
Use HTTP 1.1
Ilse HTTF 1.1 through proxy connections
[=] International*
[] Abways show encoded addresses
Send IDMN server names
[] send IDM server names For Intranet addresses
Send UTF-5 LRLs

[¥] Show Information Bar for encoded addresses
4 T 3

m

*Takes effect after vou restart Internet Explorer

Restore advanced sektings

Reset Internet Explorer setkings
Deletes all temporary files, disables browser Resat
add-ons, and resets all the changed settings, =

You should anly use this iF wour browser is in an unusable state,

[ (0.4 ] I Zancel I I Apply I

Step 3: Click Apply in the Advanced tab and then OK in the I nter net Options window to
allow the settings to take effect.

8.1.2.4 Security settings for ActiveX controls and Appeon Xcelerator plug-in download

If the Web application calls OLE objects, DLL files, or runs executable programs on the
Client, then when the Web application is run for the first time on the Client the user will
need to download an ActiveX control (for executing functions that involve client-side
integration) and the Appeon Xcelerator plug-in (for improving the runtime performance of
Web applications) from the Web Server. To ensure that Internet Explorer will not block the
download, configure Internet Explorer's settings, using the following steps:

Step 1: Open Internet Explorer and navigate to Tools > Internet Options > Security.

Step 2: Verify that you selected an appropriate Web content zone. Appeon recommends you
select the Trusted sites zone and add the Web application URL to the Trusted sites.
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Figure 8.5: Select a Web content zone
Internet Options @
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Low
- Minimal safeguards and warning prompts are provided
- Most content is downloaded and run without prompks
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— - Appropriate For sites that vou absolutely trust

Enable Protected Mode (requires restarting Internet Explorer)

[ Cuskom level... ” Default level ]
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Step 3: Click the Custom L evel button in the Security tab. The Security Settings pageis
displayed, as shown in the following figure.
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Figure 8.6: Security Settings page

Security Settings - Internet Zone @

Settings
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|#| Allow Scriptlets
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Step 4: Check the Enable or the Prompt (recommended) radio button for the following
options:

» Download signed ActiveX controls and plug-ins

Initialize and script ActiveX controls not marked as safe

Run ActiveX controls and plug-ins

Script ActiveX controls marked safe for scripting

File download

Active scripting

If Enableis selected, the ActiveX control will download automatically without prompting. If
Prompt is selected, your approval will be required before downloading takes place.

8.1.3 Language setting requirements
Note: Thisisrequired for the Web application only.

The language of the data in the database used by the application should match the Windows
operating system language settings on the machine where Appeon Server isinstalled. If the
language settings conflict, problems will occur when the Web application is run.
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Verify that the language of the data in the database used by the Appeon-deployed Web
application matches the language settings of the client operating system:

Step 1: Select Windows Start > Settings > Control Panel.
Step 2: Click Regional Options, as shown in the following figure.

Figure 8.7: Regional Options

¥ Regional and Language Options [E5m]
Formats | Location | Keyboards and Languages | Administr ative
Sorne software and serdices provide wou with local information such as news
and weather,
Current location;
United States -
[ Ik ] | Zancel | Apply

Step 3: Verify that the language selected in the Your locale (Iocation) list box and the
language checked as default in the L anguage settings for the system settings are the same.
The language can be from different regions as long as it is the same language.

This configuration is not required for English language applications.

8.1.4 Disabling anti pop-up software
Note: Thisisrequired for the Web application only.

If anti-popup software (example: Popup Stopper by Panicware) isinstalled and is active on
the Client machine, it will not allow any browser pop-ups to occur. This can cause certain
operations to become disabled in the converted Web applications such as the enhanced
Web features detailed below, or other operations that automatically load a browser window
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or popup. To prevent any problems, it is recommended that users disable any anti-popup
software while using the converted Web applications.

8.2 Accessing Appeon applications

8.2.1 URLs of Appeon applications

A typical URL to an application that is deployed to the Appeon Server is similar to this:
http://192.0.0.80:8080/appeondemo/, which normally consists of four parts.

Table 8.1: Appeon Application URL

Application Description
URL

Protocol Uses "http://" typically. If your Web server is configured as an SSL Web
server, use "https://".

IPaddress | Usesthe IP address or domain name of the Web server. Using localhost
or domain |listenersin aproduction environment is not recommended.
name

HTTP port |(Optional) Specifiesthe port number that your Web server acceptsfor HTTP
connections.

If several Web servers are running on the same machine, make sure that the
port specified is a port of the Appeon Server Web server.

Application | Specifies the application name. It is the name that you input in the Web
name Folder field in Application Profiles (For more, see Basic Settings).

When the application URL isrun in the Web browser, the appropriate index file will be
automatically loaded according to the Web browser type, and you can see the index file name
appended to the end of the application URL.

8.2.2 Running Appeon applications

There are more than one method to run the Web application and the mobile application.
Web applications will be run in the Web browser. Y ou can use the following two methods to
run aWeb application in a Web browser:

» Typing the URL of the Web application in the Web browser address bar: You can
always use this method to access the application, on the condition that the computer meets
Section 8.1, “Requirements’.

» Launching the deployed Web application from the Appeon Developer Run button

(éﬁ): Run isashortcut to Web applications that are deployed to the default Appeon Server
and Web Server.

Mobile applications will be run in the Appeon Workspace. Y ou can use the following two
methods to run a Mobile application in Appeon Workspace:

» Accessing the mobile application in Appeon Workspace: You can always run the
Appeon Workspace and run a deployed mobile application there. For detailed instructions,
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refer to Chapter 4, Running apps in Appeon Workspace in Appeon Workspace User Guide
(Mobile only).

* Launching the mobile application from the Appeon Developer Run button (%): Run
is a shortcut to mobile applications that are deployed to the default Appeon Server and
Web Server.

Asyou can see from the above, both the Web application and the mobile application can be
run from the Appeon Developer Run button. This section talks about this method in details.

8.2.2.1 Launching applications from the Run button

Y ou can launch the application by clicking the Run button in the Appeon Developer toolbar.
Appeon Developer automatically remembers the URL s of the applications that are deployed
to the default Appeon Server and Web Server.

To run an application from the Appeon Developer toolbar:

Step 1: Verify that the default Appeon Server and Web Server in the Server Profiles settings
have been started.

Step 2: Click the Run button (£%) on the Appeon Developer toolbar.

If more than one application is deployed, the Run Application window is displayed as
shown in the following figure, prompting you to select which application to run.

Figure 8.8: Run Application window

Run Application -
% PP

All application: deploved to the default Appeon Server and default
Web Server are listed below.

Select an application to run:

tutorial

Praoject Loader: IE Browwzer -
Orientation: Landzzape
Default Appeon Server: Lacal Appean Server
Default Web Server: Local wieb Server
Run... ] [ Cancel
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Only applications deployed to the Default Appeon Server and Default Web Server are listed
in the Run Application window.

If you have deployed an application to severa different folders on the same Web Server,
Appeon Developer will only remember the URL used in the last deployment, although the
URL s to access the other folders used in the previous deployments will also be valid.

Step 3: Select an application from the application list.
Step 4: Select a project loader for the application from the Project L oader dropdown list.

» For Web applications, | E Browser isthe only selectable project loader and is
automatically selected by default; the Orientation dropdown list is automatically disabled.

 For mobile applications, Appeon Emulators (either for tablets or for smartphones) are the
only selectable project loaders and the Tablet 9.7" (1024* 768) is automatically selected
by default; you aso need to select an orientation for the application in the Orientation
dropdown list. By default, if you have selected Tablet 9.7" (1024* 768) as the project
loader, the L andscape orientation is automatically selected; and if you have selected
Smartphone 3.5" (480*320) or Smartphone 4.0" (568* 320) as the project loader, the
Portrait orientation is automatically selected.

Step 5: Click Run.
» For Web applications, it will be automatically loaded in the |1E browser.

» For mobile applications, it will be automatically loaded in the Appeon Workspace
Emulator, which is Appeon Workspace running on the Windows platform.

8.2.2.2 Selecting arun mode
Note: Thisisfor the Web application only.

When you run aWeb application for the first time, a run mode selection page will be
displayed, if you have enabled the Allow user to select run mode option in AEM (see
Appeon Server Configuration Guide for .NET or Appeon Server Configuration Guide for
J2EE for details).

This page alows you to select from the following run modes (as shown in the following
figure):

* Run Now: The application runs immediately and files will be downloaded only when used.
This mode is recommended for high speed network.

* Run After Download: Files will be downloaded before the application runs. Thismodeis
recommended for low speed network.

Y ou can also set arun mode to be the default mode in AEM (see Appeon Server
Configuration Guide for .NET or Appeon Server Configuration Guide for J2EE for details).
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Figure 8.9: Run Mode window

& Appeon Download Center - Windows Internet Explorer

== s

it/ |g, http:,-‘flocalhost."appeontutorﬂ
Eile  Edit Miew Faworites Tools Help

8 g | @ Appeon Download Center

- | *’?| x | | Live Search P~

bl
v B v &= v [k Page v (£ Tools +

Maode

* Run Mow

Fun &fter
O Cownload

Done

Appeon Web Application

Far high speed netwark. The application mns immediately and
files are downloaded only when needad. Recommended for
broadband connection, such as =D5SL.

Far love speed network. All files will be downloaded before the
application runz. Recommended for narowband connection,
such a5 modem or ISDM.

m

Appeon

o @ Internet | Protected Mode: Off * 100% -

8.3 Appeon DataWindow menu

Note: This section isfor Web applications only.

Appeon provides a Web enhancement, the Appeon Datawindow menu, for all DataWindows
deployed to the Web. When right-clicking on a deployed Datawindow, you can access the
Appeon Datawindow popup menus: Find, Find Next, Find Previous, Sort, Filter, Print, and
Save As File (Obsolete), as shown in the following figure.

Figure 8.10: Appeon DataWindow popup menu

Find...
Firnd Mext

Find Prewvious

Sort
Filter

Print...
Sawe O File..,
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8.3.1 Enabling Appeon DataWindow menu

To use the Appeon DatawWindow menu, you must enable it by using the following two
functions. appeonextfuncs.of popmenu and appeonextfuncs.of popmenuon that are defined
in the Appeon Workarounds PBL. For detailed instructions on how to use these functions
in a DataWindow, refer to Section 2.3.1, “ AppeonExtFuncs object” in Workarounds & API

Guide.

8.3.2 Using Appeon DataWindow Menu

Appeon DatawWindows menu have the following features: Find, Find Next, Find Previous,
Sort, Filter, Print, and Save As File (Obsolete). Perform the following steps to use the menu

in the Web DatawWindows.

8.3.2.1 Find

The user can search for data using the Find, Find Next and Find Previous functions.

Step 1: Right-click the Web DataWindow and select Find from the popup menu, as shownin

the following figure.

Figure8.11: Find

D atatwindow

Department Hame State Employee Employee Emp *
1D Lazt Hame First

Finance oF 148 Jordan Julie =

Finance [F 390 Davidzon Jodnn

Finatize m Find... ..Iarne:z:

Finarze (P Find MNesxt Deris

Finanze A ] ] Krizten

Finarze b Find Previous b ary Anr

Finarice b Sort Jaret

Finance WA Filter Jennifer

Finarice bl _ Johin

k arketing b P Melizza

b arketing b, save As File.. Jane

M arketing kA, g Cra John

k arketing b 419 Weaver Bruce

b arketing b A91 Barletta Irene

4

Step 2: Select the column and search scope and input criteriafor the search.

I

Use the Find function to find all rows where the orders count column is equal to 2, as shown

in the following figure.
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Figure8.12: Find

Ok
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Search n

Cancel
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Help

Step 3: Thefirst row that matches the search criteriawill be highlighted.

Step 4: Right-click and select Find Previous or Find Next to highlight the rows (one at a

time) that match the criteria.

8.3.2.2 Sort and filter

The user can sort data by the column in ascending or descending order, or filter datausing a

number of functions.

To sort data:

Step 1: Right-click the Web Datawindow and select Sort from the popup menu, as shown in

the following figure.

Figure 8.13: Sort
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Step 2: Specify the column used to sort the data in the Datawindow by clicking on the
column name in the left list box. The column name appears on the right, as shown in the

following figure.

Appeon Developer User Guide

Page 121



Running Appeon Applications Appeon® for PowerBuilder® 2015

Figure 8.14: Specify sort column

Specify Sort Columns 5]
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Step 3: Check the Ascending check box to sort the data in ascending order or uncheck the
Ascending check box to sort the datain descending order. Click OK to accept the changes.
The Datawindow automatically refreshes and the datais sorted.

If you want to edit the selected column, double click it to open the "Modify Expression”
dialog, as shown in the following figure.

Figure 8.15: Modify Expression dialog

Muodify Expression

Functions: Columnz:
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Tofilter data:

Step 1: Right-click the Web DataWindow and select Filter from the popup menu, as shown
in the following figure.
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Figure 8.16: Filter
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Step 2: Specify thefilter by selecting the functions and columns. Click Verify to test whether
the filter expressionisvalid. Click OK to accept the filter, as shown in the following figure.
The Datawindow automatically refreshes and the datais filtered.

Figure 8.17: Specify Filter
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8.3.2.3 DataWindow printing

The Print menu provides user ability to print DataWindows directly on printers connected to

the Client.
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Step 1: Right-click the Datawindow and select Print from the popup menu, as shown in the
following figure.

Figure 8.18: Print filewith physical printers
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Step 2: Specify the printer settings and paper settingsin the Print Setup window, as shown
in the following figure. Click OK.

The Datawindow will be printed directly to the local printer.

Figure 8.19: Print setup window
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8.3.2.4 SaveAs (Obsolete)

Thisfeatureisobsolete since Appeon Web 6.6.

The user can save the contents of a DataWindow in different file formats.

Step 1: Right-click the Datawindow and select Save As File from the popup menu, as shown

in the following figure.

Figure 8.20: Save AsFile
D atabafindow

Department Hame State Employee Employee Emp *
1D Lazt Hame First

Finance k&, 148 Jordan Julie E

Finarice bl 290 Davidzon JoAnn

Finarize m Find... -.|-E|r|'|E!:E:

Finance [F Firnd Nest Denis

Finance WA ] ] Kristen

Finarce b Find Previous b ary Ay

Finatze b Sort Janet

Finance MA Filter Jennifer

Finarice b _ Johin

k arketing b P Melizza

b arketing b save A File.. Jane

k arketing b 34 Cro John

b arketing b, 409 YWheaver Bruce

M arketing kA, 5 Barletta Irene

4 1 F

Step 2: Specify the file location, file name and file type in the Save As window, as shown in

the following figure.

Figure 8.21: Save Aswindow
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Note:

If the DataWindow without any datais saved asthe HTML file or the XML file, on the Web
the Datawindow header will not be saved, whereas it will be saved on PB.

8.3.2.5 Additional Enhanced Features

In addition to the popup menu (Find, Find Next, Find Previous, Sort, Filter, Print, Save As
File), Appeon offers more features for users to manage DatawWindows on the Web. Users
can place DataWindow columns in a different order by dragging and dropping them to new
positions. When navigating an editable DataWindow, users can use the popup menu to
quickly edit the contents. These features are always available and require no extra coding to
be enabled. The following steps show you how to access them:

Step 1: Select a column header in the Web Datawindow and the selected location is
highlighted, as shown in the following figure.

Step 2: Drag and drop it to the desired location, and the location to be dropped is highlighted
aswell.

Figure 8.22: Select a column header

] Catalog Manager - Categaries E@
Categony - Prad Add
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4 Save
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azsorted toilletries

F Ti 3 | Cloze

Step 3: Right click on an item in an editable HTML Datawindow and a menu pops up, as
shown in the following figure.

The user can select the following menu items from the popup menu to perform quick editing:
Undo, Cut, Copy, Paste, Delete, Select All.
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Figure 8.23: Popup menu for quick edition
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9 Launching Appeon Workspace Emulator

Appeon provides a shortcut of the mobile device emulator, which is the Appeon Workspace,
emulating various mobile devices, on the Windows platform to conveniently run your
Appeon deployed mobile applications.

There are three ways to launch the Appeon Workspace Emulator:

1. Launch Appeon Workspace Emulator from the Appeon Developer Run button (5/4*).

If the application is deployed to the Mobile, then when you click Run in the Run
Application window, Appeon Workspace Emulator will be launched and the application
will be automatically run in Appeon Workspace Emulator.

For details, please refer to Section 8.2.2.1, “Launching applications from the Run button”.

2. Launch Appeon Workspace Emulator from the Appeon Developer Appeon Wor kspace

Emulator button (ﬁ').

On the click of the Appeon Workspace Emulator icon on the Appeon Developer
Toolbar, you directly open the Appeon Workspace Emulator as shown in the following
figure (Appeon Workspace Emulator).

Y ou will need to add the application in Appeon Workspace first before you can run it.

3. Launch Appeon Workspace Emulator from Windows Start > All Programs > Appeon
for Power Builder 2015 > Appeon Developer > Appeon Wor kspace Emulator.
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Figure 9.1: Appeon Workspace Emulator

-
Appeon Workspace Emulator -—1

Appeon Workspace

Easy. Fast. Cross-0OS.

Develop using drag n’ drop and powerful compo-
nents.

After you have launched the Appeon Workspace Emulator, you can:

Select a device that the Appeon Workspace Emulator emulates from the device dropdown
list box.

There are three kinds of devices for choices: Tablet 9.7" (1024*768), Smartphone
3.5" (480*320), and Smartphone 4.0" (568* 320).

Select a scale percentage from the percentage dropdown list box.

There are four scales for choices: Autofit to screen, 100%, 75%, and 50% . By default,
Autofit to screen (for the first time) or the scale you used last time is selected when
you launch the Appeon Workspace Emulator. If you change the scale during running
application(s), you need to relaunch the application(s) manually.

Rotate the screen to left or right by clicking Rotate L eft or Rotate Right.

Exit the Appeon Workspace Emulator by clicking Exit in the Emulator Toolbar, as
shown in the following figure.
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Figure 9.2: Appeon Workspace Emulator Toolbar

Emulator Toalbar

| Tablet 9.7° (1024°768) - || Autofitto Screen | | Rotate Left | |Rﬂtate Right| | Exit |

For detailed instructions on using Appeon Workspace, please refer to the Appeon Workspace
User Guide (Mobile only).
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10 Using Information Manager

Information Manager provides easy access to al the available reports or log files generated
during the application migration process, including debug, development, and deployment.
The reports are categorized as follows: Analysis. Thelog files are categorized as follows:
Deploy Log and Analysis Log.

The following table provides a brief description of al the reports generated during the Web
or mobile migration process and the report types they are associated with.

Table 10.1: Report Description

Report Description

Type
Analysis Analysis Report is generated during a feature analysis or application
deployment, and records the unsupported features in the application.

After you click this button, the UFA Report Window will be displayed. For
detailed instructions, refer to Section 5.2, “Working with UFA Report”.

The following table provides a brief description of all the log files generated during the Web
or mobile migration process, and the log types they are associated with.

Table 10.2: Log Type Description

Log Type Description

Deploy Log | Deploy Log is generated during application deployment, and records the
deployment process status.

All log files are named according to the following format:

Log Type (i.e. DeployWizardLog, or FeatureAnalysisLog) + time when the
log file is generated (yyyy/mm/dd/hh/mm/ss) + xml.

For example, DeployWizardLog 20050220101918.xml.

AnaysisLog |AnalysisLog isgenerated during the feature analysis process, and records
the analyzing status.

10.1 Viewing the reports and logs

Step 1: Click the Infor mation button () on the Appeon Developer toolbar and the
Information Manager is displayed, as shown in the following figure.
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Figure 10.1: Information Manager

Infarmation Manager - sales_application_derno (3]
Pleaze zelect an application: |sales_a|:upliu:atinn_demn | - |
Ea, Appeon Applicalion Unzupported Feature Analysis Report
P ﬁ% Analysiz To generate the Unsupported Feature Analysiz Beport, the application must be
%} Ferfarmance analyzed by running Unsupported Feature Analysis or Application Deplopment 'wizard.
-8 &ppeon Developer
% Deplay Log Analyziz Beport

C:A%Program FileshdppeontDevelopers. 24Project\zales_application...\UFA_Report.«ml

Cloge

Step 2: Select the application in the top dropdown listbox.

Step 3: Select areport type or log type in the left box and the corresponding report button or
log files are displayed in the right box.

If there is more than one log file generated, the log files are listed in order according to the
date and time of generation; the latest log will be listed at the top.

Y ou can open onelog at atime, or open several logs at one time: select a continuous range of
log files by holding down Shift and click log files, or select a disconnected range of log files
by holding down Ctrl and clicking log files. Then click View to open the selected log files.

The View and Delete buttons will be disabled if no log files were generated.

Note: For Deploy Log, you can click View All to view all information such as errors,
warnings, and process description, or click View Warning to view warnings only, or click
View Errorsto view errorsonly.

Step 4: Click the report button or log file to view the report or log.

Y ou can continue with other operations while the Information Manager opens. For example,
you can perform feature analysis, deploy the application, or run the Web or mobile
application. If any new reports or logs are generated when the Information Manager is still
open, the new reports or logs are not reflected in the Information Manager immediately. Y ou
need to refresh Information Manager in either of the following ways:

* Closethe Information Manager and open it again, or
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» Select adifferent application and then select the original application again in the
Information Manager.
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11 Packaging Applications

The Appeon Application Package Wizard helps PowerBuilder developersto

» Generate portable server deployment packages for Web and/or mobile applications, so the
user can directly deploy the Web and/or mobile application to servers without installing
Appeon Developer and using it to do Web or mobile deployments. The PowerBuilder
developers do not need to provide the source PowerBuilder application to the user; this
protects the author's intellectual property rights. Refer to Packaging a server deployment

project.

» Generate the standal one native application package for iOS and Android, so the user can
publish the application in the online app stores or distribute it over-the-air. For iOS, the
Package Wizard generates an X code project which can be compiled to an iOS application
archive (IPA) file by using Xcode later. For Android, the Package Wizard generates an
Android application package (APK) file which can be published or distributed to the end
usersright away. Refer to Packaging a stand-alone mobile project.

» Customize Appeon Workspace and package A ppeon Workspace to a standalone
application. Refer to Customizing and packaging Appeon Workspace.

Before using the Appeon Application Package Wizard, verify that

1. Thetarget PowerBuilder application has been deployed as required:

Y ou must have performed afull deployment on the target PowerBuilder application

on the same Developer machine where you will use the packaging wizard to pack this
application later, this will generate a complete set of files on the local Developer machine
where the package wizard will be able to obtain and pack files.

2. The deployed application can run correctly.
11.1 Packaging a server deployment project

11.1.1 What can be packaged?

The package wizard allows you to pack the following files and settings into a server
deployment project:

» Mandatory Web or mobile application files

Include all application files, DataWindow syntax, INI files, image files, DLL/OCX files
etc.

» Mandatory application profile, Appeon Server profile, and Web server profile settings

Include the profile name, Application URL, PowerBuilder version, file encryption,
performance settings, server type, Appeon Server version, Appeon Server and Web
server connection settings, AEM, data sources, etc. All these settings will be saved to the
configuration filesin the INI folder of the generated package. Of these configuration files,
you can modify the config.xml file using the config.exe tool. For detailed information,
refer to Section 11.1.3, “Modifying the deploy-config file”.
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» Optional EAServer components

When the Appeon Server is of type EAServer, you can package the local or remote
EA Server components used by the application. Note that EAServer components work with
EA Server application server only.

11.1.2 Packaging instructions
To package a server deployment project and the related settings, take the following steps:

Step 1: Start the servers, as the package wizard will pack settings of Appeon Server, AEM,
and NV Os (if any).

Step 2: Click the Package (E'll) button on the Appeon Developer toolbar to open the Appeon
Application Package Wizard.

Step 3: Select or create a profile from the dropdown list box and click Next to proceed.

A profileisaconfiguration file containing configurations that you specify when packaging
the application. Y ou can select an existing profile or create one by entering anamein the
text field. The profile will be automatically saved and listed for selection next time when you
launch the Appeon Application Package Wizard again.

Figure 11.1: Welcome page

- N
H Appeon Application Package Wizard Iﬁ

Welcome to the Appeon Application Package Wizard
Welcome

B Select Package Type
B Select Application Please select an existing profile or create a new one.
B Select Appeon Server

B Configure EAServer Profile

W Select NVOs ‘

d=fault -

B Select AEM Settings
B Specify Destination Folder
B Packaging Process

B Finish

¢ Back [ Mest » ][ Cancel Finizh

L9

Step 4: Select the Package a Server Deployment Project radio button.

To package the mobile application to a stand-alone mobile app, select Package a Stand-
alone Mobile Project and follow detailed instructions in Packaging a stand-alone mobile

project.
To customize Appeon Workspace and then package Appeon Workspace to a standalone

application, select Customize and Package Appeon Wor kspace and follow detailed
instructions in Customizing and packaging Appeon Workspace.

Appeon Developer User Guide Page 135



Packaging Applications Appeon® for PowerBuilder® 2015

Figure 11.2: Select packagetype

-
H Appeon Application Package Wiza u

Welcome Please select a package type.

Select Package Type

B Select Application

@ Package a Server Deplovment Project

B Select Appeon Server
(") Package a Stand-alane Mobile Project
B Configure EAServer Profile
() Customize and Package Appeon Wark space
B Select NVOs
B Select AEM Settings
B Specify Destination Folder

B Packaging Process

B Finish

[ < Back " Mest = ][ Cancel l Finizh

Step 5: Select the profile of the application that you want to package and click Next.

Only applications that have been deployed will be listed here for selection. If the application
you intend to package is not listed here, you would need to deploy the target application
using the Appeon Deployment Wizard first (See Chapter 6, Deploying Power Builder

Applications).

Figure 11.3: Select an application

& Appean Application Package Wizard u

Please select an application to package. Only applications that have

Wealcome been deployed will be listed below for selection.

Select Package Type

Selected Profile Mame Fode

M Select Appeon Server @ acf Release

Select Application

B Configure EAServer Profile
B Select NVOs
B Select AEM Settings

B Specify Destination Folder

B Packaging Process

4 L 2

W Finish

< Back ][ Mest > ][ Cancel Einish
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The following table gives a brief introduction to the columns:

Table 11.1: Application Package Wizard

Column Description

Selected Identical to the default application profile selected in the Appeon Developer
Configuration window.

Profile Name | Identical to the application profiles configured in the Appeon Developer
Configuration window.

Mode Identical to the current mode the application profileis set to in the Appeon
Developer Configuration window.

It is recommended that the packaged applications should be available in
Release mode, as this mode prevents most forms of reverse engineering, and
like application packaging, it protects the author's intellectual property.

Step 6: Select the Appeon Server whose settings will be packaged and click Next.

The Appeon Server settings, such as the server type and the Appeon Server version, will be
saved to the config.xml filein the INI folder of the generated package. If necessary, modify
thisfile using the config.exe tool after the packaging is complete (refer to Section 11.1.3,
“Modifying the deploy-config file”).

All the configured Appeon Servers selected into the default deployment profile in the Appeon
Developer Configuration window are listed, as shown in the following figure.

The selected Appeon Server determines that its AEM settings will be packaged and that the
packaged application can only be installed to Appeon Servers of the same version, such as
2015, but not necessarily the same type.

Figure 11.4: Select an Appeon Server

& Appean Application Package Wizard ﬁ

Please select an Appeon Server from the following list.
Welcome

Select Package Type
Mote: To package E&Server MWDz, you must zelect an Appeon Server of type E&Server. Otherwize, the
Select Application steps for selecting EAServer profile and NYD components will be skipped.

Select Appeon Server -
Selected Appeon Server Profile Name

B Configure EAServer Profile | ©® | LocalAppeon Server

B Select NVOs

B Select AEM Settings

B Specify Destination Folder

B Packaging Process

4 [T 3
W Finish
< Back ][ Meut » ] [ Cancel Einish
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Step 7: If the selected Appeon Server is of type EAServer, select whether to package
EAServer components.

Figure 11.5: Configure EAServer profiles

H Appeon Application Package Wizard ﬁ

Please select whether to package EAServer components.
Welcome

Select Package Type

MHate: If the Package EAServer Components option is not selected, the step for selecting NYD
Select Application components will be skipped.

Sefect Appeon Server [TliPackage EAServer Componerts

Configure EAServer Profile Profile Mame Server Wame Port Mumber

B Select NVOs
N Select AEM Settin

B Specify Destination Folder

B Packaging Proce

Edit... Add.. Delete
B Finish

¢ Back ][ Mewxt » ][ Cancel Finizh

If EAServer components are used in the application, select the Package EA Ser ver
Components option and then create connection profiles for EAServers which host the
components. Follow instructions below to create EA Server profiles:

Click Add to create an EAServer profile.

In the Edit EAServer Profile dialog box, input the following connection parameters:
profile name, host name or IP address, port number, user name, and password.

Click Test to ensure that the connection is successful.

Click OK to save the new EAServer profile.
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Figure 11.6: Edit EAServer profile

" . .
rEdit EAServer Profile [

I Profile Marne: |
Server Mame:
Port Humber:
Login Marne:

Pazsward:

Mote: Input the real IP addresz in the Server Mame field. |t cannot be
"127.0.07" or "localhost',

ok ][ Conod |

Step 8: If the Package EA Server Components option is selected in the previous step, select
which components to package and click Next.

The selected NV Os will be packaged as ComponentName.jar and saved under the /NV O/
server profile name/package folder.

Figure11.7: Select NVOs

& Appean Application Package Wizard ﬁ

Please select EAServer components to package:
Welcome

Select Package Type

Eg F'-E||::|-=:.-E|QE= List

Select Application
Select Appeon Server

Configure EAServer Profile

Select NVOs
B Select AEM Settin

B Specify Destination Folder

B Packaging Process

W Finish

[ < Back ][ Meut » ][ Cancel l Einish

i

Step 9: Select whether AEM settings and data sources for the current application will be
packaged and click Next.

The AEM settings will be saved in the AEM .xml file and data sources will be saved in the
config.xml file.
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Figure 11.8: Select AEM settings and data sour ce

& Appean Application Package Wizard M

*“ou can select to package the AEM settings and the application server
Welcome data source settings for the current Appeon application.

Select Package Type

Pleaze select whether to package AEM settings and data source settings. Pleaze note that these
Select Application zettings can anly apply to Appeon Server of the zame tpe [from J2EE ta J2EE, or from MET ta MET].

Select Appeon Server

ure EAServer Frofile [7] Data Source Settings [for 115 only)
Select NVOs
Select AEM Settings
B Specify Destination Folder
B Packaging Process

W Finish

[ < Back ][ Mext » ][ Cancel l Einizh

Step 10: Specify the storage location for the generated package and click Next.

The generated package will be stored under afolder named " Application Profile
Name _install" under the specified location.

Figure 11.9: Specify destination location for the package

] Appeon Application Package Wizard - @

The packaging tool will create a folder named "Application Profile
Welcome Name_install® to store the packaged application.

Select Fackage Type

Select Application
Application Profile MName: acf

Select Appeon Server ) ' . L
Specify the directory where the install falder will reside:

C:\Program Files'fppeontappPac Browse...

ure EAServer Frofile

Select NVOs
Select AEM Settings

Specify Destination Folder

B Packaging Process

H Finish

’ < Back ][ Mext » ][ Cancel Finizh

Step 11: Wait while the wizard is packing files and settings.
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Figure 11.10: Application packaging status window

] Appeon Application Package Wizard ﬂ

Please wait while the packaging tool performs the requested operation.
Welcome This may take several minutes.

Select Fackage Type

A Time Fiun Information
Selact AR 13:34:01 Packing files...
Select Appeon Server 1334:M C.nr.'unechng to..&ppeon Server:.loc.alhn.sl
1334:02 Finished packing Appeon application files,
onfigure EAServar Profile 133403 Finished packing EXE & DLL files.
Seledt NVOs
Select AEM Settings
Specify Destination Folder
Fackaging Frocess L

B Finish

A

Step 12: Once the operation is complete, click Finish to exit the package wizard.

To view the log information generated during the packaging process, select the View
Package L og box and then click Finish. The log file will be displayed.

Figure 11.11: Application packaging finished

] Appeon Application Package Wizard u

Finished packaging the application.
Welcome

Select Fackage Type
Select Application The package wizard has finizhed packaging the application.
Select Appeon Server

re EAServer Frofile

Select NVOs

Select AEM Settings

Specify Destination Folder Click. Finish to exit the wizard,

Fackaging Process

After the application is successfully packaged, all the necessary application fileswill be
packaged into an executable deployment project under the " Application Profile Name_install”
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folder under the specified location. Y ou can copy the deployment project to other computers
and deploy the application to any Appeon Servers and Web Servers by following instructions
in Section 11.1.4, “Installing and uninstalling an application to the server”.

11.1.3 Modifying the deploy-config file

The deploy-config file (config.xml) is created during the packaging process and includes the
default settings of the application: application profile, Appeon Server profile, Web server
profile, EAServer profile, EAServer components, and data sources. Y ou can modify the
config.xml file using the config.exe tool to have identical settings of the target environment,
so that the user can run the installation very conveniently without needing to specify them.

When you run the config.exe file in the generated package, an XML File Configuration
dialog is displayed and loads the Application URL setting, Appeon Server settings, and Web
server settings from the config.xml file. Y ou can modify these settings on the corresponding
tab pages and then click OK to save them to the config.xml file. The instructions to modify
these settings are the same as to modify in the Appeon Developer Configuration window (see
Section 4.2, “Using Configure Tool” for detailed instructions).

Important Note: If you are installing a Web application to a JEUS Web server, or installing
amobile application, be sure to use the default Application Profile Name and Application
URL. Changing the default Application Profile Name and Application URL will cause the
application files unaccessible.

Figure 11.12: Configuring the XML file
{32 %ML File Configuration =)

&pp URL | Appeon Server | Web Server
App URL Setking

htkp:ffweh serveriporty | Sjell= g ials =SR] =

Ok ] | Cancel
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11.1.4 Installing and uninstalling an application to the server

11.1.4.1 Points to note before installation

Be aware of the following points before you run the deployment project to install an
application to the server:

» The Setup program of the generated deployment project runs on the Windows platform
only. To install applications to servers running on Unix\Linux, you must run the Setup
program on the Windows platform and then install the application to remote servers
running on Unix\Linux.

» Thetarget Web servers must have the Appeon Server Web Component correctly installed.

» The packaged EA Server components, if any, can only be installed to EA Server application
server.

11.1.4.2 Installing an application

The generated deployment project runs on the Windows platform only. Therefore, you will
need to copy the deployment project to a computer running Windows and then install the
application to any number of Appeon Servers and Web servers located in the same network
area. Installing an application using the deployment project is the same as deploying an
application using the Appeon Deployment Wizard.

Step 1: Start the target Appeon Server(s) and Web server(s) where you want to install the
application.

Verify that the target Web servers already have Appeon Server Web Component installed.
Step 2: Run the Setup.exe file in the generated deployment project.
The Appeon Application Deployment wizard is displayed. Click Next to proceed.
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Figure 11.13: Welcome page

E;-@.&ppeun Spplication Deployment (]

Welcome to the Appeon Deployment Wizard!

Thiz wizard will install the packaged Appeon application on
YOUr cornpuker.

To continue, click Mest. Tao esit the wizard, click Cancel,

| T ST T I R T T T TR

{ I Cancel I

Step 3: Select the deployment configuration file (config.xml) to ease your configuration of
the installation wizard. The installation wizard will use the settings in the config.xml file.

If you do not want to use the deployment configuration file, ssimply skip this option and click
Next to configure the settings step by step.
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Figure 11.14: Select the configuration file

ﬁ.&ppeun Spplication Deployment (5]

Select an Existing Deploy-config File

Fleaze select an exizting deploy-config file for quick configuration.

The wizard automatically loads the configuration file for the current package and uses the settings
it thiz file as the default gettings for the subsequent steps. You can modify the settings in thiz file or
gelect another configuration file.

Maote: 'ou can clear the configuration file path in the Destination File bow and click Mext to
configure the settings manually.

Destination File

MAppecntiy ebfppPackagebappeon code examples installsinioonfio.sm Browse...

[ < Back ][ Hest » ] [ Cancel ]

Step 4: Input the Application Profile Name and the Application URL for the application
and click Next.

The Application Profile Nameis used as the application name to identify an application.

If you want to install multiple instances of the same application on the same server, you can
run the setup package repeatedly and specify different Application Profile Name here. For
example, input appeon_code _examples_test as the Application Profile Namein the first
installation, and input appeon_code_examples_production as the Application Profile Name
in the second installation. The Application Profile Name will be used as the application
name to distinguish the multiple application instances on the same server, so they can berun
independently from each other.

However, there are the following circumstances that you should not use different Application
Profile Name and Application URL from those specified when creating the package,
otherwise the application would not run:

» when you are installing a mobile application

» when you are installing a Web application to a JEUS Web server
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Figure 11.15: Specify Application Profile Name and Application URL

Eﬁ.&ppeun Spplication Deployment @

Specify Deployment Settings
Fleaze specify the profile name and the URL for the application,

Fleasze specify the URL for the application.

Application Profile Mame: s EREEITEES

Application LRL

http:/fweb server:port/ appeon_code_exarnples

l < Back |[ Hest » ]l Cancel |

Step 5: Configure and select profiles for the Appeon Server(s) and the Web server(s) where

the application will be installed.

To install the application to more than one Appeon Servers, please make sure the Appeon
Servers are of the same version (such as 2015) as the Appeon Server selected for packaging.

Toinstall the application to an Appeon Server cluster, please create an Appeon Server profile
for each Appeon Server in the cluster. For detailed instructions on how to create the Appeon
Server profile and Web server profile, refer to Section 4.2.3, “Managing server profiles’.

Appeon Developer User Guide

Page 146



Packaging Applications

Appeon® for PowerBuilder® 2015

Figure 11.16: Specify server settings

i Sppeon Spplication Deployment

Server Settings

Appeon Servers

Fleaze select the Appeon Server and the *Web Server.

Selected  Prafile Mame

| FE | 1920156 EAServer

Semer Type Edit...

1|

I

| » Delete

YWwieb Servers

Selected  Prafile Mame
[#1 192.0.1.56_EAServer

Edit...
&dd

Delete

e B

[ < Back ]E Hest » ] [ Cancel

Step 6: Select whether to deploy EAServer components.

After NV O components are deployed, you must generate stub/skeleton in EA Server. Detailed

instructions are provided in Section 5.2.1, “Generating Stub/Skeleton in EAServer” in

Migration Guidelines for Appeon Web (Web only).
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Figure 11.17: Specify EAServer settings

i Sppeon Spplication Deployrment

EAServer Settings

Fleaze select whether to deploy EAServer components.

Please zelect whether to deploy EAServer components. To deploy components, pleaze specify
the EAServer configuration settings.

Maote: if the EAServer Components option is not selected, the step for zelecting Y0 components
will be zkipped.

Prafile M arne Server Name Fort Murnber Logir Edi...
Add...
Delete
4 I F
| < Back |[ Mest » ] | Cancel |

If EAServer components are used in the application, select the EAServer Components
option and then create connection profiles for EA Servers where you want to deploy the
components. Follow instructions below to create EAServer profiles:

» Click Add to open the Edit EAServer Profile dialog box.

* |nput the connection parameters:. profile name, host name or |P address, port number, user
name and password.

» Click Test to verify the connection and the click OK to finish the creation.

Figure 11.18: Edit EAServer Profile
f Edit EAServer Profile ==

Profile Hame:; |

Server Mame:
Part Murnber:
Login Marne:

Pazzward:

Mate: Input the real IP address in the Server Mame field. For example,
192.0.0.1.

] ] [ Cancel
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Step 7: If the EAServer Components option is selected in the previous step, select the
EAServer profile from the list and the components to deploy. Click Next to proceed.

Figure 11.19: Deploy NVOs

i Sppeon Spplication Deployment

Deploy NYDsz

Fleaze select which EASerer components to deploy.

Pleasze select which EAServer components will be deploped to the specified EAS erver.

EaServer List: 192.0.1.56

#-[]J4§ Component List

[ < Back ][ Hest » J [ Cancel ]

Step 8: Select whether to install AEM settings and data sources for the current application
and click Next.
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Figure 11.20: Deploy AEM settings
i Sppeon Application Deployment

Deploy AEM Settings
Pleaze specify how to deploy the AEM zettings.

Fleaze select whether to deploy the AEM zettings and data zource settings to the specified
Appean Sermver.

[7] Data Source

If a data source with the same name already exiztz in the Appeon Server, then

i@ Owvenrite it Do nat ovvenarite it

[ < Back ][ Mest = J [ Cancel ]

Step 9: Specify the destination folder for the undeployment tool and the log file and click

Next.
Figure 11.21: Specify location for the Appeon Undeployment T ool

ﬂ Appean Application Deployment

Install the Appeon Undeployment Tool

Pleasze zelect the folder where the Appeon Undeployment Ta

Please zpeciy where the Appeon Undeployment Tool will reside. The deploy-config file and the
deploy log will alzo be stared in this folder.

Destination Folder
C:AProgram Files'ppeontl ndeploytappeon code examples

< Back ][ Mest » J [ Cancel
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Step 10: Specify the destination file and source file that you want to replace for the Appeon
application package, and click Next.

Files (also called "destination file") under the "wcode" folder of Appeon application package
can be replaced by files of the same type (also called "sourcefile"), so that the sourcefile
will beinstalled instead of the destination file. When you click the Add button, the File
Replacement dialog box is opened. To select the destination file, click Browse to display
the Open file dialog which will automatically open the "wcode" folder of Appeon application
package, so you can conveniently select afile from the "wcode" folder or from its subfolder.
To select the sourcefile, click Browse to navigate to the folder where the sourcefileis
stored.

Figure 11.22: Specify filesto replace for the application package

#i# Appeon Application Deployment
Replace Files
Pleaze specify the files that you want ta replace far the apphicat

Mo, Destination File Source File Edit...
Add...
Delete

4 1 3

<Back | Ned> | | Cancel

Step 11: Wait while the wizard isinstalling files and settings.
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Figure 11.23: Deploying the application

! minutes.

i Sppeon Spplication Deployment

Deploying the Application

The deployment wizard is performing the requested operations.

[Ld| Flease wait while the deployment wizard is deplaying the application. This may take several

Time
18:13:23
18:19:24
18:19:24
18:19:24
13:19:25
13:19:25
13:19:25

seceeoe | Gh

Run Infarmation

Deploving application name to Appeon Server...
Dreploving [M] file(z] to Appeon Server...

Deploving D atavwindow SOL to Appeon Server...
Committing changes to Appeon Server...

Deplaving embedded SOL to Appeon Server...
Committing changes to Appeon Server...

Deploying D atatwindow Spntax bo Appeon Server...

A

I

< Back Het »

Cancel

Step 12: Once the operation is complete, click Finish to exit the installation wizard.

To run the application immediately, select the Run Application Now option and click
Finish. Or you can run the application later from the Windows Start > Programs > Appeon
Web Application > ApplicationName.

To view the log information generated during the installation process, select the View L og
box and then click Finish. The log file will be displayed.
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Figure 11.24: Deployment complete

E;»@.&ppeun Spplication Deployment [5]

Finizhed deploying the Appeon application.

The deployment wizard has finished installing the application and
the related zettings to the computer.

[ Bun Application Mo

[] Wiew Log

Click. Finizh bo exit the wizard.
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< Back Cancel

11.1.4.3 Uninstalling an application

Step 1: Start the Appeon Server(s) and/or Web server(s) where you intend to uninstall the
application.

Step 2: Select Windows Start > All Programs > Appeon Application > Undeploy
ApplicationName.

The Appeon Application Undeployment Wizard is displayed. Click Next to proceed.
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Figure 11.25: Appeon Application Undeployment wizard

ﬁ.&ppeun Spplication Undeployment

Welcome to the Appeon Undeployment Wizard!

Thiz wizard will remove the Appeon application from the specified
compuker.

Mate: before undeplaving an application, ety that it iz not in
LIzE.

To continue, click Mext. To exit the wizard, click Cancel,

< Back. { I Cancel I

Step 3: Select an existing deploy-config file to automatically use the configuration previously
used for the deployment wizard.

Figure 11.26: Select the configuration file

ﬁ.&ppeun Application Undeployrment

Select an Existing Deploy-config File

Pleaze zelect an exizting deploy-config file far

The wizard automatically loads the configuration file for the curent package and uses the settingz
in thiz file az the default settings for the subzequent stepz. You can modify the settings in thiz file or
zelect another canfiguration file.

Mate: “ou can clear the configuration file path in the Dezstination File box and click Mest to
configure the zettings manually.

Destination File

o ppeon W ebtppPackagehappeon code examples installhiniconfio.sm

< Back ][ Mest » J [ Cancel
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Step 4: Specify the Application URL.

Figure 11.27: Specify Application URL

ﬁ Sppeon Spplication Undeployrment

Specify Undeployment Settings

Fleaze input the undeployment zettings.

Pleasze specify the URL for the application to undeplay.

Application Prafile Warme: appeon_cade_examples

Application LRL

hittp: A fvaeh server: port) sl e s =R e =

[ < Back ][ Hest » J [ Cancel ]

Step 5: Select the Appeon Server(s) and Web server(s) where application will be undeployed.

To create the Appeon Server profile and Web server profile, refer to Section 4.2.3
“Managing server profiles’.
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Figure 11.28: Specify server settings

‘ﬁ Sppean Spplication Undeployrment

Server Settings

Fleaze zelect the Appeon Server and the

Appeon Servers

N
[ Edt. |

Selected  Profile Mame Server Type Edit...
[ [192.0.1.56 EAServer

Add...

4 1 | » Delete

YWeb Servers
Selected  Profile Mame Edit...
[+ 192.0.1.56_EAServer

&dd

Delete

il

[ < Back ]E Mest » ] [ Cancel

Step 6: Select whether to undeploy EAServer components.

Figure 11.29: Undeploy EAServer components

ﬁ Appeon Application Undeployment ﬁ

EAServer Settings

Flease select whether to undeploy EAServe :

Pleaze select whether to undeploy EAServer companents. To undeploy components, please
gpecify the EAS erver configuration zettings.
Mate: if the EAServer Compaonents option iz not selected, the step far selecting MY0 components
will be zkipped.
[TlEAServer Components
Prafile Mare Server Mame Part Mumber Lagin Edit..
Add..
Delete
<Back | Ned> | | Cancel
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Select the EAServer Components option and then create connection profiles for EAServers
where you want to undeploy the components. Follow instructions below to create EA Server
profiles:

» Click Add to open the EAServer Connection dialog box.

* Input the connection parameters: profile name, host name or I1P address, port number, user
name and password.

» Click Test to verify the connection and the click OK to finish the creation.

Figure 11.30: Edit EAServer profile

-

i) Edit EAServer Profile (3]

Profile Mame: |
Server Mame:

Part Humber:

Login Marme:

Pazsword:

Mote: Input the real IP addresz in the Server Hame field. For example,
192.0.01.

| Test | [ k. ]| Cancel |

Step 7: If the EAServer Components option is selected in the previous step, select the
EAServer profile from the list and the components to undeploy. Click Next to proceed.
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Figure 11.31: Select EAServer components

‘ﬁ.&ppeun Spplication Undeployment

EAServer Components

Fleaze select which EAServer components

Pleaze zelect which EAServer components will be undeploved from EAS erver.

EaServer List:

#-[]J4§ Component List

[ < Back ][ Hest » J [ Cancel

Step 8: Wait while the wizard is removing files and settings.

Step 9: Once the operation is complete, click Finish to exit the undeployment wizard.

To view the log information generated during the uninstall process, select the View L og box

and then click Finish. Thelog file will be displayed.
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Figure 11.32: Undeployment complete

ﬁ.&ppeun Application Undeployrment @

Finizhed undeploying the Appeon application.

The undeplopment wizard haz finizhed removing the application
and the related zettings from the computer.

Chek. Finish ko exit the wizard.

< Back Cancel

11.2 Preparing for the mobile package

These preparations are for packaging the stand-alone mobile apps (for iOS and Android) and
customizing and packaging the Appeon Workspace.

11.2.1 Preparations for the iOS package
Before you packaging the iOS application, make the following preparations accordingly:

1. (Required) Register for an AppleID.

Y ou can follow the onscreen instructions on My Apple ID to create an Apple ID if you do
not have one.

It is strongly recommended that you consistently use the same Apple ID in every

place that requires you to input an Apple ID. Thisis mainly for the following two
reasons. 1) Using the same Apple ID when packaging the iOS applications can help
Appeon determine whether the apps are running on the same device, so Appeon can
correctly manage the device sessions in the license file. More details are provided in
Section 5.2.3.1, “Task 3.1 (Optional): Import the certificate” in Appeon Mobile Tutorials
(Mobile only). 2) Using the same Apple ID when working with Xcode can eliminate the
likelihood of conflicts between the certificate and the provisioning profile.

2. (Required) Prepare aMac machine with the latest X code installed.

The Package Wizard will generate an Xcode project which you will need to compile
into the IPA file using Xcode. There are severa other tasks you should do to prepare the
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Xcode environment. Detailed instructions are provided in Section 5.2.1, “Task 1. Prepare
the X code environment” in Appeon Mobile Tutorials (Mobile only).

Note that if you have used the Payment APIs in the application, make sure you compile
the application using Xcode 5.1 or above, otherwise Payment APIswill not work.
3. (Optional) Prepare the icons/images for your application.

Y ou can provide you own app icons, launch images, and spotlight icons for your iOS
application. If you do not provide the icons and images, the Package Wizard will use the
default ones provided by Appeon.

a. App Icons: Refer to App Icon [176] for the size requirement for different iOS
devices.

b. Launch Images. Refer to Launch Image [176] for the size requirement for different
10S devices.

It isoptional to reduce the i0S status bar (20 pixels for standard display and 40 pixels
for retina display) for the launch image, for example, 1004 x 768 pixels as the launch
image for standard display in landscape on iPad.

c. Spotlight Icons: Refer to Spotlight Icon [177] for the size requirement for different
i0S devices.

11.2.2 Preparations for the Android package
Before you packaging the Android application, make the following preparations accordingly:

11.2.2.1 (Required) Obtain a private key

The Android operating system requires that all installed applications be digitally signed with
a certificate whose private key is held by the application's developer and uses the certificate
as ameans of identifying the author of an application and establishing trust relationships
between applications. Y ou can either use the default keystore file generated by Appeon or use
the Keytool utility included in the Java Development Kits (JDK) to generate your private key.
For details, refer to http://devel oper.android.com/tool §/publishing/app-signing.html.

Hereis an example of a Keytool command that generates a private key (you can execute
the command in any folder if the JAVA_HOME environment variable correctly pointsto
the JDK directory, otherwise, you should first change to the JDK directory (using the "cd"
command as shown below), and then execute the Keytool command there):

cd C\Program Fi |l es\Java\j dkl. 6.0 _24

Keyt ool -genkey -alias nyalias -keypass nypass -keyal g RSA -keysize 1024 -validity
3650 -keystore C:\my. keystore -storepass nypass

The Keytool command prompts you to provide the owner information.
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Figure 11.33: Generate keystore

BN Administrator: C\Windows'system324cmd. exe =g @
Copyright <c» 208? Microsoft Corporation. All rights reserved.

C=“Uszersshyociared C:isProgram FilessJavasjdki. 6. @_24

C:“Program Files>Javasjdkli.6.8_24>Keytool —genkey —alias myalias —keypass mypass
—keyalg RSA -keysize 1824 —validity 3650 —-keystore C:my_keystore —storepass my
pass
What iz your first and last name?
[Unknownl:z: tracy huang
Ilhat is the name of wyour organizational unit?
[Unknownl: support
lhat is the name of your organization?
[Unknownl:= appeon
lhat iz the name of your City or Locality?
[Unknownl: shenzhen
What iz the name of your State or Province?
[Unknownl: guangdong
Ilhat is the two—letter country code for this unit?
[Unknownl:z: cn
Is CH=tracy huang, OU=support, O=appeon. L=shenzhen. 5T=guangdong. C=cn correct?

[nol: wyes

C:“Program Files“Javasjdkl.6.0_24>

After the keystore file is generated, remember the file name and location (C:\my.keystore
in the above example) and the password, as you will need to include the keystore file when
packaging the application later. To include the file, specify the relevant information in the
App Signing [179] section in the Appeon Application Package Wizard.

11.2.2.2 (Optional) Obtain a Google Maps API key

If you plan to provide the Google Maps functionality in the application, you would need

to register for a Google Maps API key first and then include the key when packaging the
application in the Appeon Application Package Wizard. The key isfree and you can

use it with any of your applications that call the Map APIs (for how to call Map APIs, see
Section 2.4.8, “Map” in Workarounds & API Guide), and it supports an unlimited number of
users.

Below are instructions for generating the Google Map API key in the Google Developers
Console.
1. Obtain the SHA1 fingerprint of the keystore file that will be used to sign the application.

The keystore file should have aready been generated, if not, follow instructionsin the
previous section Obtain a private key to generate a keystore file. Make sure you have
installed JDK so the Keytool utility included in it is available to use.

Hereis an example of a Keytool command that retrieves the SHA1 fingerprint of

the keystore file (you can execute the command in any folder if the JAVA_HOME
environment variable correctly points to the JDK directory, otherwise, you should first
change to the JDK directory (using the "cd" command as shown below), and then execute
the Keytool command there):
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cd C\Program Fi | es\Java\j dk1. 6. 0_24

keytool -list -v -keystore C:\ny.keystore

Figure 11.34: SHA1 fingerprint

EX Administrator: CA\Windows'\system32hcmd. exe = ||==] @
C-“Uzersshxxiarcd C:Program FilessJavasjdki.6.@_24

C:*“Program FilessJavasjdkl.6.8_24>keytool —-list —v —-keystore GC:imy.keystore
Enter keystore password:

Keystore type: JKS
Keystore provider: SUMW

Your keystore contains 1 entey

Alias name: myalias
Creation date: Aug 12, 2814
Entry type: PrivateKeyEntry
Certificate chain length: 1
Certificatel11:
Ouner: CM=tracy huang, OU=support, O=appeon, L=shenzhen, S5T=guangdong. GC=cn
[zzuer: CN=tracy huang, OU=support, O=appeon, L=shenzhen, ST=qguangdong, C=cn
Serial number: 3b23celdb
Jalid from: Tue Aug 12 A2:57:55 C5T 2814 uwntil: Fri Aug @9 A2:57:55 C5T 2024
Certificate fingerprints:
MD5: AE:67:B7:21:84:BE:D5:4F:B4:2B:5B:DB:CA:=83:A2:FA
SHA1: BB:C6:97:AE:F?:3C:B6:2B:51:78:B2:A0:4A:-D4:F4:DE:-F?:48:-AC:DE
SHAZ256: 3B:DS:D7:1D:64:44:D2:D5:FE:52:98:1B:=BE:CC:=B3:D8:FC:2D:AA=54:3A:
CF:DA:52:8F:86:75:F4:2C:88:D6:5C
Signature algorithm name: SHA256withREA

2. Turn on the Google Maps APIs.

Y ou should register for a Google devel oper account first if you do not have one, asyou
will need to log into the Google Developers Console (https.//code.google.com/apis/
console) to turn on the Google Maps API and create the key.

a. Log into the Google Developers Console.

b. Click Create Project to create a new project for Google Maps API, or use an existing
project.

c. Click APIsunder APIs& AUTH on the left navigation pane, and then click the switch
indicator on the right to turn on Google M aps Android API v2 and Google M aps
Coordinate API on theright side.
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Figure 11.35: Createthe key

Go 8[6 Developers Consale

Projects NAME

MapAPI for 68
BigQuery API o]
APIS & AUTH

Credentials

Google Cloud SQL

Google Cloud Storage
Consent screen

Push Google Cloud Storage JSON API

o]

MONITORING
Google Maps Android APl v2
SOURCE CODE

COMPUTE Google Maps Coordinate APl

STORAGE

BIG DATA Ad Exchange Buyer AP

support@appeon.com

QUOTA

STATUS

0%

1,000 requests/day

3. Createthe API key that binds with the specified application(s).

a. Inthe Google Developers Console, click Credentials under APIs& AUTH on the left
navigation pane, and then click Create new key under Public API access on the right.

Figure 11.36: SHAL fingerprint

Google

Projects

MapAPI for 68

APIS & AUTH

APls

Credentials

Consent screen

Push

MONITORING
SOURCE CODE
COMPUTE
STORAGE

BIG DATA

Permissions

Billing & Settings
Support

I ;
Developers Console

OAuth

DAuth 2.0 allows users to share specific
data with you (for example, contact lists)
while keeping their usernames,
passwords, and other information
private.

Learn more

Create new Client 1D

Public APl access

Use of this key does not require any user
action or consent, does not grant access
to any account information, and is not
used for autherization.

Learn more

Create new Key

Appeon Developer User Guide

Page 163

OFF



Packaging Applications Appeon® for PowerBuilder® 2015

b. Inthe popup Create a new key dialog, click Android key.

Figure 11.37: Create Android key

Create a new key

The APls represented in the Google Developers Console require that
requests include a unigue project identifier. This enables the Console totie a
request to a specific project in order to monitor traffic, enforce quotas, and
handle billing.

Server key Browser key Android key 05 key

c. Input the SHA1 fingerprint and the application name (separated by a semicolon) per
linein the text box, and then click Create.

Notes:

» The same application name must be specified as the App Identifier [178] in the
Appeon Application Package Wizard later.

» The generated API key should be included in the application. To do this, specify the
key inthe Map APl Key [179] field in Appeon Application Package Wizard
later.
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Figure 11.38: Createthe key

Create an Android key and configure allowed Android applications

This key can be deployed in your Android application.

API requests are sent directly to Google from your client Android device. Google verifies that each
request originates from an Android application that matches one of the certificate SHAT fingerprints and
package names listed below. You can discover the SHA1 fingerprint of your developer certificate using
the following command:

kevtool —-list —v —kevstore mystore. kevstore

Learn more

ACCEPT REQUESTS FROM AN AMDROID APPLICATION WITH ONE OF THE CERTIFICATE
FINGERPRINTS AND PACKAGE MAMES LISTED BELOW

One SHA1 certificate fingerprint and package name (separated by a semicolon) per line. Example:
45:B5 E4:6F: 36:AD0A95:94:B4:02:606:2B:12:17:F2:56:26:A0:ED;com.example

11.2.2.3 (Optional) Prepare the icons/images for your application

Y ou can provide you own app icons and splash/launch images for your Android application.
If you do not provide the icons and images, the Package Wizard will use the default ones
provided by Appeon.

Android powers avariety of devices with different screen sizes and densities, in order to get
aproper Ul look on those different screens, you may need to provide different app icons and
splash/launch images for your app.

a. App Icons: Refer to App Icon [180] for the size requirement for different Android
screens.

b. Splash/Launch Images: Refer to Splash Image [180] for the size requirement for
different Android screens.

11.2.3 Preparations for the Appeon Workspace package

Except for the above two preparations, you may also need to do the following two
preparations if you want to customize and package the Appeon Workspace, otherwise, the
Package Wizard will use the default settings.

11.2.3.1 (Optional) Prepare your own banner

The banner in the Appeon Workspaceisan HTML Web app. Y ou can design your own
banner and replace the Appeon Workspace Banner.
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1. Banner size:

a. For iOSdevices: The height is 248 pixelsfor iPad (including iPad 2, 3, 4, mini and
Air), and 124 pixels for iPhone (including iPhone 4, 4S, 5, 5C, 5S, 6, 6 Plus); the width
is subject to the device (usually the same width as the device screen). Below isthe
width for different screens:

For iPad 2, 3, 4, and mini, the width in Portrait view is 768 pixels, and the width in
Landscape view is 1024 pixels.

For iPad mini with retina display and iPad Air, the width in Portrait view is 1536
pixels, and the width in Landscape view is 2048 pixels.

For iPhone 4, 4S, 5, 5C, and 5S, the width in Portrait view is 640 pixels, and the width
in Landscape view is 960 pixels for iPhone 4/4S, and 1136 pixels for iPhone 5/5C/5S.

For iPhone 6, the width in Portrait view is 750 pixels, and the width in Landscape view
iS 1334 pixels.

For iPhone 6 Plus, the width in Portrait view is 1080 pixels, and the width in Landscape
view is 1920 pixels.

b. For Android-powered devices: You need to design your own height (or you can use
the recommended 248 pixels for tablets, and 124 pixels for smartphones) and the width
is subject to the devices. Y ou may need to write scriptsto retrieve the size of the device
screen first and then design your own HTML Web app as the Workspace Banner
accordingly.

2. HTML file name:
Make sure that the HTML Web app contains an index.html file under the root directory of
the app. The index.html file is the default file that the Workspace Banner |oads.

3. Important Notes:

a. Keep the banner height as 248 pixels for iPad, and 124 pixels for iPhone; and the width
the same as the device screen.

b. There are different widths for the portrait view and for the landscape view on a device
if your workspace supports both orientations.

c. Pay attention to the compatibilities of the related JavaScript.

11.2.3.2 (Optional) Prepare the Ul language package

The workspace Ul can be displayed in English, French, Simplified Chinese, Traditional
Chinese, Japanese, Korean, Italian, and Spanish.

To make Appeon Workspace display in other language as well, you will need to add the other
language packages before you package Appeon Workspace:

1. Navigate to one of the following folders under the Appeon Developer installation
directory according to your package type.

Appeon Developer User Guide Page 166



Packaging Applications Appeon® for PowerBuilder® 2015

a. For iOS packages: ...\Appeon\Devel oper2015\A ppTemplate\i OS\X codeX
\A ppeonW S.bundle\config\Aws\ (the second "X" in XcodeX indicates the X code
version);

b. For Android packages: ...\Appeon\Devel oper2015\A ppTemplate\Android\
\A ppeonW S.bundle\config\Aws\.

Open the languages.xml file in atext editor and uncomment the line of script that
corresponds to the language you want to add. It is recommended that you back up thisfile
before modifying it.

For example, to add the support for German, find the corresponding line of script (or add it
if it isnot pre-defined), and then remove the comment as shown below:

<l ang code="de" nane="Deutsch" c="##"/>

The value of code must be used as the file name for the language in the next step.

The value of name will be used as the display name for the language in the L anguage tool
of Appeon Workspace later.

2. Make a copy of an existing language file under one of the following folders (according to
your package type) under the Appeon Developer installation directory.

a. For i0OS packages: ...\Appeon\Devel oper2015\A ppTemplate\i OS\X codeX
\A ppeonW S.bundle\config\Awsl\lang;

b. For Android packages: ..\Appeon\Devel oper2015\AppTemplate\Android
\A ppeonW S.bundle\config\Awsl\lang.

Put the copy under the same directory, and name the copy after the value of code. Take
German for example, the language file must be named as de.xml.

Then open the file, and tranglate the content into the language you want to add.

3. Inthe Package Wizard, when you click the ellipse button in the Default Language field,
the language you added will be displayed for selection.

11.2.3.3 (Optional) Customize the Ul text

The workspace Ul text can be customized according to your needs. Y ou will need to make
the change before you package Appeon Workspace.

To customize the Ul text, you edit the language file under one of the following folders
(according to your package type) under the Appeon Developer installation directory.

» For i0S packages: ...\Appeon\Devel oper2015\AppTemplate\i OS\X codeX
\A ppeonW S.bundle\config\Aws\lang;

» For Android packages: ...\Appeon\Devel oper2015\AppTemplate\Android
\A ppeonW S.bundle\config\Awsl\lang.

For example, you can open en.xml and change the text (id="1") from "Appeon Workspace"
to "ABC Workspace", so "ABC Workspace" will display in the center of workspace titlebar
instead of "Appeon Workspace".
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The following figures show most of the customizable texts and the matching IDs in the

language file.

Figure 11.39: Customizable Ul Text

Appeon Workspace Emulator Appeon Workspace Emulator
Appeon Workspace Text id="1" @ Settings Textid="2"
Workspace Settings
—— |
Settings | Textid="2" General > | Textid="10"
Close All Apps Installed Apps \
0 ‘------"‘-—
| Help > Textid="59" Add App... 2 s Textid="65"
some W e >N
B \\\‘ Textid="16" Text id="g"
;_:3;.:.1 S Textid="7" \ Textid="5"
Figure 11.40: Customizable Ul Text
Appeon Workspace Emulator
Text id="65"
App Titlebar —@ |
"“ _m n
Workspace Banner m_ Textid="11
SSL verify Peer % |
Textid="12"
S5L Verify Host
Text id="45" f—— Connection Timeout (seconds) ~A S —
Default App None
& r
. Language English
Textid="3" / 9uag SR Textid="58"
/ Logging on »
Textid="41" //
Textid="47"
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Figure 11.41: Customizable Ul Text

Appeon Workspace Emulator Appeon Workspace Emulator

T — ® soors Textid="7"
App URL _—tr Textid="14"
http://
Example: http://demo.appeon.com/sales ———— | Taxt id="66" Appeon Workspace > | Textid="1"
| Textid="18"
o J

Build 0200.00

Appeon Workspace ID:
C00071A1-1591-6127-42F1- FESS000035C5

APP=E0ON®
Copyright € 2000-2014 Appecn Corporaion.  —————J» Text id="40"

11.3 Packaging a stand-alone mobile project

11.3.1 Points to check before packaging

After packaging the mobile application into an iOS IPA file or Android APK file, you will
need to upload the IPA or APK file to the online application stores to get the app approved.

For theiOS IPA file, Apple follows strict guidelines to review the app before it approves and
posts the app to the Apple App Store. To get the app approved, you may need to carefully
read the App Store Review Guidelines (you will need to log in first to view the page) and
verify the app isin compliance with these guidelines.

The following lists the most common areas and reasons we have found so far that will cause
the app to be rejected by Apple.

1. Check that if your app includes Ul controls for quitting the app. For example, a button
labeling "Quit", "Exit", etc. Y ou'd better remove any mechanism for quitting the app, as
thisis not in compliance with the iOS Human Interface Guidelines, as required by the App
Store Review Guidelines (you will need to log in first to view the page).

2. Check that if your app appears to be for demonstration or trial purposes only. For
example, "demo", "tria"”, "test” or "beta’ is displayed on the app Ul, app description or
release notes. Y ou'd better remove any these references and complete or fully configure
any partially implemented features.

11.3.2 What will be packaged?
The package wizard will generate different packages for iOS and Android.

» For iOS, the package wizard will generate an executable X code project which consists of
the following packages:

i. App Name.zip
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Including all of the application files, DatawWindow syntax, image files, etc. for the iOS
application, and also including an X code project file and the X code project settings
which will be run later to compile the IPA file.

ii. AppeonMobile.framework.zip

Including the mobile client libraries of the Appeon Workspace. The client libraries
support the running of the stand-alone mobile app, such as rendering the mobile-style
Ul, providing interfaces for calling the mobile SDK, supporting the offline capabilities,
etc.

Copy the above packages to a Mac machine with X code installed, and then compile them
into an IPA file.

» For Android, the package wizard will directly generate an APK file which can be installed
on the Android device right away:
i. App Name_install_Android.apk

Including all of the application files, DataWindow syntax, image files, etc. for the
mobile application.

11.3.3 Packaging instructions

To package an Xcode project or an Android application package (APK) file, follow the steps
below:

Step 1: Click the Package (i) button on the Appeon Developer toolbar to open the Appeon
Application Package Wizard.

Step 2: Select or create a profile from the dropdown list and click Next to proceed.

A profileisaconfiguration file containing the settings that you specify when packaging the
application. You can select an existing profile or create one by entering a name in the text
field. The profile will be automatically saved and listed for selection next time when you
launch the Appeon Application Package Wizard again.
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Figure 11.42: Welcome page

- A
H Appeon Application Package Wizard [ﬂ

Welcome to the Appeon Application Package Wizard
Welcome

B Select Package Type

B Select Application Pleaze zelect an existing profile or create a new one.
W Select Appeon Server

B Configure EAServer Profile

B Select NVOs

defauly -

N Select AEM Settin

B Specify Destination Folder

B Packaging Process

B Finish

¢ Back [ Mest » ][ Cancel Finizh

Step 3: Select the Package a Stand-alone M obile Project radio button.

To package a deployment project that can deploy the application to servers, select Package
a Server Deployment Project and follow detailed instructions in Packaging a server
deployment project.

To customize Appeon Workspace and then package Appeon Workspace to a standalone
application, select Customize and Package Appeon Wor kspace and follow detailed
instructions in Customizing and packaging Appeon Workspace.
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Figure 11.43: Select packagetype

-
H Appeon Application Package Wizard M

Welcome Please select a package type.

Select Package Type

() Package a Server Deplayrment Project

B Select Application
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B Packaging Process

W Finish

l ¢ Back ][ Mest » ][ Cancel ] Finizh

Step 4: Select the profile of the application that you want to package and click Next.

Only applications that have been deployed will be listed here for selection. If the application
you intend to package is not listed here, you would need to deploy the target application
using the Appeon Deployment Wizard first (See Chapter 6, Deploying Power Builder

Applications).

Figure 11.44: Select appsto be packaged

& Appean Application Package Wizard g

Please select an application to package. Only applications that have

been deployed will be listed below for selection.
Welcome

Select Fackage Type
Selected Prafile Narme Device Type
. 0 sk dossz
& acl Releaze Bath
B Select Target Device
B Configure App Settings
B Specify Destination Folder
B Packaging Process
< 1] | *

B Finish

< Back ][ Meut » ][ Cancel Einish
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The following table gives a brief introduction to the columns:

Table 11.2: Application Package Wizard

Column Description

Selected

Identical to the default application profile selected in the Appeon Developer
Configuration window.

Profile Name

Identical to the application profiles configured in the Appeon Developer
Configuration window.

Mode

Identical to the current mode the application profile is set to in the Appeon
Developer Configuration window.

It is recommended that the packaged applications should be available in
Release mode, as this mode prevents most forms of reverse engineering, and
like application packaging, it protects the author's intellectual property.

Device Type

Identical to the current device type settingsin the Appeon Developer
Configuration window.

Step 5: Select the device type (i0OS or Android) on which the application will run after
packaged and then click Next.

Figure 11.45: Select a target devicetype

-

& Appean Application Package Wizard @

Welcome

B Finish

L

Select Fackage Type
Select Application

Select Target Device

B Configure App Settings ‘

B Specify Destination Folder

B Packaging Process

Please select the target device on which the mobile application will run
after packaged and published.

() Android Devices

< Back ][ Mewut » ][ Cancel Einish

Step 6: Specify the parameters according to the device type and then click Next.

* For apps running on iOS, specify the parameter according to the following table.
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Figure 11.46: Configure parametersfor the Xcode project

L

H Appeon Application Package Wizard Iﬁ
Please specify the app settings.
Welcome
Name WValue
Select Package Type - General
N E Titleharll:uns
Select Application - Xeode
Sk 3 --App Icon
Select Target Device __ Launch Image
i ; ‘ & Spotlight Icon
Configure App Settings
B Specify Destination Folder
W Packaging Process J jil | E
B Finish
¢ Back ][ Mest > ] [ Cancel Finizh

Table 11.3: Parametersfor the Xcode pr oject

Group Value Description

Genera | App Name (Required)

Specify the name of your app that will appear in
the Apple App Store.

For the name to be displayed completely, it
should be about 12 letters but it depends on the
width of each individual letter, for example, w
takes more room than i.

The App Name will also be used as the name of
the generated package.

App Description

Provide the description of your app that will
appear in the screen under 10S Settings > App
Name after the app isinstalled on the iOS-based
device.

App URL (Required)

Specify the URL to the mobile application that
is deployed to the Appeon Server, for example,
http://192.0.0.201/sales. For more information,
see URL s of Appeon applications.

The URL supports both HTTP and HTTPS
formats, for example, https://192.0.0.201/sales.

The URL can be changed in the screen under iOS
Settings > App Name after the app isinstalled on
the iOS-based device.
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Group Value Description

Apple ID (Required) Specify the developer's Apple ID, and it must
be the same Apple ID used in the provisioning
profile for building the Xcode project later.

By default, the Apple ID you input last timeis
displayed automatically.

Keep the developer's Apple ID consistent for
different apps, so that these different apps
running on the same mobile device can be
recognized as running on one device, not on
multiple devices by the Appeon licensefile.
For details on the Device control typein the
Appeon licensefile, refer to Section 5.3.4.1.1,
“Product Activation” in Appeon Server
Configuration Guide for .NET or in Appeon
Server Configuration Guide for J2EE.

Startup Orientation Set theinitial interface orientation when the app
starts.
SSL Verify Peer Enable or disable the SSL peer verification.
SSL Verify Host Enable or disable the SSL host name verification.
Connection Timeout Specify the timeout seconds for your app
(seconds) connecting to the server.
Record Logs Set whether to record app logs.
Titlebar | Full Screen by Default Whether to display the app in full screen view
Icons (with the titlebar hidden) by default when it

isopened. In the full scree view, the normal
view icon will be available on the top right
corner of the window, and when it is tapped, the
application will return to the normal view (with

thetitlebar visible).
Xcode |AppMaorVersion Specify the version number for your app.
App Build No. Specify the build number for your app.
Xcode Version Select the X code version which will be used

to compile the application. By default, 5 or the
version number you selected last time is selected.

It is recommended that the latest version of
Xcode should be installed and used, so that

the compiled application can support up to the
latest iOS platform. For example, application
compiled by Xcode 5.1 or above can run on iOS
7.1 and earlier platforms, application compiled
by Xcode 5.0.2 can only run oniOS 7 and
earlier platforms, and applications compiled by
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Group Value Description
Xcode 4.x can only run on iOS 6.x and earlier
platforms.
App iPhone Standard Display Specify the app icon for the standard display on
Icon (10S 6.1 or earlier) iPhone (57 x 57 pixels).
iPhone Retina Display (i0S | Specify the app icon for the retinadisplay on
6.1 or earlier) iPhone (114 x 114 pixels).
iPhone Retina Display Specify the app icon for the retina display on
(Xcode 5 only) iPhone (120 x 120 pixels).
iPad Standard Display (iOS | Specify the app icon for the standard display on
6.1 or earlier) iPad (72 x 72 pixels).
iPad Retina Display (i0S 6.1 | Specify the app icon for the retina display on
or earlier) iPad (144 x 144 pixels).
iPad Standard Display Specify the app icon for the standard display on
(Xcode 5 only) iPad (76 x 76 pixels).
iPad Retina Display (Xcode | Specify the app icon for the retina display on
5 only) iPad (152 x 152 pixels).
Launch |iPhone 4 Standard Display | Specify the launch image for the standard display
Image on iPhone 4.
i0S 6.1 and prior: 320 x 480 pixels
iPhone 4 Retina Display Specify the launch image for the retina display
on iPhone 4.
10S 6.1 and prior: 640 x 960 pixels
I0S 7 and later: 640 x 960 pixels
iPhone 5 Specify the launch image for the retina display

on iPhone 5.
1I0S 6.1 and prior: 640 x 1136 pixels
iI0S 7 and later: 640 x 1136 pixels

iPad Standard Display in
Landscape

Specify the launch image for the standard display
in landscape on iPad.

i0S 6.1 and prior: 1024 x 748 pixels
i0OS 7 and later: 1024 x 768 pixels

iPad Standard Display in
Portrait

Specify the launch image for the standard display
in portrait on iPad.

i0S 6.1 and prior: 768 x 1004 pixels
i0OS 7 and later: 768 x 1024 pixels

iPad Retina Display in
Landscape

Specify the launch image for the retina display in
landscape on iPad.

10S 6.1 and prior: 2048 x 1496 pixels
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Group Value

Description
iI0OS 7 and later: 2048 x 1536 pixels

iPad Retina Display in
Portrait

Specify the launch image for the retina display in

portrait on iPad.
10S 6.1 and prior: 1536 x 2008 pixels
I0OS 7 and later: 1536 x 2048 pixels

Spotlight
Icon

iPhone Standard Display
(10S 6.1 or earlier and
Xcode 5 only)

Specify the app spotlight icon for the standard
display on iPhone (29 x 29 pixels).

iPhone Retina Display (i0S
6.1 or earlier and Xcode 5

only)

Specify the app spotlight icon for the retina
display on iPhone (58 x 58 pixels).

iPhone Retina Display
(Xcode 5 only)

Specify the app spotlight icon for the retina
display on iPhone (80 x 80 pixels).

iPad Standard Display (iOS
6.1 or earlier and Xcode 5
only)

Specify the app spotlight icon for the standard
display oniPad (50 x 50 pixels).

iPad Retina Display (i0S 6.1
or earlier and Xcode 5 only)

Specify the app spotlight icon for the retina
display on iPad (100 x 100 pixels).

iPad Standard Display
(Xcode 5 only)

Specify the app spotlight icon for the standard
display oniPad (40 x 40 pixels).

iPad Retina Display (Xcode
5 only)

Specify the app spotlight icon for the retina
display oniPad (80 x 80 pixels).

» For apps running on Android, specify the parameter according to the following table.
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Figure 11.47: Configure parametersfor the Android APK file

3] Appeon Application Package Wizard @

Please specify the app settings.

Welcome

Mame Walue
Select Package Type - General

- APK Project
Select Application - App Signing

-- Titlebar Icons
Select Target Device & App Icon

- Splash Image

Configure App Settings ‘

W Specify Destination Folder

W Packaging Process 1 | 2

B Finish

Help < Back | MHeut » | Cancel

Table 11.4: Parametersfor the Android APK file

Group Value Description

Genera | App Name (Required) Specify the name of your app that will appear in
the Android marketplace.
The App Name will also be used as the name of
the generated package.
App URL (Required) Specify the URL to the mobile application that

is deployed to the Appeon Server, for example,
http://192.0.0.201/sales. For more information,
see URL s of Appeon applications.

The URL supports both HTTP and HTTPS
formats, for example, https://192.0.0.201/sales.

App ldentifier (Required) | Specify theidentifier for the app(s).

Thisfield is used to identify the app, and when
the app isto be installed on a device where
another app with the same identifier has already
been installed, the installation will fail.

This app identifier can only contain lower-case
letters, dots, and/or numbers without spaces, for
example, com.appeon.sales, and cannot contain
capital letters or start or end with dots or contain
numbers between dots.

SSL Verify Peer Enable or disable the SSL peer verification.
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Group Value Description

SSL Verify Host

Enable or disable the SSL host name verification.

Connection Timeout
(seconds)

Specify the timeout seconds for your app
connecting to the server.

Record Logs

Set whether to record app logs.

APK
Project

Delete project after
packaged

Whether to delete the APK project after the app
is packaged.

If not, there will be afolder named after the App
Name under ...\Developer2015\AppTemplate
\Android\NativeConfig\.

App
Signing

Alias (Required)

Enter the alias name for key.

Only thefirst 8 characters of the alias name are
used.

Y ou can use the default alias name generated
by Appeon (which is appeon) or use your own
name. If you use the default keystore file in the
Directory field, you need to keep thisfield as
default.

Alias Password

Enter the key password.

Y ou can use the default alias password generated
by Appeon (which is appeon) or use your own
password. If you use the default keystore filein
the Directory field, you need to keep thisfield as
default.

Directory (Required)

Click the browse button (...) to select the
keystorefile.

Y ou can use the default keystore file or click the
browse button to select your own one.

For how to create the keystore file, refer to
Obtain aprivate key.

Keystore Password

Enter the keystore password.

Y ou can use the default keystore password
generated by Appeon (which is appeon) or

use your own password. If you use the default
keystore file in the Directory field, you need to
keep thisfield as default.

Map API Key

Specify the Google Map API key. The Map APIs
(see Section 2.4.8, “Map” in Workarounds &

API Guide) read the key value and passit to the
Google Maps server, which then confirm that the
app has access to Google Maps data.
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Group

Value

Description

For how to create the Map API key, refer to
Obtain a Google Maps API key.

Titlebar
Icons

Full Screen by Default

Whether to display the app in full screen view
(with the titlebar hidden) by default when it
isopened. In the full scree view, the normal
view icon will be available on the top right
corner of the window, and when it is tapped, the
application will return to the normal view (with
the titlebar visible).

App
Icon (in
PNG
format)

App Icon in Google Play

Specify the app icon displayed in Google Play
(512 x 512 pixels).

App Icon for MDPI Screen

Specify the app icon for MDPI (~160 DPI)
device screens (48 x 48 pixels).

App Icon for HDPI Screen

Specify the app icon for HDPI (~240 DPI) device
screens (72 x 72 pixels).

App Icon for XHDPI Screen

Specify the app icon for XHDPI (~480 DPI)
device screens (96 x 96 pixels).

App Icon for XXHDPI
Screen

Specify the app icon for XXHDPI (~640 DPI)
device screens (144 x 144 pixels).

Splash
Image

Splash Image in Landscape

Specify the splash image in landscape for the
app.
The recommended size is 1024 x 768 pixels, and

the tool will stretch or compress the images to
accommodate various heights and widths.

Splash Image in Portrait

Specify the splash image in portrait for the app.

The recommended size is 768 x 1024 pixels, and
the tool will stretch or compress the images to
accommodate various heights and widths.

Step 7: Specify the storage location for the package and click Next.

» For i0S, the generated package will be stored under afolder named " App
Name _install_XcodeX" (The second "X" in XcodeX indicates the X code version number,
for example, Sales Demo _install_Xcode5.0) under the specified location.

» For Android, the generated package will be stored under afolder named " App
Name _install_Android" (for example, Sales Demo_install _Android) under the specified

location.
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Figure 11.48: Specify directory

F ™
~ = - —
A Application Package Wizard
I Appeon Applica ion Package Wiza ﬁ

The package tool will create a folder named "App Name_install® to

Walcome store the packaged application.

Select Package Type

App Mame:Sales App Demo

Select Application

Specify the directory where the install falder will reside:

C:\Pragram Fil peontdppPackagey) Browsze. ..

Select Target Device

ure App Settings

Specify Destination Folder

W Packaging Process

H Finish

¢ Back H Mext » ][ Cancel Finizh

Step 8: Wait until the package process is complete.

Figure 11.49: Package process

~
i Appeon Application Package Wizard - M

Please wait while the packaging tool performs the requested operation.

a This may take several minutes.
Welcome

Select Package Type

Time Rur Information
£ 111836 Start packaging the native mobile app
Select Appiication REXT Copying files to the temporary folder...
111837 Canfiguring the native mobile app settings. .
Select Target Device 111837 Start building the native mobile app...

Specify Destination Folder

FPackaging Frocess

W Finish

< Back Mext > Einish

Step 9: Click Finish when the package process is complete.
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If the package log reports the error "Failed to build the native mobile app™ when creating
the Android APK file, you may try the solution in Section 2.5.1, “"Failed to build the native
mobile app" error when creating the Android APK package’ in Troubleshooting.

Figure 11.50: Package complete

[&] Appeon Application Package Wizard u

Finished packaging the application.

Welcome

Select Package Type

The package wizard has finished packaging the application,

Select Application

Select Target Device
| Click Finigh to exit the wizard,
Configure App Settings |

K To compile or distibute the package, pleaze follow the instructions in the following tutorial:
Specify Destination Folder
Tutorial 4: Package & Distribute W ative Mobile &pps

Packaging Process

Finish

Step 10: Go to the folder "App Name _install_X" (X indicates the suffix XcodeX or Android)
under the specified location.

* For iOS, you will find the following two zip files:
i. App Name.zip: the application file package

ii. AppeonMobile.framework.zip: the mobile client libraries
Then follow the instructions in Section 5.2, “Package & Distribute iOS Apps’ in
Appeon Mobile Tutorials (Mobile only) to compile them into an IPA file.
» For Android, you will find the following APK file:

i. App Name_install_Android.apk

Then follow the instructions in Section 5.3, “Package & Distribute Android Apps’ in
Appeon Mobile Tutorials (Mobile only) to distribute the APK file.

11.4 Customizing and packaging Appeon Workspace

To customize Appeon Workspace and package it as a standal one application, follow the steps
below:
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Step 1: Click the Package (&) button on the Appeon Developer toolbar to open the Appeon
Application Package Wizard.

Step 2: Select or create a profile from the dropdown list box and click Next to proceed.

A profileis aconfiguration file containing the settings that you specify when packaging the
application. You can select an existing profile or create one by entering a name in the text
field. The profile will be automatically saved and listed for selection when you launch the
Appeon Application Package Wizard again.

Figure 11.51: Welcome page

- 7
& Appean Application Package Wizard ﬁ

Welcome to the Appeon Application Package Wizard
Welcome

B Select Package Type
B Select Application Pleaze zelect an exizting prafile or create a new ane.
B Select Appeon Server

B Configure EAServer Profile

B Select NVOs
defaull -

B Select AEM Settings

B Specify Destination Folder

B Packaging Process

W Finish

< Back [ Mest > ][ Cancel Einish

Step 3: Select the Customize and Package Appeon Wor kspace radio button and click Next.

To package a deployment project that can deploy the application to servers, select Package
a Server Deployment Project and follow detailed instructions in Packaging a server
deployment project.

To package the mobile application to a stand-alone mobile app, select Package a Stand-
alone Mobile Project and follow detailed instructions in Packaging a stand-alone mobile

project.
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Figure 11.52: Select packagetype

H Appeon Application Package Wizard

[ |

Welcome

Select Package Type

B Select Target Device

B Configure Appeon Workspace
B Select Application

W Specify Destination Folder

B Packaging Proce;

B Finish

Please select a package type.

() Package a Server Deployment Project

() Package a Stand-alone Maobile Project

(@ Customize and Package Appeon Workspace:

’ ¢ Back ][ Mest » ][ Cancel ] Finizh

ke

Step 4: Select the device type (iOS or Android) on which the Appeon Workspace application
will run after packaged and then click Next.

Figure 11.53: Select thetarget device

& Appean Application Package Wizard

===

Welcome

Select Package Type

Select Target Device

B Configure Appeon Workspace

B Select Application

B Specify Destination Folder
B Packaging Process

B Finish

Please select the target device on which the mobile application will run
after packaged and published.

() Android Devices

[ < Back ][ Mest » ][ Cancel l Einizh

A

Step 5: Specify and customize the parameters according to the device type and then click

Next.

 For appsrunning on iOS, follow the instructions in the following table.
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Figure 11.54: Workspace parametersfor iOS
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Table 11.5: Workspace parametersfor iOS

Group Parameter Description

General |ApplelID (Required)

Specify the developer's Apple ID, and it must
be the same Apple ID used in the provisioning
profile for building the Xcode project later.

By default, the Apple ID you input last timeis
displayed automatically.

Keep the developer's Apple ID consistent for
different workspaces, so that these different
workspaces running on the same mobile

device can be recognized as running on

one device, not on multiple devices by the
Appeon licensefile. For details on the Device
control type in the Appeon license file, refer

to Section 5.3.4.1.1, “Product Activation” in
Appeon Server Configuration Guide for .NET or
in Appeon Server Configuration Guide for J2EE.

Display Name (Required)

Specify the name of your workspace that will
appear in the App Store. For the name to be
displayed completely, it should be about 12
letters but it depends on the width of each
individual letter, for example, w takes more room
thani.
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Group

Parameter

Description

The Display Name will also be used as the name
of the generated package.

Workspace Banner

Whether to display the Workspace Banner in
your workspace.

Workspace Banner Package

If you have created your own workspace banner,
you can specify to use your own banner here.
For how to create your own workspace banner,
refer to Prepare your own workspace banner for
details.

Click the Wor kspace Banner Package button
to select the folder containing your own HTML
Web app. Make sure the default page of your
own banner is"index.html". The Package tool
will check whether the specified folder contains
the index.html file.

SSL Verify Peer

Enable or disable the SSL peer verification.

SSL Verify Host

Enable or disable the SSL host name
Verification.

Connection Timeout

Specify the timeout seconds for your app

(Seconds) connecting to the server.

Record Logs Set whether to record app logs.

Help Path If you have created your own help file for the
workspace, specify the folder that contains your
help file. The startup page of your help must be
index.html. The Package tool will check whether
the specified folder contains the index.html file.

Applicatidanable Edit App Enable or disable the Add App and Delete App
functions.

Default App Specify the default app. The deployed apps are

listed.

Full Screen by Default

Whether to display the app in full screen view
(with the titlebar hidden) by default when it
isopened. In the full scree view, the normal
view icon will be available on the top right
corner of the window, and when it is tapped, the
application will return to the normal view (with
the titlebar visible).

L anguage

2Default Language

Click the ellipse button to display the Language
box.

In the Language box, select the Selected check
box for the languages you want to package, and
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Group Parameter Description

select the Default radio button to specify the
default language of your workspace Ul.

The workspace Ul can be displayed in English,
French, Simplified Chinese, Traditional Chinese,
Japanese, Korean, Italian, and Spanish. To
display the workspace Ul in other languages, you
will need to prepare the language package by
following instructions in Prepare the Ul language

package.
Figure 11.55: Language
Language @
Selected  Default Language
| H | O Engsh |
v Espariol
o Francais
) ltaliano
v SEx
v #30f
v [zt b
v R
| ok | [ Cancel |
Xcode |App MaorVersion The version number of your workspace.
App Build No. The build number of your workspace.
Xcode Version Select the X code version which will be used

to compile the application. By default, 5 or the
version number you selected last time is selected.

It is recommended that the latest version of
Xcode should be installed and used, so that

the compiled application can support up to the
latest iOS platform. For example, application
compiled by Xcode 5.1 or above can run on iOS
7.1 and earlier platforms, application compiled
by Xcode 5.0.2 can only runoniOS 7 and
earlier platforms, and applications compiled by
Xcode 4.x can only run on iOS 6.x and earlier

platforms.
App iPhone Standard Display Specify the app icon for the standard display on
Icon (10S 6.1 or earlier) iPhone (57 x 57 pixels).
iPhone Retina Display (i0S | Specify the app icon for the retinadisplay on
6.1 or earlier) iPhone (114 x 114 pixels).
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Group Parameter Description

iPhone Retina Display Specify the app icon for the retina display on
(Xcode 5 only) iPhone (120 x 120 pixels).
iPad Standard Display (iOS | Specify the app icon for the standard display on
6.1 or earlier) iPad (72 x 72 pixels).
iPad Retina Display (i0S 6.1 | Specify the app icon for the retina display on
or earlier) iPad (144 x 144 pixels).
iPad Standard Display Specify the app icon for the standard display on
(Xcode 5 only) iPad (76 x 76 pixels).
iPad Retina Display (Xcode | Specify the app icon for the retina display on
5 only) iPad (152 x 152 pixels).
Launch |iPhone 4 Standard Display | Specify the launch image for the standard display
Image on iPhone 4.

i0S 6.1 and prior: 320 x 480 pixels

iPhone 4 Retina Display Specify the launch image for the retina display
on iPhone 4.

i0S 6.1 and prior: 640 x 960 pixels
i0OS 7 and later: 640 x 960 pixels

iPhone 5 Specify the launch image for the retina display
on iPhone 5.

10S 6.1 and prior: 640 x 1136 pixels
i0S 7 and later: 640 x 1136 pixels

iPad Standard Display in Specify the launch image for the standard display
Landscape in landscape on iPad.

i0S 6.1 and prior: 1024 x 748 pixels

i0OS 7 and later: 1024 x 768 pixels

iPad Standard Display in Specify the launch image for the standard display
Portrait in portrait on iPad.

i0S 6.1 and prior: 768 x 1004 pixels

i0OS 7 and later: 768 x 1024 pixels

iPad Retina Display in Specify the launch image for the retina display in
Landscape landscape on iPad.

10S 6.1 and prior: 2048 x 1496 pixels
i0OS 7 and later: 2048 x 1536 pixels

iPad Retina Display in Specify the launch image for the retinadisplay in
Portrait portrait on iPad.

i0S 6.1 and prior: 1536 x 2008 pixels
I0S 7 and later: 1536 x 2048 pixels
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Group Parameter Description

Spotlight| iPhone Standard Display Specify the app spotlight icon for the standard
Icon (10S 6.1 or earlier and display on iPhone (29 x 29 pixels).
Xcode 5 only)

iPhone Retina Display (i0S | Specify the app spotlight icon for the retina
6.1 or earlier and Xcode5 | display oniPhone (58 x 58 pixels).

only)
iPhone Retina Display Specify the app spotlight icon for the retina
(Xcode 5 only) display on iPhone (80 x 80 pixels).

iPad Standard Display (i0OS | Specify the app spotlight icon for the standard
6.1 or earlier and Xcode5 | display oniPad (50 x 50 pixels).
only)

iPad Retina Display (i0S 6.1 | Specify the app spotlight icon for the retina
or earlier and Xcode 5 only) |display oniPad (100 x 100 pixels).

iPad Standard Display Specify the app spotlight icon for the standard
(Xcode 5 only) display oniPad (40 x 40 pixels).

iPad Retina Display (Xcode | Specify the app spotlight icon for the retina
5only) display on iPad (80 x 80 pixels).

* For apps running on Android, follow instructionsin the following table.

Figure 11.56: Workspace parametersfor Android

H Appeon Application Package Wizard Iﬁ
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B Packaging Process J m b
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Appeon Developer User Guide Page 189



Packaging Applications

Appeon® for PowerBuilder® 2015

Table 11.6: Workspace settingsfor Android

Group Parameter Description

General

Display Name Specify the name of your workspace that will appear in the

(Required) Android marketplace such as Google Play.
The Display Name will also be used as the name of the
generated package.

App ldentifier Specify the identifier for the app(s).

(Required) Thisfield is used to identify the app, and when the app is
to be installed on a device where another app with the same
identifier has already been installed, the installation will fail.
This app identifier can only contain lower-case |etters,
dots, and/or numbers without spaces, for example,
com.appeon.aws, and cannot contain capital |etters or start or
end with dots or contain numbers between dots.

Workspace Whether to display the Workspace Banner in your

Banner workspace.

Workspace If you have created your own workspace banner, you can

Banner Package

specify to use your own banner here. For how to create your
own workspace banner, refer to Prepare your own workspace
banner for details.

Click the Workspace Banner Package button to select the
folder containing your own HTML Web app. Make sure

the default page of your own banner is "index.html". The
Package tool will check whether the specified folder contains
the index.html file.

SSL Verify Peer |Enable or disable the SSL peer verification.

SSL Verify Host | Enable or disable the SSL host name verification.

Connection Specify the timeout seconds for your app connecting to the

Timeout server.

(Seconds)

Record Logs Set whether to record app logs.

Help Path If you have created your own help file for the workspace,
specify the folder that contains your help file. The startup
page of your help must be index.html. The Package tool will
check whether the specified folder contains the index.html
file.

APK | Delete project Whether to delete the APK project after the app is packaged.
Project | after packaged

If not, there will be afolder named after the Display Name
in ..\Developer2015\A ppTemplate\Android\NativeConfig\.

ApplicatiBnable Edit App

Enable or disable the Add App and Delete App functions.

Default App

Specify the default app. The deployed apps are listed.
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Group Parameter Description

Full Screen by
Default

Whether to display the app in full screen view (with the
titlebar hidden) by default when it is opened. In the full scree
view, the normal view icon will be available on the top right
corner of the window, and when it is tapped, the application
will return to the normal view (with the titlebar visible).

Languag

®efault Language

Click the ellipse button to display the L anguage box.

In the Language box, select the Selected check box for the
languages you want to package, and select the Default radio
button to specify the default language of your workspace UI.

The workspace Ul can be displayed in English, French,
Simplified Chinese, Traditional Chinese, Japanese, Korean,
Italian, and Spanish. To display the workspace Ul in other
languages, you will need to prepare the language package by
following instructions in Prepare the Ul language package.

Figure 11.57: Language
Language @

Selected  Default Language

| B | O JEgish |
Espariol

Frangais

ltaliang

HEEE

Ty

[ii) e b

g lho

e A e A Y

[ ok | [ cancel |

App
Signing

Alias (Required)

Enter the alias name for the key.
Only thefirst 8 characters of the alias name are used.

Y ou can use the default alias name generated by Appeon
(which is appeon) or use your own name. If you use the
default keystore filein the Directory field, you need to keep
thisfield as default.

Alias Password

Enter the password.

Y ou can use the default alias password generated by Appeon
(which is appeon) or use your own password. If you use the

default keystore filein the Directory field, you need to keep
thisfield as default.

Directory
(Required)

Click the browse button (...) to select the keystore file.

Y ou use the default keystore file or click the browse button to
select your own one.
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Group Parameter Description
For how to create the keystore file, refer to Obtain a private
key.

Keystore Enter the keystore password.

Password
Y ou can use the default keystore password generated by
Appeon (which is appeon) or use your own password. If you
use the default keystore file in the Directory field, you need
to keep thisfield as default.

Map API Key Specify the Google Map API key. The Map API reads the
key value and passesit to the Google Maps server, which
then confirms that the app has access to Google Maps data.
For how to create the Map API key, refer to Obtain a Google
Maps API key.

App Applconin Specify the app icon displayed in Google Play (512 x 512

Icons | Google Play pixels).

(in App | con for Specify the app icon for MDPI (~160 DPI) device screens

fPN Gat) MDPI Screen | (48 x 48 pixdls).

orm

App Icon for Specify the app icon for HDPI (~240 DPI) device screens (72

HDPI Screen X 72 pixels).

App Icon for Specify the app icon for XHDPI (~480 DPI) device screens

XHDPI Screen | (96 x 96 pixels).

App Icon for Specify the app icon for XXHDPI (~640 DPI) device screens

XXHDPI Screen | (144 x 144 pixels).

Splash |Splash Imagein | Specify the splash image in landscape for the app.

Image | Landscape The recommended size is 1024 x 768 pixels, and the tool
will stretch or compress the images to accommodate various
heights and widths.

Splash Imagein | Specify the splash image in portrait for the app.

Portrait The recommended size is 768 x 1024 pixels, and the tool
will stretch or compress the images to accommodate various
heights and widths..

Step 6 (Optional): Select the apps you want to package into the workspace and specify the
URL to the apps. The apps deployed in Appeon Developer are listed by default, and multiple
apps can be selected.

For more information about how to specify the URL, see URL s of Appeon applications.
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Figure 11.58: Select appsto be packaged with your Workspace

H Appeon Application Package Wizard

Please select the application(s) to package.
. Only applications that have been deployed
Welcome will be listed below for selection.
Select Package Type
Selected Prafile Mame AL
Select Target Device sales http: //192.0.3.17 es
[ ack http: 44
Configure Appeon Workspace
Select Application
B Specify Destination Folder
B Packaging Process
4 L1 3
B Finish
¢ Back ][ Mest » ] [ Cancel Finizh

Step 7: Specify the storage location for the generated package and click Next.

* For iOS, the generated package will be stored under afolder named "Display
Name _install_XcodeX" (The second "X" in XcodeX indicates the Xcode version number,
for example, MyWorkspace install_Xcode5.0) under the specified location.

» For Android, the generated package will be stored under afolder named "Display
Name _install_Android" (for example, MyWorkspace install_Android) under the specified

location.
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Figure 11.59: Specify the directory

] Appeon Application Package Wizard g

The package tool will create a folder named "Display Name_install® to

Walcome store the packaged application.

Select Package Type

Dizplay Mame: sales

Select Target Device

Specify the directory where the install folder will reside:

C:MProgram Files\dppeon'éppPackagel) Browse. ..

Configure Appeon Workspace

Select Application

Specify Destination Folder

W Packaging Process

H Finish

l ¢ Back ” Mest » ][ Cancel Finizh

A

Step 8: Wait until the package process is complete.
Figure 11.60: Packaging process

H Appeon Application Package Wizard M

Please wait while the packaging tool performs the requested operation.

: This may take several minutes.
Welcome

Select Package Type

Timne: Fiun Information
] 14:03:66 Start packaging workspace.
Select Target Device 14:03:56 Copying files to the termporary folder...

Configure Appeon Workspace

Select Application

Specify Destination Folder

Packaging Process

B Finish

’ ¢ Back ][ Mewxt > ][ Cancel Finizh

Step 9: Click Finish when the package process is complete.

If the package log reports the error "Failed to build the native mobile app™ when creating
the Android APK file, you may try the solution in Section 2.5.1, “"Failed to build the native
mobile app" error when creating the Android APK package’ in Troubleshooting.
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Figure 11.61: Package complete

R Appecn Application Packacge Wizarc [

Finished packaging the application.
Welcome

Select Package Type

The package wizard has finished packaging the application,

Select Target Device

Configure Appeon Workspace

| Click Finigh ta exit the wizard,
Select Application |

To cornpile or distiibute the package, please follow the instructions in the fallowing tutarial:

Specify Destination Folder

Tutorial 4: Package & Distribute W ative Mobile &pps

Packaging Process

Finish

e -

Step 10: Go to the folder "Display Name_install_X" (X indicates the suffix XcodeX or
Android) under the specified location.

» For iOS, you will find the following two zip files:
i. Display Name.zip: the zip package of the workspace

ii. AppeonMobile.framework.zip: the mobile client library
Then follow the instructions in Section 5.2, “Package & Distribute iOS Apps’ in
Appeon Mobile Tutorials (Mobile only) to compile them into an IPA file.
» For Android, you will find the following APK file:

i. Display Name _install_Android.apk: the package of the workspace

Then follow the instructions in Section 5.3, “Package & Distribute Android Apps’ in
Appeon Mobile Tutorials (Mobile only) to distribute the APK file.
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12 Undeploying Appeon Applications

The Application Undeployment Wizard removes a deployed application from the associated
Appeon Server(s) and Web Server(s), including al Datawindows from the Appeon Server(s),
al the Web or mobile application files from the Web Server(s), and all the Transaction
Object mappings from AEM. Thisisthe only way that an Appeon deployed application
should be removed. Any other method may not fully remove the application, and may cause
errors.

12.1 Undeploying instructions

Step 1: Verify that the Appeon Server and the Web Server(s) hosting the Appeon application
to be undeployed are running before you proceed with undeployment.

Step 2: Click the Undeploy button (%) in the Appeon Developer toolbar. The Application
Undeployment Wizard is displayed, as shown in the following figure.

Figure 12.1: Application Undeployment Wizard

¥ Application Undeployment Wizard @

Thiz wizard helpz you undeploy an application from an Appeon Server.

Click Mexst to proceed.

< Back Mext |[ Cancel ]

Step 3: Click Next to continue. The Specify Undeployment M ode window is displayed, as
shown in the following figure, prompting you to select an undeployment mode.
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Figure 12.2: Specify Undeployment M ode window

¥ Application Undeployment Wizard @
Specify Undeployment Mode

Y'ou can undeploy an application deployved using a specific deployment
profile by choozing Deployment Profile mode. |f you are unsure of the
application name, uze Appeon Server mode to list all applications
deployed to a specific Appeon Server.

[Indeplopment bMode:

(71 Appeon Server

[ < Back ][ M ent > ][ Caricel

The following table shows when and how to use each mode.

Table 12.1: Undeployment modes

When To Use It How ToUselt

Deployment | If you clearly know which Select an application to be undeployed and
Profile mode | application you want to delete | its associated deployment profile.

from which server. For detailed instructions, refer to
Section 12.1.1, “Undeploying with the
Deployment Profile mode”.

Appeon When you are uncertain of Specify an Appeon Server by selecting
Server mode | the name of the application an Appeon Server profile. The selected
you want to undeploy, or an Appeon Server will refer to all the Web
application profile does not exist | or mobile applications that are deployed.
for the application you want Then you can choose one Web or mobile
to undeploy, but you clearly application for undeployment.

know the Appeon Server hosting
the Web or mobile application
intended for undeployment.

For detailed instructions, refer to
Section 12.1.2, “Undeploying with the
Appeon Server mode” .

12.1.1 Undeploying with the Deployment Profile mode

Step 1: Select the Deployment Profile radio button in the Specify Undeployment M ode
window, and click Next to continue.
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Step 2: Select aWeb or mobile application from the Application list box, as shown in the
following figure.

The Application list box lists all the application profile names. Be sure to choose one that has
been deployed and is intended for undeployment. The application and the deployment profile
used in the last deployment will be selected by default.

Step 3: Select the deployment profile that is used to deploy the Web or mobile application
from the Deployment Profile list box, as shown in the following figure. Click Next to
continue.

Figure 12.3: Deployment Profile M ode window

¥ Application Undeployment Wizard @

Deployment Profile Mode

To undeploy an application from the servers, select the Application that
oy want to undeploy and the Deployment Profile containing the zervers
where the application has been deploped.

ndeplay a Specified Application

Application: [sales v]
Deployment Prafile: [Lu:u:alDepIu:u_l,lment T]
[ < Back ][ Mext = ] [ Cancel ]

Step 4: Select the Appeon Server(s) or Web Server(s) that are intended for undeployment,
as shown in the following figure. The Appeon Server(s) and Web Server(s) defined in the
deployment profile selected in the previous step are listed. Click Next to continue.
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Figure 12.4: Confirm Appeon Serversand Web Servers

-

=

X Application Undeployment Wizard

Confirm Appeon Servers and Web Servers

Application: zales

Confirm Appeon Server for Undeployment

Undeploy  Appeon Server
Local &ppeon Server

1 | 1 [ 3

Confirm M eb Server for Undeplopment

IIndeploy

Wieh Semver
Local web Server

4|

1]

[ < Back ][ et =

] [ Cancel ]

Step 5: Click Undeploy to confirm the undeployment settings and start the undepl oyment
process, as shown in the following figure.

Figure 12.5: Confirm undeployment settings

-

==

Y Application Undeployment Wizard

Ready to Undeploy Application

Click Undeploy to begin undeploving the application. [F you want to
review or change any settings, click Back.

Current Settings:

Indeployment Mode:
Dreployment Prafile

| »

Deploprment Prafile
Application:
zales

m

Dreployrment Profile:
Local Deployment
Appeon Servers and W'eb Servers -
1 | 1] [ »

[ ¢ Back ][ Undeploy ] [ Cancel ]

The undeployment process begins, as shown in the following figure.
Step 6: Click Finish to close the dialog box.
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Figure 12.6: Undeployment in Progress

-

¥ Application Undeployment Wizard @

Undeployment Status Information

Undeployment Statuz

Time Rur Information

16:44:368  Undeploying application from Appeon Server...
16:44:36  Connecting to Appeon Server: localhost

16:44:36  Deleting application files from Appeon Server.
16:44:36 Deleted application files from Appeon Server succ
16:44:36  Connecting to'eb serverLocal ‘Web Server
16:44:36  Deleting application files from Web serer.
16:44:37  Deleted application files from "Web server success

SCICECICECICES)

e

m. | k

100%
¢ Back Cancel

12.1.2 Undeploying with the Appeon Server mode

Step 1: Select the Appeon Server radio button in the Specify Undeployment M ode window
as shown in the following figure, and click Next to continue.

Figure 12.7: Specify Undeployment M ode window

¥ Application Undeployment Wizard @
Specify Undeployment Mode

You can undeploy an application deployed uzing a zpecific deployment
profile by choosing Deplavment Prafile mode. I pou are unzure of the
application name, uze Appeon Server mode to list all applications
deploved to a specific Appeon Server.

IJndeployment Mode:

(") Deplopment Prafile

¢ Back ][ I et > J[ Carnicel

Appeon Developer User Guide Page 200



Undeploying Appeon Applications Appeon® for PowerBuilder® 2015

Step 2: Select the Appeon Server that contains the Web or mobile application to be

undeployed from the Appeon Server list box, as shown in the following figure.

The Appeon Server list box lists al the Appeon Server profile names. Make sure the selected

Appeon Server is running.

Step 3: Select the application to be undeployed from the Application list box and click Next,

as shown in the following figure.

The Application list box lists al the Web or mobile applications deployed to the selected

Appeon Server.

Figure 12.8: Appeon Server Mode window

Appeon Server Mode

To undeplay the specified application from an Appeon Server, select
the Appeon Server that your application is deployed o and the
application you want to undeploy,

IJndeploy from a Specified Appeon Server

Appeon Server: [Ll:n:al Appenn Server *]

Application; [ codeexamples - ]

[ ¢ Back ][ [ et > ][ Cancel ]

= Application Undeployment Wizard @

Step 4: Select the Appeon Server(s) or Web Server(s) that are intended for undeployment,
as shown in the following figure. The Appeon Server(s) and Web Server(s) defined in the

default deployment profile are listed. Click Next to continue.
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Figure 12.9: Ready to Undeploy Application window

¥ Application Undeployment Wizard

Confirm Appeon Servers and Web Servers

Application: codeexamples

Confirmn Appeot Server for Undeployment

Undeploy  Appean Server
Local Appeon Server

1| 1] [ b

Confirm "eb Server for Undeplopment

dndeploy  web Server
Lacal wWeb Server

1 | 1] 3

[ ¢ Back ][ M ext > ][ Cancel ]

Step 5: Click Undeploy to confirm the undeployment settings and start the undeployment
process, as shown in the following figure.

Figure 12.10: Undeployment settings

> Application Undeployment Wizard

Ready to Undeploy Application

Click Undeplay ta beqgin undeploving the application. [F pau wank b
review or change any settings, click Back.

Current Settings:

[ »

IJndeployment Mode: :
Appeon Server
Appean Server
Appeon Server:
Local &ppeon Server

m

Application:
codeexamples
Appeon Servers and Web Servers -
1| 1] | »

[ < Back ][ Undeploy ] [ Cancel ]

The undeployment process begins, as shown in the following figure.
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Figure 12.11: Appeon Application Undeployment

¥ Application Undeployment Wizard

=3

Undeployment Status Information

Undeployment Status

SCLCECECECECEC

ey

Time
16:47:40
16:47:40
16:47:40
16:47:40
16:47:40
16:47:40
16:47:41

m. |

Fun Information

|Indeploying application from Appeon Server...
Connecting to Appeon Server: localhost

Deleting application files from Appeon Server.
Deleted application files from Appeon Server succ
Connecting to web server:Local \wWeb Server
Deleting application files from 'Web serer.
Deleted application files from wWeb server success

1002

¢ Back Cancel

-

Step 6: Click Finish to close the dialog box, as shown in the above figure.
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13 Developing with Code Insight

Code Insight is atool designed to help you write Appeon-supported PowerScript code more
quickly by providing alookup and paste service inside the PowerBuilder Script view. You
can use it to develop PowerBuilder applications that are free of Appeon unsupported features
and tailored to Web or mobile migration.

The usage of Code Insight is similar to that of PowerBuilder AutoScript. The following table
describes the differences between the PowerBuilder AutoScript and Appeon Code Insight.

Table 13.1: Comparison between AutoScript and Code Insight

Power Builder AutoScript Appeon Code I nsight

Effective | Functions, events, variables, properties, and Itemsreferred in dot
for templates for PowerBuilder DO, FOR, IF, and notations
CHOOQSE statements.

What pops| A list of properties, variables, methods, or 1) A list of properties,

up statements. variables, or methods.
2) The Appeon unsupported
properties, variables or
methods that are marked
with ared icon left to them.

Waysto | Two ways to use AutoScript: Only one way to use Code

useit Insight:

» Turn automatic popup on to pop up alist

automatically when you pause while typing, or | XeP 1: Activate Code

Insight;
* Invoke AutoScript only once when you need it | Step 2: Configure the

by selecting the menu items. default PBT file;
Step 3: Enable Code
Insight.

Refer to the following
sections for detailed
instructions.

Priority | When Code Insight is activated, AutoScript will be automatically turned off.

13.1 Activating Code Insight

Click the Code I nsight button ( in the Appeon Developer toolbar to launch Code Insight.
At the click of the Code Insight button, an icon will appear in the status area of the task bar.
Code Insight has five status icons:

Table 13.2: Status of Code Insight

Icon Status Description

Disabled | Code Insight is disabled.

3 |Loading | Code Insight isanalyzing the default PBT and generating the supported and
unsupported feature list based on the analysis result.

Appeon Developer User Guide Page 204



Developing with Code Insight Appeon® for PowerBuilder® 2015

Icon Status Description
@ |Off Code Insight is enabled but ineffective.

@ |On Code Insight is enabled and effective in the current application.

() |Gray Thisicon appears anytime the PowerBuilder IDE losesfocus, even if Code
Insight is disabled.

13.1.1 Configuring Code Insight

Before you can enable Code Insight for a PowerBuilder application, you need to configure
the PBT file of the desired application as the default PBT file. Y ou can also specify the
Appeon feature sets and the feature types for which feature list will be displayed.

Step 1: Click on theicon of Code Insight, and the status-area-icon menu pops up with three
items. Enable (or Disable), Config, and Quit, as shown in the following figure.

Figure 13.1: The status-ar ea-icon menu

Enahle

Config
Selected Ll

—“ Quit I
Step 2: Click Config to open the Code I nsight Configuration window, as shown in the

following figure.

Figure 13.2: Code Insight Configuration window - PBT Filestab
Code Insight Configuration ==

FET Files | System

Add the PBT files ta the list:

PET File Mame FET File Path
sales_application_demo  C:\Program Filesh\appeontDevelopert. 2happe:

Pl 11 I

sdd || Delete

(] ] I Cancel
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Figure 13.3: Code Insight Configuration window - System tab

Code Insight Configuration

At List
| Funchions | Controls
| Events | Wariables

Feature Type

@ Both Types Supparted

[
| Properties
Unsupported
s ] | Cancel |

The Code Insight Configuration window contains two tab pages where you can manage the
PBT files and specify what displaysin thelist.

Table 13.3: Code Insight Configuration window

Select this | Todothis
tab

PBT File |AddthePBT files.
tab page

Detailed Steps

1. Click Add.

2. Search and select the PBT filein the common
dialog box.

3. Click Open in the common dialog box.

4. Click OK.

Delete the PBT files.

1. Select the PBT file you want to delete.
2. Click Delete to delete the selected PBT file.
3. Click OK.

NOTE: The default PBT file cannot be deleted.

Set the default PBT file.

1. Select the check box in front of a PBT file.

2. Click OK.
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Select this Todothis Detailed Steps
tab
NOTE: 1) only one PBT file can be set to the
default PBT.
2) Code Insight can only be effective to the default
PBT.
Systemtab | Specify what to display |1. Inthe Auto List group box, opt to automatically
page inthelist. display functions, events, properties, controls

and/or variablesin thelist.

2. Inthe Application Type group box, opt to
display only the unsupported features and/or the
supported features for Web applications or/and
Mobile applications.

3. Inthe Feature Type group box, opt to display
only the unsupported features and/or the
supported featuresin the list.

4. Click OK.

13.1.2 Enabling Code Insight

After you complete the configuration, you can enable Code Insight and use it to develop the
PowerBuilder application.

Click on theicon of Code Insight and select Enable from the status-area-icon menu, as
shown in the following figure.

Figure 13.4: Enable Code I nsight

Enahle

Config
ielected Quit

L

The Code Insight icon appears in one of the following statuses:

Table 13.4: Enable Code I nsight

Status Detailed Steps

Code Insight remains disabled.

This happens when the PBT Filelist in the Code Insight Configuration window is
empty. Make sure you have added the PBT fileto thelist.

@ Code Insight is enabled but ineffective in the current application. To make it
effective, make sure you have

1. Configured the PBT file of the current application as the default PBT filein the
Code Insight Configuration window.
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Status Detailed Steps

2. Opened an object of the current application in a painter (not in the Source editor)
by double-clicking it in the Workspace or selecting Edit from the popup menu.

After taking the above steps, Code Insight becomes effective (@).
D Code Insight is enabled and effective.

Y ou can develop an application with the assistance of Code Insight.

13.2 Coding with Code Insight

When Code Insight is enabled and effective (@) for an application, you can start editing the
objects of the application using Code Insight. For example, take the following stepsto add a
new control and use Code Insight to edit it:

Step 1: Add a button to the current object in the painter.
Step 2: Save the object by clicking the Save button on the PowerBar.

Note: Saving the object enables Code Insight to generate the supported and unsupported
feature list for the new content. Code Insight cannot detect the new content unless the object
is saved.

Step 3: Double click the button to open the Script view and pause for afew seconds after
typing an identifier followed by adot (for example, pause after This.).

If there is more than one property, variable, method, or statement that could be inserted, the
Code Insight feature list pops up for you to select a supported property, variable or method,
as shown in the following figure.

Figure 13.5: Develop an application with Code Insight

@ AppeonDemo - PonerBulder [== ==

File Edit View Insert Format Desion Run  Tools Window Help
ShcEHlEe o dPnal e aam eGP Btk H4 RGO @ Do |EE|x
B D@ ENEN X W @R

P | B | @ -  Arial ~12 -~ B U=
- | = w_logon * (seles_epplication_demo) (C:\Users\Public\ Documents\ AppeonDeveloper6 5 D Demosales_main.pbl} inherited from window - W...[-=-|[-=-|[=5]

L L
[ Script - apen for w_logen retums long O] x| [[o Properties - w_logon inherited from window ol x|
w_logon ¥ | open{) returns long [pbm_oper] - Q| General | seroll | Toolbar | Other

s #colsvulEle

EF activate()
{E3animationtime
[ heets( ]
{3 backeolor
E3border
S bringtotop
EBeb 1
EBeb_2

Elrenter
«

Layouthopen {Event ListyFunction ListyDedare Instance Variables, | Ixproperties {Control Liston-Visual Object List

Ready =0001:0006 Nothing Selected
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The unsupported properties, variables or methods in the popup list will haveared iconin
front, as shown in the following figure. Avoid using the unsupported features.

Figure 13.6: Appeon unsupported features displayed in popup window

0 Center ::.I
ClassDefinition
ClientEdge =i

ColumnsPerPage
ContexiHelp

-7 Control

1 ControlMenu

-1 Enabled

7 Height

e B [ B | | o =
| | 3

Step 4: Select a supported property, variable or method from the popup list.

Y ou can use Code Insight to help develop an application free of unsupported features and
suitable for migration.
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14 Launching Appeon Enterprise Manager

Appeon Enterprise Manager (AEM) is a Web-based application that manages the converted
Web or mobile applications and Appeon Server over the Internet, an intranet or an extranet.
It includes a comprehensive set of easy-to-use tools for system configuration, system
maintenance, performance optimization, and application security.

AEM isincluded when Appeon Server isinstalled.

AEM is accessible from any Client's Web browser or it is possible to access AEM through
the AEM button that resides on the Appeon Developer toolbar. Clicking the AEM button
will automatically open a Web browser window and load the AEM entry page.

14.1 Requirements
Before launching AEM, verify that:

1. The Appeon Server hosting AEM has been started.

2. You have correctly specified the host name and port of the Appeon Server in the Appeon
Server Profile Configuration page.

14.2 Launching Appeon Enterprise Manager

Step 1: Click the AEM button (‘) on the Appeon Developer toolbar.

If more than one Appeon Server profileis configured, the Select an AEM URL to run page
isdisplayed, as shown in the following figure. All Appeon Server profiles and corresponding
AEM URLsare listed. The Appeon Server configured as the default server is highlighted and
selected.

If only one Appeon Server profile is configured, the entry page of AEM is displayed.

Figure 14.1: Select an AEM URL torun

W Select an AEM URL to run @
Appeon Server Praofile Mame AER URL
192.0.1.56 http:/4192.0.1.56: 8080/ AE M

Local Appeon Server http: A dlocalhost: FOOT AAE M

Bur... ] l Lancel
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Step 2: Select an AEM URL and click Run, as shown in the following figure.
The entry page of AEM isloaded in the Web browser, as shown in the following figure.

Figure 14.2: Appeon Enterprise Manager entry page

_ré Appeon Enterprise Manager (AEM) - Windows Internet Explorer [ =& éj

@ L |g, http://localhost/ AEM/ i | ‘f‘ A | | B sing Y |

- R o Y
+.¢ Favorites (& Appeon Enterprise Manager (AEM) Eh A = [ g v Pagev Safety~ Took~ @~

Welcome to use Appeon Enterprise Manager

User name:

Password:

Click the link to download Appeon Workspace
for iOS or Android device.

oration. All Rights Reserved.

Done €5 Local intranet | Protected Mode: Off 43 v H100% -

The AEM URL isautomatically entered into the Web browser address bar when you click
the Run button. Y ou can configure AEM's URL and connection method (https or http) in the
Appeon Server Profile Configuration page.

The default username is admin and the default password is admin. The username and
password settings for AEM can be modified in Security settingsin AEM. Refer to

Section 5.3.5.1, “AEM login” in Appeon Server Configuration Guide for .NET or in Appeon
Server Configuration Guide for J2EE for more information.
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15 Converting screen size between points and
PBUs

rert
The Size Calculator (F7F) tool in the Appeon Developer toolbar is used to conveniently
convert the display size between points and PBUs. Aswe all know, PowerBuilder uses
PowerBuilder units to measure the size while Appeon uses points as the measurement unit,
which is the same with the popular mobile OS providers, such as Apple (i0S), Google
(Android), and Microsoft (Windows Phone). When you design the Ul in PowerBuilder,
you may want to know what the size would be in iOS, Android, or Windows Phone, or you
may already determine the size in i0S, Android, or Windows Phone and want to know how
to design the size correspondingly in PowerBuilder. In either case, you can use the Size
Calculator tool to convert the size from PBU to Point or from Point to PBU.

Figure 15.1: Size Calculator

FFE Size Calculator [iE-J
Foint
Width: Height: 0
DFI: 36 Language: | Englizh -
FE nit
Width, [ Height: 0
PT>PBU | | PBUSFT

To utilize the tool to convert the size, do the following:

rert
Step 1: Click the size calculator icon (F7F) in the Appeon Developer toolbar.

Step 2: Input the size, then select alanguage, and then click one of the conversion buttons
according to your needs.

» The DPI stands for Dot Per Inch describing the screen density. Thisis fixed (96) for
simplicity.

» Language indicates the language of the operating system of the mobile device. Currently
only English and Japanese are supported.

For Point to PBU:
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Input the size in the corresponding text boxes under the Point group box, and then select a
preferred language from the L anguage dropdown list box.

On the click of the PT to PBU ([ FT > FeU ]) button, the results appear in the

corresponding text boxes under the PB Unit group box.
For PBU to Point:

Input the size in the corresponding text boxes under the PB Unit group box, and then select a
preferred language from the L anguage dropdown list box.

On the click of the PBU to PT ([ FBU > PT ]) button, the results appear in the

corresponding text boxes under the Point group box.

For details, please refer to the Section 2.5.1, “Unit conversion” in Mobile Ul Design &
Development Guide (Mobile only).
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16 Appeon for PowerBuilder Help

Appeon provides a comprehensive HTML help system that contains:
* Introduction to Appeon

* Getting Started

* New Features Guide

* Appeon Mobile Tutorias

» Appeon Mobile (Offline) Tutorials

* Installation Guide for Appeon for PowerBuilder 2015
* Installation Guide on Cloud Platform

» Mobile Ul Design & Development Guide

» Migration Guidelines for Appeon Web

» Supported PB Features for Appeon Mobile

» Supported PB Features for Appeon Web

» Appeon Developer User Guide

» Workarounds & API Guide

» Appeon Workspace User Guide

» Appeon Server Configuration Guide for .NET
» Appeon Server Configuration Guide for J2EE
* Web Server Configuration Guide

» Appeon Troubleshooting Guide

» Appeon Performance Tuning Guide

» Testing Appeon Web Applications with QTP

Appeon for PowerBuilder Help isin compiled HTML format, so that you can search by index
or by typing keywords, navigate back and forth, or print a specified page.

To access Appeon HTML Help:

Step 1: Click the Help button (#2) in the Appeon Developer toolbar.

Step 2: Click the corresponding help book to access the detailed help information, as shown
in the following figure.
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Figure 16.1: Appeon for PowerBuilder Help

r 3
£ Appeon for PowerBuilder Help = | S
] = %) Al sii
Hide Locate  Back Stop  Refresh  Home Primt  Options

Contents

lndex I [ I E— ]

T2 Fome Page Appeon for PowerBuilder 2013 R2 Help
@ Introduction to Appeon
@ Getting Started
New Features Guide
Appeon Mabile Tutorials
Appeon Mabile {Offline) Tutorals
g ::3:::::2: g:::z ;E; i’;szz: :Q,ZTE The most current help for these products is available online at: http://www.appeon.com/support/documents/appeon_online_h¢
@ Installation Guide on Cloud Platform
Mobile Ul Design & Development Guide
Migration Guidelines for Appeon Web
Supported PB Features for Appeon Mobile
@ Supported PB Features for Appeon Web Getting Started with Appeon for PowerBuilder Hot topics:
0 Appeon Developer User Guide
Workarounds & API Guide
Appeon Workspace User Guide
Appeon Senver Configuration Guide for .MET @ i
514 Appeon Server Configuration Guide for J2EE =) Getting Started =l Deploying a mobile
0 ‘Web Server Configuration Guide

This help includes information about Appeon for PowerBuilder 2013 R2 which consists of two products: Appeon Mobile 2 i

Y Introduction to Appeon @ Developing a mobile

@ fppeon Troubleshooting Guidz H New Features & Distributing a mobil
Appeon Performanice Tuning Guide
-8 Testing Appeon Web Applicati ith QTP .
Feing repeen THEh Replestians a Appeon Mobile Tutorials @ Configuring Appeon
= Appeon Mobile (Offline) Tutorials @ Maodifying the app fo
Installing Appeon for PowerBuilder Hot topics:

4| 1
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17 Extended Toolkit

Appeon provides extended tools to ease your PowerBuilder-to-Web or PowerBuilder-to-
mobile process. These tools include:

» DLL/OCX Files Package Tool: It is designed as a solution for packaging and installing
large-sized DLL/OCX files.
Note: Thistool is effective for the Web application only.

» Appeon Silent Installer: Installs EAServer, Appeon Server, Appeon Server EBF
(Emergency Bug Fix), and Appeon Web applications in the silent mode.
Note: Thistool is effective for the Web application only.

» Appeon Developer Toolbar Register Tool: Enables you to register (or unregister) one

Appeon Developer version to more than one PowerBuilder version or different Appeon
Developer versionsto different PowerBuilder versions.

17.1 DLL/OCX Files Package Tool
Note: Thistool is effective for the Web application only.

DLL and OCX files are frequently used in PowerBuilder client/server application. Appeon
offers you two ways to distribute DLL/OCX files.

Table 17.1: Twowaysto distribute DLL/OCX files

When to use Which tool to use...

Deploy DLL/OCX filesto There are only afew DLL/ In the Additional Filestab

the server and then download | OCX files or thefiles are of the Application Profiles

them to the client at runtime. |small. Configuration window. Refer
to Deploy External Filesfor
details.

Package DLL/OCX files Therearemany DLL/OCX  |Usethe DLL/OCX file
and install them to the client |files or the files are large; and | packaging wizard. Refer to
before the applicationisrun |the client machineisfixed. |thefollowing sectionsfor
for thefirst time. detailed information.

17.1.1 Packaging DLL/OCX files

Step 1: Run the EonDLLOCX .exe file under the \Toolkit\DLL& OCX Package folder in the
Appeon Developer installation directory.

The DLL/OCX File Packaging Wizard starts, as shown in the following figure. Click Next to
proceed.
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Figure17.1: DLL/OCX File Packaging Wizard

= DLL/OCK File Packaging Wizard

Thiz wizard will help pou package DLLAOCH files for diztibution,

Click Mest to proceed.

< Back Mest> | [ Cancel

Step 2: Select an application and click Next.

Only application profilesthat are aready configured with DLL/OCX fileswill be listed. For
configuring DLL/OCX files for an application profile, refer to Deploy External Files. When
Next is clicked, the pre-configured DLL/OCX files will be automatically added for you.

Or, skip the selection and click Next to manually add the DLL/OCX files.
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Figure 17.2: Select an application

£ DLL/OCX File Packaging Wizard ==
Specify Application
Select the application of which DLLAOC files need to be packaged.

Maote: the application must be configured to deplay with DLLAOC filez
in Appeon Developer Configuration.

Maote: you can skip thiz step and go to the nest step directy.

[ ¢ Back ][ MHest » ][ Cancel ]

Step 3: Click Add to add the DLL/OCX files, select the Register box to automatically
register the file when installed, and click Next to proceed.

The DLL/OCX fileswill be automatically added if you select the application of which files
are aready configured in the previous step.

Figure 17.3: Add DLL/OCX files
£ DLL/OCX File Packaging Wizard

Specify DLL/OCXK Files

Add DLLAOCK files for packing and select files that need to be
regiztered.

Fegizter  File Mame

ddd. | | Delete |

[ ¢ Back ][ MHest » ][ Cancel
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Step 4: Specify the location where the package will be created. A folder named Package will
be created under this location.

Figure 17.4: Specify the package location

3 DLL/OCX File Packaging Wizard [E3m]

Specify Package Location

Specify the directary where the DLLAOCE package will rezide.

Specify Package Location

C:“Program Files\Appeon'.appeontesy H Browse... ]

[ ¢ Back “ MHest » ][ Cancel ]

Step 5: Review the settings and click Next to generate the package.

Figure 17.5: Review settings

3 DLL/OCX File Packaging Wizard [E3m]

Review Settings

Click Mest to beqin packaaging files. [F you want b review ar change any
zettings, click Back.

Current Settings:

Applcation Mame:

pet_warld
Package Location:

C:%Program Files\tppeon'.appeontesth,
DLLADOCH Information:

Regizter DLLADC files
Mo C:Wwfindowsapstemtavifile. dil
Mo C:Awindowsheypstemtavicap. dll

< Back ]EMH.EHt> i[ Cancel
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Step 6: Wait until the file packaging process is complete.
Step 7: When packaging is complete, click Finish to close the wizard.

To view the log information generated during the process, select the View L og box and then
click Finish. Thelog file will be automatically opened. Y ou can a'so manually open the
DLLOCX.log file in the generated package.

Figure 17.6: Packaging complete

< DLL/OCX File Packaging Wizard ==

Review Settings

Click Mest to begin packaging files. IF you want to review or change any
zettings, click Back.

Current Settings:

Application Mame:

pet_warld
Package Location:

C:%Program Files\dppeontappeontesth,
DLLADOCE Information:

Fegizter DLLADC files
Mo C:wwfindowsapstembavifile. dll
Mo C:Wwfindows\apsterntavicap. di
[ < Back ] { [ Cancel

17.1.2 Installing and uninstalling DLL/OCX files

Y ou will use the same setup program (Setup.exe file) in the generated package for installing
and uninstalling DLL/OCX files:

 If the DLL/OCX files are not installed on the client, when you run the setup program, you
will be guided to install the files. Refer to Section 17.1.2.1, “Installing DLL/OCX files” for
detailed instructions.

» |f the DLL/OCX files are already installed on the client, when you run the setup program,
you will be guided to reinstall or uninstall the files. If you select to reinstall the files, you
will run through the same process as a new installation, as described in Section 17.1.2.1,
“Installing DLL/OCX files’. If you select to uninstall the files, refer to Section 17.1.2.2,
“Uninstalling DLL/OCX files’ for detailed instruction.

17.1.2.1 Installing DLL/OCX files
Step 1: On aclient machine, run the Setup.exe file in the generated package.

The DLL/OCX File Installation Wizard starts, as shown in the following figure. Click Next
to proceed.
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Figure17.7: DLL/OCX Filelnstallation Wizard

£ DLL/OCX File Installation Wizard

Thiz wizard will help pou zetup DLLAOCH files for diztibution,

Click Mest to proceed.

< Back

Cancel |

Step 2: Specify the location where the DLL/OCX fileswill be installed. Click Next to start
the installation process.

The default installation location is %SystemRoot%\system32\A ppeonPlugin (%SystemRoot
% indicates the folder where Windows isinstalled, typically C:\Windows); if you specify
acustom location in AEM (see Appeon Server Configuration Guide for .NET or Appeon
Server Configuration Guide for J2EE for details), then specify the same location here.
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Figure 17.8: Specify the installation location

£ DLL/OCX File Installation Wizard

Specify Installation Location

Specify the directony where the DLLADCx fles will be installed.

Specify [netallation Location

C:Awindowshaesternd2\appeonPlugint, Browse. .. |

< Back

Cancel |

Step 3: Wait until the installation is compl ete.

During the installation process, the DLL/OCX fileswill first be copied to the specified
location and then registered if they have been selected for auto-registration during the
packaging process.

Step 4: When the installation is complete, select the L et wizard restart the system now
option and click Finish to close the installation wizard and restart your machine.

To view the log information generated during the process, select the View L og box and
click Finish. The log file will be automatically opened. Y ou can also manually open the
DLLOCX.log filein the generated package.
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Figure 17.9: Installation complete

= DLL/OCK File Installation Wizard

Fimizhed DLL/OCK File Installation Whzard

Setup has finizhed inztalling DLLA0Cx package on pour computer.

Click Finizh bo exit,

¥ Let wizard restart the system now

Recommended: Restart the spstem to enzure that the DLLAOC files wall
wiark, correcty.

Select whether o let wizard restart the system now or restart the system
later by yourself.

< Back I Finizh I Cancel

17.1.2.2 Uninstalling DLL/OCX files

Step 1: On aclient machine, run the Setup.exe file in the generated package.
The DLL/OCX File Installation Wizard starts, as shown in the following figure. Click Next

to proceed.
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Figure 17.10: DLL/OCX FilelInstallation Wizard
= DLL/OCK File Installation Wizard ==

Thiz wizard will help pou setup DLLAOCH files for distribution.

Click Mest to procesd.

< Back

Step 2: Select Uninstall and click Next to proceed.

If you select to reinstall the files, you will run through the same process as a new installation,
as described in Section 17.1.2.1, “Installing DLL/OCX files’.

Figure 17.11: Reinstall or uninstall
= DLLAOCK File Installation Wizard [5]

Maintenance Mode

Fleaze select one of the following ophions:

£ Uninstal

¢ Back I MHest » I Cancel

Step 3: Click Yesto confirm the uninstall.
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Figure 17.12: Uninstall confirmation

Question £3

{9} Aire you sure you want to uninstall DLLAOCK Package?

........................................

Step 4: Wait until the uninstall is compl ete.
Step 5: When uninstall is complete, click OK to exit.
Figure 17.13: Uninstall complete
DLLAOCH File Uninstall 5]

[0} DLLADCH File weas successfully rermoved from wour cormputer,

17.2 Appeon Silent Installer (Windows EAServer only)

Notes: 1) Thistool is effective for the Web application only. 2) Thistool does not work
in .NET, JBoss, JEUS, WebL ogic and WebSphere versions.

To help ISVs create an easy-to-use Appeon installation package for the end users, Appeon
specially provides asilent installer which can be customized to install EAServer, Appeon
Server, Appeon Server EBF (Emergency Bug Fix), and Appeon applications in the silent
mode.

This guide provides some useful instructions for I1SVson:
* Creating folder structure of Silent Installer

» Copying installation program of EAServer, Appeon Server, Appeon Server EBF or Web
applications

» Customizing configuration file
* Burning installation CDs
Additional instructions are also provided for end userson:

* Running Appeon Silent Installer (for End Users)

17.2.1 Creating folder structure of Silent Installer

The installation program files of EAServer, Appeon Server, Appeon Server EBF, and Web
application must be placed in the required folder structure, so that Appeon Silent Installer can
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run them. For your convenience, Appeon provides a compressed folder structure which can
be decompressed under any directory. To decompress and create the folder structure and the
required files, take the following steps:

Step 1: Run Silentinstall.exe in the "\Toolkit\Silent Install" under the Appeon Devel oper
installation directory, for example, C:\Program Files\A ppeon\Devel oper2015\T ool kit\Silent
Install.

Step 2: Select where to create the folder structure. Click OK.
Figure 17.14: Specify thelocation
=¥ Silent Install ()

Create khe Folder struckure For silent install under the Fallawing directary, Ta
change the directary, click Browse,

CProgram Files! AppeoniSilent Install Browse, ..

Cancel |

After the creation, afolder named "Setup” is created with the following sub-folders and files:
Figure 17.15: Folder structure

[F=1 KON Ex=
@le CProgram FileshAppeontSilent InstallhSetup - | 4 | | Search o

File  Edit  Wiew Tools Help

Bl Organize v = Views -

Favarite Links Marne Date modified Type Size

Appeon 2/26/2009 351 P File Folder
_ rrsvep6l.di 2/26/2000 551 PM DLL File 393 KB
B Pictures 5! setup.exe 2/26/2000 551 PM Application 128 KB
B Music [ SilentInstallbe 2/26/2008 5:51PM  Text Dacument IKB
More » &fUninstall.exe 2F26,/2009 51 PR Application 124 KB

[E Documents

Folders hd
appeon_workarounds110e =
appeon_workarounds110e
appeohdemo
Appeonlhstall
CodelnSight
icon ‘

m |

language .
Project
res
Template
Toolkit
DLLAOCH Package
Register Toolbar
Silent Install
GMU_gsT07
Helpf.1l il

5 iterns (Disk free space: 1.36 GE) B Cormputer

The following is a brief introduction to each folder in the Appeon Silent Installer:

Setup: The root directory of the Silent Installer. It contains the "Appeon” folder, the
Setup.exe, Uninstall.exe, Silentinstall.txt, and msvcp60.dil files.
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» Appeon: It containsthe"AS', "AS EBF", "EAServer", and "WebApp" directory.
* AS: It storesthe installation program of Appeon Server.
* ASEBF: It stores the installation program of Appeon Server EBF.
* EAServer: It stores the installation program of EAServer.

» WebApp: It stores the Web application files packaged by the Appeon application
packaging tool.

» Setup.exe: The setup program for launching the silent installation.
» SilentInstall.txt: The configuration file which can be modified to customize the installation.

» Uninstall.exe: The uninstall program for silently removing what has been installed with
Appeon Silent Installer.

» msvcp60.dil: The DLL file for Appeon Silent Installer.

17.2.2 Copying installation program of EAServer, Appeon Server, Appeon
Server EBF or Appeon applications

After the required folders and files are generated, you can start copying the installation
program files of Appeon Server, EAServer and Appeon applications to the corresponding
folder.

To copy the EAServer installation program to Appeon Silent Installer:

Copy dl files and folders from the directory where setup.exe file resides to the "EA Server"
folder of Appeon Silent Installer.

To copy the Appeon Server installation program to Appeon Silent Installer:

Copy al filesfrom the "ASP" folder on the Appeon installation CD to the"AS' folder of
Appeon Silent Installer.

To copy the Appeon Server EBF installation program to Appeon Silent Installer:

Copy dl files from the "asebf" folder on the Appeon installation CD to the "AS EBF" folder
of Appeon Silent Installer.

To copy Web application packages to Appeon Silent Installer:

Step 1: Verify that the Web application packages have already been generated using the
Appeon application packaging tool. If no package is generated, follow stepsin Section 11.1
“Packaging a server deployment project” in the Packaging a deployment project chapter.

Step 2: Copy the generated packages to the "WebApp" folder of Appeon Silent Installer.

17.2.3 Customizing configuration file

With Appeon Silent Installer, you can customize the installation program using the
configuration file (SilentInstall.txt). The following is a detailed description of each parameter
in the SilentInstall.txt file. Each parameter contains no default value.
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17.2.3.1 Installation Types

Specify whether to install EAServer, Appeon Server and Appeon applications.
Table 17.2: Parameter for installing EAServer

Parameter EAServer

Description Specifies whether to install EAServer.

If you do not want to install EA Server using this setup program, make
sure that a supported EA Server was installed already.

Accepted Values | Yes-- Install EAServer.

No -- Not to install EAServer, instead use an existing EAServer.
Default Value | None

Example EAServer ="yes'
Table 17.3: Parameter for installing Appeon Server
Parameter AppeonServer
Description Specifies whether to install Appeon Server.
Accepted Values | Yes
No
Default Value None
Example Appeon Server="yes"
Table 17.4: Parameter for installing Appeon Server EBF
Parameter AppeonServerEBF
Description Specifies whether to apply Appeon Server EBF.
Accepted Values | Yes
No
Default Value None
Example Appeon Server EBF="yes"
Table 17.5: Parameter for installing Web Application
Parameter WebApplication
Description Specifies whether to install Web applications.
Accepted Values | Yes
No
Default Value None
Example WebApplication="yes"

17.2.3.2 EAServer and Sybase ASA/SQL Anywhere Path

Specify the path of EAServer and Sybase ASA/SQL Anywhere. Sybase ASA/SQL Anywhere
isrequired because Appeon Server has an Sybase ASA/SQL Anywhere database for storing
the sensitive system data.
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Table 17.6: Parameter for EAServer path

Parameter EAServerPath

Description If the EAServer parameter is set to "No", this specifies the path of an
existing EAServer. The specified path will be validated.
If the EAServer parameter is set to "Yes', thisindicates where EAServer
will beinstalled.

Accepted Values | A valid path

Default Value None

Example EA ServerPath="C:\Program Files\Sybase\EA Server"

Table 17.7: Parameter for Sybase ASA/SQL Anywhere path

Parameter ASAPath

Description Specifies the Sybase ASA/SQL Anywhere installation path. The
specified path will be validated.

Accepted Values | A valid path

Default Value None

Example A SAPath="C:\Program Files\Sybase\Shared\A SA802"

17.2.3.3 EAServer Host Name, Port, Username and Password

Specify the EAServer host name, port number, user name and password.

Table 17.8: Parameter for EAServer name

Parameter EAServerName

Description Specifies the IP address of EAServer.
Accepted Values | A valid |P address

Default Value | None

Example EA ServerName="loca host"

Table 17.9: Parameter for EAServer port

Parameter EAServerPort

Description Specifies the port number of EAServer.
Accepted Values | A valid port

Default Value None

Example EA ServerPort="9000"

Table 17.10: Parameter for EAServer username

Parameter EAServerUserName

Description Specifies the user name to connect to EA Server.
Accepted Values | A valid user name on EA Server.
Default Value | None

Example EAServerUserName="jagadmin"
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Table 17.11: Parameter for EAServer password

Parameter EAServerPassWord

Description Specifies the password to connect to EAServer.
Accepted Values | A valid password for the current user name.
Default Value None

Example EA ServerPassWord=""

17.2.3.4 Appeon Server Port, Username and Password

Specify the Appeon Server port number, user name and password.

Table 17.12: Parameter for Appeon Server port

Parameter AppeonServerPort

Description Specifiesthe HTTP port number of Appeon Server.

Accepted Values | A valid port
If both EAServer and AppeonServer parameters are set to "Yes', port
"9988" isthe only available port that can be used.

Default Value None

Example AppeonServerPort="9988"

Table 17.13: Parameter for Appeon Server username

Parameter AppeonServerUserName

Description Specifies the user name for deploying an application to Appeon Server.
This deployment user name can be created using the Security tool in
AEM.

Accepted Vaues | A valid deployment user name on Appeon Server.

Default Value None

Example AppeonServerUserName=""

Table 17.14: Parameter for Appeon Server password

Parameter AppeonServerPassWord

Description Specifies the password for deploying an application to Appeon Server.
Accepted Values | A valid deployment password for the current user name.

Default Value | None

Example AppeonServerPassWord=""

17.2.3.5 Web Server Path
Specify the Web root of the Web server.

Table 17.15: Parameter for Web server Web root

Parameter

WebServerRootPath
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Description Specifies the document root of the Web server.
If the WebApplication parameter is set to "No", this parameter will not
take effect.
If the WebApplication parameter isset to "Yes', the specified document
root will be validated.

Accepted Values | A valid path

Default Value None

Example WebServerRootPath="C:\Program Files\Sybase\EA Server\html"

17.2.3.6 Setup Log Path
Specify the log file path.

Table 17.16: Parameter for log file path

Parameter LogPath

Description Specifies the path for the setup log file (APBLog.txt).
Accepted Values | A valid path

Default Value None

Example L ogPath="c:\log"

17.2.3.7 Web Applications

Specify the number of Web applications, application name, data source, transaction object

and database type.

Table 17.17: Parameter for number of the Web applications

Parameter WebA pplications

Description Specifies the number of Web applications that you want to install.
Accepted Vaues | Any number greater than zero

Default Value None

Example WebA pplications="2"

If more than one application will be installed, create the following parameters through
incrementing by "1", for example, "WebApplication2", "EA ServerNV 02", "ConnectCache2"
and "AEM2" for the second application, "WebApplication3", "EAServerNVO3",
"ConnectCache3" and "TAEM3" for the third application etc.

Table 17.18: Parameter for the Web application 1

Parameter WebApplicationl

Description Specifies the actual name of the first Web application.
Accepted Vaues | An aphanumeric string

Default Value | None

Example Examples for the first application:
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WebApplicationl = "appeon_sales application_demo"
Examples for the second application:
WebApplication2 = "appeon_code_examples'

Table 17.19: Parameter for EAServer NVO 1

Parameter EAServerNVO1
Description Specifies whether to install NV O components.
Accepted Values | Yes
No
Default Value | None
Example EAServerNVO1="Y es'

To make data sources work on the target Appeon Server, be sure to install the required
database driversto the target Appeon Server. For more information on database drivers, refer
to Chapter 4, Database Connection Setup in Appeon Server Configuration Guide for .NET or
in Appeon Server Configuration Guide for J2EE.

Table 17.20: Parameter for data source 1

Parameter ConnectCachel
Description Specifies whether to install data sources.
Accepted Vaues | 0 -- Not to install data sources.
1 -- Install and overwrite existing data sources.
2 -- Install but not to overwrite existing data sources.
Default Value | None
Example ConnectCachel="1"

Table 17.21: Parameter for AEM 1

Parameter AEM1
Description Specifies whether to install AEM settings.
Accepted Values | Yes
No
Default Value None
Example AEM1="Yes'

17.2.3.8 Web Application Uninstall Program Path

Specify the directory for the Web application uninstall program. A shortcut for the uninstall
program will be created in Windows Start menu.

Table 17.22: Parameter for the uninstall program path

Parameter

UninstallWebA ppPath

Description

Specifies where the uninstall program for Web applications will reside.
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Accepted Values | A valid path.

Default Vaue None

Example UninstallWebA ppPath="C:\uninstallwebapp"

17.2.3.9 Resource Language

Specify the language of the messages displayed during the installation or uninstallation

process.

Table 17.23; Parameter for the resource language

Parameter Language
Description Specifies the language of Ul messages.
Accepted Vaues |EN -- English
JP -- Japanese
Default Value  |EN
Example Language="EN"

17.2.3.10 SilentInstall.txt example
The following example shows a sample SilentInstall.txt file.

HHHBHBHHBHBH I HH BB B R R A R R R AR R
# Configure installation type: Yes or No

HHHBHBHHBHBHHHH BB B R R A A R AR R
EAServer ="Yes"

Appeon Server ="Yes"

Appeon Server EBF="Yes"

WebAppl i cati on="Yes"

HHHBHBHHBHBHHHH B BB R A A R AR R
# Enter the path of the EAServer installed or you want to install.
HHHBHBHHBHBHHHH BB B R R A A R AR R
EASer ver Pat h="C: \ Pr ogr am Fi | es\ Sybase\ EASer ver"

HHHBHBHHBHBH I HH B HA BB R A R R AR R
# Enter the ASA path

RHBH AR HBARH AR HRHBH AR HBHBH AR HRH A AR AR HBH AR B HRH AR AR HBHBH B HBHBH AR HHHE

ASAPat h=""C: \ Progr am Fi | es\ Sybase\ Shar ed\ ASA802"
HUHHH B RS HH R A R AR A R A R R R A R R R R A R R

# Enter the Port, Usernane, and Password of EAServer
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HHHBHBHARHBH I HH B BB R R R R R R R R AR R
EASer ver Name="1 ocal host "

EASer ver Port =" 9000"

EASer ver User Nane="j agadmni n"

EASer ver PassWor d=""

HHHBHBHARHBH I HH B BB R A R R R AR R R AR R
# Enter the Port, Usernane, and Password of Appeon Server
HHHBHBHARHBH I HH B BB R RS R R A R R R AR R
AppeonSer ver Port ="9988"

AppeonSer ver User Nane=
AppeonSer ver PassWor d=""

HHHBHBHARHBH I HH B BB R R R R AR R R AR R
# Enter the Web root of Web server

HHHBHBHARHBH I HH B BB R RS R R A R R R AR R
WebSer ver Root Pat h="C: \ Program Fi | es\ Sybase\ EAServer\ ht n "
HHHBHBHARHBH I HH BB R A R R R A R R R AR R
# Enter the path of Setup Log: APBLog.t xt

HHHBHBHARHBH I HH B BB R B R R R AR R R AR R
LogPat h="c:\ | og"

HHHBHBHARHBH I HH B BB R RS R R A R R R AR R
# Enter the Web application nunber

HHHBHBHARHBH I HH B BB R R R R R R AR R
WebAppl i cati ons="1"

HHHBHBHARHBH I HH BB R R R R R R R R R AR R
# Web Application Configuration

# Connect Cache:

# 0: not install

# 1. install, overwite if exist

# 2. install, not overwirte if exist

# EAServer N\VO. Yes or No

# AEM Yes or No
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HHHBHBHARHBH I HH B BB R RS R R A R R R AR R
WebAppl i cati onl="Web Application Nanel"

EASer ver NVO1=" YES"

AEML=" YES"

Connect Cachel="1"

HHHBHBHARHBH I HH B BB R RS R R A R R R AR R
# Uninstall Path

HHHBHBHARHBH I HH B BB R R R R R R AR R
Uni nst al | WebAppPat h = " C: \ uni nst al | webapp"

HHHBHBHARHBH I HH BB R R R R R R R R R AR R
# Language

#[default] = "EN'

# "EN' English

# "JP" Japanse

HHHBHBHARHBH I HH B BB R R R R AR R R AR R

Language="EN'

17.2.4 Burning installation CDs

After configuration is completed, you can burn installation CDs with the customized silent
installer (the entire "setup” folder) and distribute CDs to your end users.

The Appeon Silent Installer can be provided in one, two or three CDs:

* Inone CD: Ingtalling the Appeon Server ("AS" folder), Appeon Server EBF ("AS EBF"
folder), EAServer ("EAServer" folder) and the Appeon Web application ("WebApp"
folder).

* Intwo CDs: Onefor installing the Appeon Server ("AS" folder), Appeon Server EBF ("AS
EBF" folder), and EAServer ("EAServer” folder), and the other for installing the Appeon
application ("WebApp" folder).

* Inthree CDs: One for installing the Appeon Server ("AS" folder) and Appeon Server EBF
("AS EBF" folder), one for installing EAServer ("EAServer” folder), and one for installing
the Appeon application ("WebApp" folder).

Each CD must contain the following four files right under the Setup folder (that is, place the
following filesin the same directory level of the"AS", "EAServer" and "WebApp" folders):

o Setup.exe
* SilentInstall.txt

e Uninstall.exe
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* msvcp60.dil

17.2.5 Running Appeon Silent Installer (for End Users)

This section provides some additional instructions for end users on using the Appeon Silent
Installer to install/uninstall EAServer, Appeon Server, Appeon Server EBF and/or Appeon
applications

17.2.5.1 Installing Appeon Server, EAServer and/or Appeon applications
Before running the Appeon Silent Installer, be aware that

1. The Setup.exe program can only be run on the Windows platform.
2. The Appeon Server and the Web server must reside on the same machine.

Start the silent installation by running the Setup.exe file on the installation CD.

By default, the configuration file in the same location of the Setup.exe file will be used
during the installation process. To use a configuration file residing in a different location,
run the Setup.exe file from the command line and append the configuration file location, for
example, Setup.exe d:/setuptmp/Slentinstall.txt.

17.2.5.2 Uninstalling Appeon Server, EAServer and/or Appeon applications

To silently uninstall EAServer, Appeon Server, Appeon Server EBF, and/or Appeon
applications:

Run Uninstall.exe on the installation CD. The uninstall program will automatically load the
SilentInstall.txt file on the same CD and remove what has been installed with Appeon Silent
Installer.

To uninstall Appeon applications from Windows Start menu:

Select Windows Start > Programs > Appeon Application > Undeploy Appeon
Web Application. Or run the uninstall program under the location specified by the
"UninstallWebA ppPath" parameter.

Y ou will go through the same process as those in Section 11.1.4.3, “Uninstalling an
application” in the "Packaging and Installing Appeon Applications' chapter.

17.2.5.3 FAQs
1. What happens if EAServer is started during the process of silent installation?
Appeon Silent Installer will shut down the EA Server and continue the installation.

2. What happensif EAServer or Appeon Server was already installed during the process of
silent installation?

Appeon Silent Installer will overwrite the existing EAServer or Appeon Server.
3. What happensiif the names of NV O packages for a Web application are duplicated?

Appeon Silent Installer will still deploy the first NVO package, but will not deploy the
second NV O package. This activity will be recorded in the log file.
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17.3 Appeon Developer Toolbar Register Tool

Appeon Developer can run with PowerBuilder 8, 9, 10, 10.5, 11, 11.5, 12, 12.5, and 12.6 at
the same time and multiple Appeon Developer versions can run on the same machine. The
Appeon Developer Toolbar register tool enables you to register (or unregister) one Appeon
Developer version to more than one PowerBuilder version or different Appeon Developer
versionsto different PowerBuilder versions, so that you can easily and flexibly select which
Appeon Developer version and PowerBuilder version to use.

Following are steps to use the Appeon Developer Toolbar register tool:

Step 1: Select Start > Programs > Appeon for Power Builder 2015 > Appeon Developer >
Toolbar Register Tool.

Figure 17.16: Registry tool

e Appeon Developer Toolbar Registry @

Select Appeon Developer Wersion

Fegizter Appeon Developer toolbar in different
PowerBuilder versions.

PowerBuilder Werzsion  Appeon Develaper Versic =

PowerBuildera.0

PowerBuilder1 0.0

PowveerBuilder1 0.5

PowveerBuilder 1.0

FPowerBuilder! 1.5 .2 0023.00

m

] 1T 3

[ Ok ] | Cancel |

The PowerBuilder versions existing on this computer will be listed.
Step 2: Select the Appeon Developer version to be registered in the PowerBuilder version.

If you want to unregister an Appeon Developer version from a PowerBuilder version, clear
the selection in the Appeon Developer Version column.

Figure 17.17: Register toolbar to Power Builder

bt Appeon Developer Toolbar Registry @

Select Appeon Developer Werzion

Reqgizter Appeon Developer toalbar in different
PowerBuilder versions,

FowerBuilder Yerzion  Appeon Developer Wersic =

PowwerBuildera.0 | |
PowerBuilde1 0.0

PowerBuider1 g [ee002300
PowerBuilder11.0

PoweerBuilder1 1.5 6.2.0023.00

-

] 1T 3

] ] | Cancel
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Step 3: Click OK to register (or unregister) the selected Appeon Developer version with the
PowerBuilder version.
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18 Technical Support

Y ou can get technical support by clicking the Get Support icon in the Appeon Developer
toolbar appearing in the PowerBuilder IDE or launching the Appeon Help from the Windows
start menu.

Get support for Appeon for Power Builder 2015

Please send your email to <suppor t @ppeon. con® for technical support and be
prepared to provide the following files listed in the following table to Appeon Technical
Support. Thiswill aid debugging.

Table 18.1: Filesrequired for technical support

File Type File Name

Appeon Server configuration | For EA Server\WebL ogic\WebSphere\JEUS\JBoss.
file All filesin the %appeonserverd\repository\<instancename>
\config folder.

For .NET IIS:

All filesin the %appeonserver%a\AEM\config folder.

%appeonserver% indicates the Appeon Server installation
path.

Appeon Server log file For EA Server\WebL ogic\WebSphere\JEUS\JBoss.

All filesin the %appeonserverd%\repository\<instancename>
\log folder.

For .NET IIS:
All filesin the %appeonserver%a\AEM\L og folder.

Appeon Server Repository For EAServer:
DB Y%appeonserver%\db\A ppeonServer.db

For NET IIS:

All filesin the Y%appeonserver%\AEM\db folder.

For WebL ogic\WebSphere\JEUS\JBoss:
Y%appeonserver%o\db\appeondb.script

Appeon licensefile For EA Server\WebL ogic\WebSphere\JEUS\JBoss.
Y%appeonserver%o\license.appeon

For .NET IIS:
%appeonserver%o\AEM\bin\license.appeon

Web Server configuration file| httpd.conf

Web Pagefile Web server path\application name\window name.html

Web server path\application name\window name.js

Web server path\application name\all DataWindows on
window.xml
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File Type File Name
Note: If the window named includes inheritance, then also
supply all ancestor HTML and JavaScript files.

PowerBuilder exported PowerBuilder application path\exported window name.srw
source codefile

PowerBuilder application path\exported DataWindow
names.srd

Note: Exported windows should include exported ancestor
windows and exported ancestor user objects.
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182

customize configuration file, 227
customize general settings of UFA report, 85

D
Datawindow printing, 123
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I run Appeon silent installer, 236

If you need help, 4 run application in debug mode, 104
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install and uninstall an Appeon application,
143 S
install and uninstall DLL/OCX files, 220 SaveAs, 125
install Appeon for PowerBuilder, 8 search for UFA report items, 80
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open or save UFA report, 79 undeploy instructions, 196
undeploy with Appeon Server mode, 200
P undeploy with Deployment Profile mode,

package a server deployment project, 134 197
package and install Appeon applications, 134  undetected unsupported features, 74

package DLL/OCX files, 216 uninstall an application, 153
package stand-al one mobile projects, 169 uninstall DLL/OCX files, 223
perform feature analysis, 72 URLs of Appeon applications, 116
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Preparing for the mobile package, 159 Datawindow printing, 123
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run Appeon application, 108, 116 use UFA tool, 69
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